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Introduction

The viewing tool in the DTS Editor allows you to view subscription content in Ontylog
and Thesaurus namespaces within your knowledgebase (in DTS each namespace
represents a separate source terminology). All of your namespaces together comprise
your knowledgebase. You can configure a tree display for a broad view of a selected
subscription namespace, then select an individual item (e.g., concept, term) for which to
view detailed information.

The edit functions in the DTS Editor allow you to create and maintain new content in one
or more local namespaces. Each user-defined local namespace that you create can
contain new concepts and/or terms that reside outside of any of your subscription
namespaces.

In the local namespace you also can map relationships (i.e., create associations) between
selected concepts or terms in your local content, and specific concepts or terms in
subscription namespace content. For example, you can create a mapping between a
single concept in an Ontylog subscription namespace, and a newly created synonymous
term in your local namespace.

Namespaces

Ontylog Namespaces

An Ontylog namespace is one created using the Ontylog language, developed using
Apelon’s Terminology Development Environment (TDE) product. TDE, and Ontylog,
allow you to build and maintain knowledgebases through the use of description logic.
Concepts and terms in Ontylog are organized into a taxonomy through a process called
classification. Refer to the Ontylog Namespaces discussion later in this guide for more
on Ontylog namespaces.

Ontylog Extension Namespaces

You cannot perform edits directly to an Ontylog-type subscription namespace using the
DTS Editor. Using the DTS Editor, you can (locally) create new concepts and concept
relationships for each Ontylog subscription namespace by creating an Ontylog Extension
namespace.

You link the Ontylog Extension local namespace to the specific Ontylog subscription
namespace for which you want to add or modify content. Each Extension namespace is
comprised of supplemental content that you create locally, content that you can classify
against the linked Ontylog subscription content.

Classification of a namespace produces the namespace’s inferred view, which takes
concept and role relationships into account. If necessary, classification positions
concepts in the namespace hierarchy based on these relationships.
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You may link each Extension namespace to only a single Ontylog subscription
namespace. You can, however, create multiple Extension namespaces that link to the
same Ontylog subscription namespace.

Refer to the Ontylog Extension Namespaces and Extension Namespace Classification in
DTS document for procedures on creating and classifying Ontylog Extension
namespaces, and for instructions on installing and deploying the files necessary to
perform classification.

Thesaurus Namespaces

A Thesaurus namespace in DTS is one in which concepts and terms are organized based
on relationships (associations) with other concepts. The DTS Editor provides view
capabilities for subscription namespaces with the type of Thesaurus. You can create a
new “local” namespace that is a Thesaurus type. In the local namespace you can create
new content, and establish mappings to content in subscription namespaces (both Ontylog
and Thesaurus) as well as other local namespaces. Refer to the Thesaurus Namespaces
discussion later in this guide for more on Thesaurus namespaces.

Subsets of Namespaces

A subset is a segment of concepts that you can create from a specific namespace, based
on selection parameters that you define. Using the Subset Editor functions available to
you from the DTS Editor Main window, you can create and maintain a subset from a
subscription or local namespace, or from a (classified) extension namespace. If the
namespace you are viewing in the DTS Editor has one or more subsets created for it, you
can highlight each concept in the view that was selected for a subset. Refer to the DTS
Subset Editor Users Guide for procedures on subset creation and maintenance in DTS.

Purpose of This Guide

This guide includes procedures for using the view capabilities in the DTS Editor to create
tree views of subscription content in Ontylog and Thesaurus namespaces. Detail views
are available for each selected concept/term in a tree view. lllustrations of different view
scenarios are provided.

The guide also includes procedures for adding and maintaining one or more local
namespaces, as well as the new content within. This content includes new concepts
and/or terms, and the attributes related to each (e.g., properties, associations). Procedures
for creating new associations between concepts and/or terms within a namespace are
provided, as well as procedures for creating associations across namespaces. lllustrated
examples are included.
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Connect to the DTS Editor

Connection and Logon

Follow this procedure to establish a connection to the server where your knowledgebase
resides. If you intend to use a secure socket connection, confirm that the user has been
created before you start the DTS Editor; refer to the Managing Users discussions in the
Apelon DTS Server Operations Guide for procedures on adding and maintaining users.

Start the DTS Term Editor from the Windows Start menu (Start>Programs>
Apelon>DTSInstall>Apelon DTS Editor, where DTSInstall represents the current
version). If there is a shortcut for the DTS Editor, click the shortcut icon. The DTS
Editor Main window displays.

S Apen DTS Edites 340 CEIE

Fln Ve Took Cpbis Hel

" o |
Mamespaces & < w||| - hew |
xiarPd | Do Locs |

Cornecied isar: dhs 4 boer: fabor. Trisd vt

At this point you must specify the desired connection to the DTS Server. Select Connect
Options from the File menu. When the Connect Options window displays, click on the
dropdown field to display the available connection options.

Connect Dptions B3 ‘

Connect Type Option

Secure Bocket Server Connection ;I
Socket Server Connection

Secure Socket Server Connection

JDBC Local Connection

Select a Socket server connection, Secure Socket server connection, or a JDBC Local
connection. To use a secure socket connection, the DTS Server must be configured to
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use Secure Server Mode, and a user must have been created. Click OK. In the following
discussions, refer to the procedures specific to the connection type you selected.

Socket Server Connection

1. Confirm that the Apelon DTS Server is running (Start>Programs>Apelon>
DTSlInstall>Start Apelon DTS Server).

2. Select Socket Server Connection from the Connect Type Option dropdown field,
then click OK.

3. Select Connect from the DTS Editor Main window File menu. The Connect to
Apelon Server window displays.

Connect to Apelon Server il

Host flocalhost | Conrect I

Port [sess P |

™ Use these values as defaults

4. Specify the connection Host and Port for the DTS Server (i.e., the name of the
machine where your DTS Server is running). To recall these values for future
sessions, click Use these values as defaults.

5. Click Connect to establish the socket server connection to with your DTS Server.
The Content License Agreements window displays.

Secure Socket Server Connection

1. Confirm that the Apelon DTS Server is running (Start>Programs>Apelon>
DTSlInstall>Start Apelon DTS Server).

2. Select Secure Socket Server Connection from the Connect Type Option dropdown
field, then click OK.

3. Select Connect from the DTS Editor Main window File menu. The Connect to
Apelon Server window displays.

Connect to Apelon Server 5[

Host I\nca\hns‘t ‘ Connect I

et IBEEE Cancel |

Usernatne ImsS

Pazzwvord I

I™ Use these valuss as defauts

4. Enter your Host name (for the machine where your DTS Server is running) and
Port number to access the DTS Server, your Username, and Password. To recall
these values for future sessions, click Use these values as defaults.
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5. Click Connect to establish the secure socket server connection to with your DTS
Server. The Content License Agreements window displays.

JDBC Local Connection

When you install DTS (using the InstallShield wizard) you must specify the type of
database (Oracle or Microsoft SQL Server database) on which you will maintain your
DTS data, as well as the driver through which the DTS Server and the DTS Editor will
access that data. The appropriate DTS configuration files (e.g., drivers.xml) are updated
to reflect your selection.

If you maintain the knowledgebase in a Microsoft SQL Server database, you have the
option of using either of these drivers:

e Microsoft JDBC driver (the required SQL Server JDBC driver is installed
automatically.

e |-Net Sprinta JDBC driver (Apelon recommends that you obtain and install the
iISprinta Enterprise™ driver, which provides the multiple connections required
to use DTS).

1. Select JDBC Local Connection from the Connect Type Option dropdown field,
then click OK.

2. Select Connect from the DTS Editor Main window File menu. The Connect to
Database window displays.

Connect to Database

x|

Usernatng Icﬂsa | Connect I

TERn
Passward I Cancel |

Host Ichaln

™ Use thess values as defaults Advanced... |

3. Enter your Username, Password, and Host name (for the machine where your
database is located). To recall these values for future sessions, click Use these
values as the defaults.

4. If your configuration requires you to modify the default Oracle instance and port
designations, or to choose SQL Server, click on Advanced. The Advanced Setup
window displays.

Advanced Setup |

5 WA Cracle - Thin Cliert Driver

Ihstance Ichainsid2

Part f1566

Ok I Cancel
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5. If you choose Oracle — Thin Client Driver in the Database/Driver field, you can
accept the default database name in the Database name/instance field, and the
default port number in the Port field, or override the defaults to connect to the
desired database. Click OK.

- If you indicated during DTS installation that you maintain your DTS
knowledgebase in a Microsoft SQL Server database, and you have
obtained and installed the iSprinta Enterprise driver, then SQL Server —
Sprinta Driver is included as an option in the Database/Driver field.

- If you indicated during DTS installation that you maintain your DTS
knowledgebase in a Microsoft SQL Server database, and selected the
Microsoft driver that is provided with DTS, then SQL Server — Microsoft is
included as an option in the Database/Driver field.

In the displayed Database/Driver field, specify your SQL Server/driver selection.
In the displayed Instance field, specify the SQL Server named instance (if you are
using a default instance, leave the field blank).

6. Click Connect on the Connect to Database window to establish the JDBC
connection. The Content License Agreements window displays.

Content License Agreements

The Content License Agreement(s) window displays immediately after you establish your
database connection.

S Content License Agreement(s) @
~
SMNOMED:

BEGIN™This product incorparates SNOMED Clinical Terms® (SNOMED CTE),
used by permission of the College of American Pathologists. ©2002 College of
American Pathologists. All rights reserved. SNOMED is a registered trademark of
he College of American Pathologists. This product incorporates SNOMED Clinical
Terms® (SNOMED CTE), used by permission of the College of American
Pathologists. ©2002 College of American Pathologists. Al rights reserved.
SMOMED is a registerad trademark of the College of American Pathologists. This
product incorporates SNOMED Clinical Terms® (SNOMED CTEY, used by
permission of the College of American Pathologists. ©@2002 College of American
Pathologists. All rights reserved. SNOMED is a registered trademark of the
College of American Pathologists. This product incorporates SMOMED Clinical
Terms® (SNOMED CTE), used by permission of the College of American
Pathologists. ©2002 College of American Pathologists. Al rights reserved
SMOMED is a registered trademark of the College of American Pathologists. This
product incorporates SNOMED Clinical Terms® (SNOMED CT®), used hy
permission of the College of American Pathologists. ©2002 College of American
Pathologists. Al rights reserved. SMNOMED is a registered trademark of the
College of American Pathologists. This product incorporates SMOMED Clinical
Terms® (SNOMED CTE), used by permission of the College of American

4

Dthelnmicte BN Callann of Bearican Oathalasicte A dakhie saeomn,

“You must read this entire agreement and accept the terms to continue
Do you accept all the terms ofthe preceding License Agreement?

In order to use the DTS Editor, use the Scroll Bar to list license terms for all of the
vocabularies to which you subscribe. Click Yes (which is enabled after you read the
entire agreement) to accept the terms; the DTS Editor Main window redisplays.
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Disconnect From the DTS Editor

Select Disconnect from the File menu, or click the toolbar Disconnect icon. If there is
unsaved data (new or modified) in one of the DTS Editor components, the following
confirmation window displays.
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Confirm Close x|

@ This componert is not ready to closs ;

Subzet Expression Editor [Trisd Procedures] | Unsaved changes

Do you still weant to close?

Cancel |

Click Yes to close the component and disconnect without reviewing or updating unsaved
data; displayed floating panels are closed when you disconnect. Click Cancel to
disregard the disconnect request.

Set Current Local Namespace

When you first log into the DTS Editor you have the option to set a current local
namespace. Select Set Current Local Namespace from the Options menu, or select
the Set Current Local Namespace icon from the Main window toolbar options. The Set
Current Local Namespace window displays.

Set Current Local Namepsace ll

Choose a local namespace for storing local additions
to subscription namespaces. These may consist of
additional synonyms, properties, or gualifiers.

Namespace: |4 Local Namespace =l

ok | Cancel

The namespace selected here becomes the default local (writable) namespace for the
addition and maintenance of property types, association types, and qualifier types to be
used when you add local content to a subscription namespace.

Thereafter, you can add a new property, synonym, or association to a concept or term in a
subscription namespace, or add a qualifier to a property or an association, as long as the
appropriate attribute type (e.g., property type) exists in the current local namespace.
You have the option of changing the local namespace at a later time. Attributes added in
this manner to a concept or term in a subscription namespace are listed in italics in the
Concept/Term Details View, as well as in the Concept Tree View (Container and
Inline versions of the view). Note the illustration.

B4 Synonyms

. -3 Boophilosis

# Infestation by Boophilus ¢ Preferred )
-3 |nfestation by Boaphilus (disorden)
-3 Infestation by Boophilus, NOS

- Synoynm Added to Subscription Namespace 4———  Local Namespace Content in Italics

The attributes themselves actually are written to the local namespace. No database
updates occur for the subscription namespace itself. Refer to the Ontylog Extension
Namespaces and Extension Namespace Classification in DTS document for procedures
on creating an Ontylog Extension namespace that you can employ as a local namespace.
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The DTS Editor Main Window

The DTS Editor Main window displays as soon as you accept the terms of the Content
License Agreements (click Yes on the Content Licenses Agreements window). The DTS
Editor version number displays in the window header. The window consists of two main
display panes. The panels available in the left pane of the window relate to global
navigation and viewing tasks.

When the window first opens, the Tree tab is selected and the Concept Tree panel
displays in the left pane. When you select a namespace from the Namespace dropdown
field, this tree unfolds the taxonomy to display the concept hierarchy for the selected
namespace in the knowledgebase.

T Apelon DTS Editor 34,1
Fle  Wew Tools Oplions Help

DY HER AL BNy B, ¥ B
Tree | wikee | Search CEncieL] Tisi s

l

coveven, §

Coremetnd Jae R el s

You can navigate through the concept tree to locate concepts for view.

The Concept/Term Details panel displays in the right pane. Here you may view concept
details, edit concept properties locally, and add new concepts. Each of these panels is
discussed in more detail later in the guide.

The Status Bar located at the bottom of the window indicates whether or not you are
connected to the database. The DTS Server connection host and port display as well.

The Windows Text Edit functions Cut, Copy, and Paste are available in many of the
DTS Editor data entry fields through keyboard shortcuts (CTRL-X, CTRL-C, and
CTRL V, respectively).
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Modify Main Window Panel Sizes

You can modify the display by clicking and dragging the edge of the pane you want to
resize. Note the resized panes in the following illustration.

S Apelon DTS Editor 3.4.1
Fie Vi Took Opticrs Heb

P4 HEH AL ERNY D6 B a

Tiew | wighsr | Search Concegh | Term Detals

Vomespoce: T | ¢ =D

H
i
5
i
E
i

i

;
a

2R

LG5I
ASRAILL SETSTANCE

ia

OCEDURE
MPLLALE ENTITY
SECIMEN

TPV e e
b

£3

Conrcted. Usér: s Host: hebvin Trisd £t

The resized panel settings are retained if you disconnect from the DTS Server, then
reconnect.

DTS Editor Main Window Menu Options

File Menu

Connect - Establishes your connection to the DTS Server and the knowledgebase (you
also can click the Connect icon in the toolbar).

Disconnect - Disconnects you from the DTS Server and the knowledgebase (you also can
click the Disconnect icon in the toolbar).

Connect Options - Displays connection options on the Connect Options window; select
the desired connection type to the DTS Server, or a direct connection to a database.

Exit - Ends this DTS Editor session and exits the program.
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View Menu

Status Bar - Lets you toggle the Status Bar on or off. The Status Bar, located at the
bottom of the window, indicates if you are connected to the knowledgebase, and
identifies the user and host connection.

Tools Menu

New Concept Tree - Displays the Concept Tree panel as a floating window (you also
can click the Open New Tree icon in the toolbar). Use this window in addition to the
Concept Tree panel, which you can display by clicking the Tree tab in the left pane.

New Concept Walker - Displays the Concept Walker panel as a floating window (you
also can click the toolbar’s Open New Walker icon). Use this window in addition to the
Concept Walker panel, which you can display by clicking the Walker tab in the left pane.

New Search - Lets you open the Search panel as a separate window (you also can click
the Search icon in the toolbar). The Search panel allows you to search for a concept
based on the parameters you specify. Use this window as an alternative to the Search
panel, which you can display by clicking the Search tab in the left pane.

Concept/Term Details - Displays the Concept/Term Details popup window (you also
can click the Open New Details Panel icon in the toolbar. The Concept/Term Details
window lists detailed information for any concept you drag and drop on the window from
anywhere else in the application.

Associations - Displays the Association Editor floating window, which allows you to
create and maintain associations between concepts or terms within the same namespace,
or across namespaces (you also can click the Open Association Editor icon in the
toolbar). For each association you can specify one or more established qualifier types
and values; these provide additional detail regarding the nature of a concept or term
association (e.g., Usually).

Properties - Displays the Property Editor floating window, which allows you to view,
create, and maintain properties for a concept or term (you also can click the toolbar’s
Open Property Editor icon). A property is a piece of user-defined information that can
be linked to a concept or term, and can be used for any purpose. For each property you
can specify one or more established qualifier types and values; these provide additional
detail regarding the nature of a concept or term property (e.g., Current).

Synonyms - Displays the Synonym Editor floating window, which allows you to
establish a synonymous term for a concept (you also can click the Open Synonym
Editor icon in the toolbar).

Association Types - Each association you create between two concepts or terms must be
assigned a specific type to indicate the nature of the relationship (e.g., one concept is
Broader Than the other, or is a Parent of the other). Click this option to display the
Association Types window, which allows you to view, create, and maintain association

types.
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Property Types - Each property that is assigned to a concept has a property type, which
defines the nature of the property (e.g., Document, Code). Multiple values can be
related to each property type. Click this option to display the Property Types window,
which allows you to view, create, and maintain property types.

Qualifier Types - Qualifier types, and their associated values, provide additional detail
regarding the nature of a concept or term property (e.g., Current) or a concept or term
association (e.g., Usually). Click this option to display the Qualifier Type Editor floating
window, which allows you to view, create, and maintain qualifier types.

Kinds - Displays the Kind Viewer floating window, which lists all kinds that have been
defined within all of the Ontylog namespaces in your knowledgebase. Each concept in

an Ontylog namespace must be assigned a kind to identify the concept’s type (specimen,
procedure, etc.).

This listing of established kinds may be helpful if you define new concepts in an Ontylog
Extension namespace. Refer to the Create and Maintain Ontylog Extension Namespaces
discussions in the Ontylog Extension Namespaces and Extension Namespace
Classification in DTS document for more on concept kinds.

Role Types - Displays the Role Type Viewer floating window, which lists all roles that
have been defined within the Ontylog namespaces in your knowledgebase. Each concept
in an Ontylog namespace can be assigned one or more roles (each defined by a Role
Type); each role describes a user-defined relationship between different established
kinds.

This listing of established role types may be helpful if you define new concepts in an
Ontylog Extension namespace. Refer to the Create and Maintain Ontylog Extension
Namespaces discussions in the Ontylog Extension Namespaces and Extension
Namespace Classification in DTS document for more on concept roles.

Namespace - Displays the Namespace Editor floating window, which allows you to
view, create, and maintain the namespaces in your knowledgebase.

Classify - This option is enabled only if the current local namespace is an Ontylog
Extension namespace. Click this option to perform classification on the current
Extension local namespace (you also can click the Classify icon in the toolbar). Refer to
the Classify an Ontylog Extension Namespace discussions in the Ontylog Extension
Namespaces and Extension Namespace Classification in DTS document for more on
Ontylog Extension namespace classification.

Classify Errors - This option is enabled only if the current local namespace is an
Ontylog Extension namespace. Click this option to display the Classify Errors window,
which lists errors that occurred during classification of the current Extension local
namespace. Refer to the Classify an Ontylog Extension Namespace discussions in the
Ontylog Extension Namespaces and Extension Namespace Classification in DTS
document for more on Ontylog Extension namespace classification.
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New Subset List - Opens the DTS Editor Subset List panel as a floating window (you
also can click the Open Subset List Panel icon in the toolbar). The Subset List panel
allows you to search for and list the namespace subsets that are available in your DTS
knowledgebase. Refer to the DTS Subset Editor Users Guide for procedures on creating
and maintaining DTS subsets.

New Subset Editor - Opens the DTS Editor Subset Expression Editor panel as a floating
window (you also can click the Open Subset Expression Editor icon in the toolbar).
The Subset Expression Editor panel allows you to edit the filters through which
namespace subsets are created. Refer to the DTS Subset Editor Users Guide for
procedures on creating and maintaining DTS subsets.

Options Menu

Code and ID Generator - Concept codes and I1Ds are concept identifiers generated
automatically and assigned to each new concept you create using the DTS Editor. The
options available here allow you to customize the format of the codes and 1Ds assigned to
new concepts.

Set Current Local Namespace — Lets you select the default local namespace, in which
you can add and maintain local content for a subscription namespace. You also can click
the Set Current Local Namespace icon in the toolbar.

Help
Help Topics - Provides online help (you also can click the Help icon in the toolbar).
About DTS Editor — The DTS Editor version, copyright date, etc.

DTS Editor Main Window Toolbar Options

Most of the options available from the menus on the DTS Editor Main window also are
available from the window toolbar.

Dl k2| B & 2] B %% 4] @ 6] B

% Connect to DTS Server - Establishes your connection to the DTS Server and the
knowledgebase (you also can click Connect in the File menu).

% Disconnect - Disconnects you from the DTS Server and the knowledgebase
(you also can click Disconnect in the File menu).

ﬂ_‘" Open New Tree - Displays the Concept Tree panel as a floating window (you
also can click New Concept Tree in the Tools menu). Use this window in conjunction
with the Concept Tree panel that you can display by clicking the Tree tab in the left pane.
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Open New Walker - Displays the Concept Walker panel as a floating window
(you also can click New Concept Walker in the Tools menu). Use this window in
conjunction with the Concept Walker panel that you can display by clicking the Walker
tab in the left pane.

i Search — Displays the Search panel as a separate window (you also can click
New Search in the Tools menu). The Search panel allows you to search for a concept
based on the parameters you specify. Use this window in conjunction with, or as an
alternative to, the Search panel that you can display by clicking the Search
tab in the left pane.

=
=t
~=~ 1Set Current Local Namespace - Allows you to select the default local
namespace, to which you can add and maintain local content for a subscription

namespace (you also can click Set Current Local Namespace in the Options menu).

a
ad
a4

Classify - This icon is enabled only if the current local namespace is an Ontylog
Extension type namespace. Click to perform classification on the current Ontylog
Extension local namespace (you also can click Classify in the Tools menu). Refer to the
Classify an Ontylog Extension Namespace discussions in the Ontylog Extension
Namespaces and Extension Namespace Classification in DTS document for more on
Ontylog Extension namespace classification.

El Open New Details Panel - Displays the Concept/Term Details popup

window, which lists detailed information for any concept you drag and drop on the
window from anywhere else in the application (you also can click Concept/Term Details
in the Tools menu).

a

7 Open Association Editor - Displays the Association Editor floating window,
which allows you to create and maintain associations between concepts or terms within
the same namespace, or across namespaces (you also can click Associations in the Tools
menu).

*
7 Open Synonym Editor - Displays the Synonym Editor floating window,

which allows you to establish a synonymous term for a concept (you also can click
Synonyms in the Tools menu).
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Open Property Editor - Displays the Property Editor floating window, which
allows you to view, create, and maintain properties for selected concepts (you
also can click Properties in the Tools menu).

% Open Subset List Panel - Displays the Subset List floating window (you also can
click New Subset List in the Tolls menu). The Subset List panel lists the namespace
subsets that are available in your DTS database. Refer to the DTS Namespace Subset
Editor Users Guide for procedures on creating and maintaining DTS subsets.

@"? New Subset List - Displays the Subset Expression Editor floating window (you
also can click New Subset Editor in the Tools menu). The Subset Expression Editor
panel allows you to edit the filters through which namespace subsets are created. Refer
to the DTS Namespace Subset Editor Users Guide for procedures on creating and
maintaining DTS subsets.

EI Help - Provides online help (you also can click Help Topics in the Help
menu).

DTS Editor Main Window Tab View Options

The following “tab” options are available when the DTS Editor Main window opens
initially. Each brief introduction that follows outlines the view panel displayed when you
click the appropriate tab. Detailed procedures and discussions on use of these panels are
provided later in the guide.

Tree - The Concept Tree view panel displays as the default in the left pane when the
main window first opens. When either of the other panels (Search or Concept Walker)
displays in the left pane, click the Tree tab to redisplay the concept tree. This tree
unfolds the taxonomy to display the concept hierarchy in a selected namespace in the
knowledgebase, or an association tree.

Walker - Displays the Concept Walker panel, which lists the parents and children of a
concept in the selected namespace.

Search - Displays the Search panel, which allows you to search for concepts based on the
parameters you specify (Name, Property, Role, etc.).
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DTS Editor Keyboard Options

Press the Enter key to perform the default action (e.g., Apply, Close, OK, etc.) in any
panel or popup window. Press the Esc key to close any displayed popup window.

View Concept Tree — Tree Tab

The DTS Editor Concept Tree panel lists concepts in a “tree” format for easy viewing.
As mentioned earlier, the Concept Tree panel displays in the left pane when the DTS
Editor Main window first opens, or when you click the Tree tab. Top-level concepts
(“nodes”) in the hierarchy display in a collapsed view (note: if this is an association tree,
no nodes display until you configure the tree).

Note the top-level concepts illustrated.

Tree IWaIkerl Searchl

Namespace: [SNOMED T

Yiew Axis: ISuperconcepts ! Subconcepts

Led L] L

Subset: |

=@ SNOMED CT Cancepk (SNOMED RT+CTY3)
- ‘b Attribuke (attribute)
- b Bady structure (body skruckure)
- @ Context-dependent categories (context-dependent category)
b Disease (disorder)
Enwvironments and geographical locations {environment [ location)
Events (event)
Finding (finding)
Observable entity {observable entity)
Crganism {organism)
Pharmaceutical [ biologic product {product)
Phesical Force (physical force)
Pheysical object {phwsical abject)
Procedure (procedure)
GQualifier walue {qualifier value)
Social context (social concept)
Special concept (special concept)
Specimen {specimen)
Staging and scales (staging scale)
b Substance {substance)

L L L LA L LT

B O O

You can expand or collapse segments of the tree to display only those elements you want.

Tree | walker | Search |

Namespace: |SNOMED CT

View Axis: ISuperconcepts | Subconcepts

1l

Subset: |

B- b SMOMED CT Concept (SMOMED RT+CTWI)
= b attribute (attribute)
‘b Ackion (atbribute)
[ g Mssociation {attribute)
‘b Complication {attribute)
Elb Condition {attribute)
‘@ Condition of pupil (attribute)
b Conditions For acquisition {attribuke)
g Test conditions {attributs)
ontext (attribute)
@ dction skakus (attribute)
- Agent relationship {atkribuke)
@ Member of (attribute)
‘b Responsible ta {attribute)
@ Subdivision of {attribute)
@ Used by (attribute)
h Associgted with (attribuke) b

|»
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Concept Tree Panel Display Preferences

Ontylog Tree Preferences

The Concept Tree panel makes concepts and their relationships easier to view and
comprehend. The following discussions explain how to format the display of data for an
Ontylog tree in the Concept Tree panel. Right-click on the white space in the Concept
Tree panel to display the following popup menu for an Ontylog tree.

# Classic Yiew

Cankainer Wigw
Inline Wigw

Click ko Edit

Any changes you make to the Concept Tree panel display settings are retained if you
disconnect from the current session (File>Disconnect) or exit the DTS Editor
(File>EXxit).

Classic View

Select Classic View from the popup menu to display concepts with single or multiple
parents in the concept tree.

Tree | walker | Search |

Namespace: [Triad

View Axis: ISuper-:c-n-:epts { Suhconcepts

Subset: I |

E-@ ANALYTIC_TECHNIQUE

@ CUALITATIVE_ANALYSIS
@ GUANTITATIVE_ANALYSIS
E-@ DIAGNOSIS

B BACK_PAIN

@ CHROMC_REMAL_FAILURE
@ CYSTITS

@ HEANY_METAL_POISONING
@ HEPATITIS_C

'@ HYPERCHOLESTERCLEMIA,
'@ MEPHROLITHASIS

@ SUBSTANCE_ABUSE
[]—‘*o MEASURABLE_SUBSTANCE

E-@ CHEMICAL
CTICNALLY ‘@ CHEMICAL _WIEWED_FUM
WE_SUBSTAMCE ‘b BIOLOGICALLY _ACT
BILIRUBIN
b TE CALCILM_CKAL

CREATIMIME
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Container View

Select Container View from the popup menu to list concept attributes within individual,
separate “folders.”

Tree | walker | Search |

Namespace: |Triad

View Axis: ISuperconcems ! Subconcepts

Subset: |

b AMALYTIC_TECHMGUE
‘@ DIAGNOSIS
= b MEASURAELE_SUBSTAMNCE
| Synonyms
;l Properties
;| Roles
| Inverse Roles
[l Concept Associations
;l Inverse Concept Associstions
J Subconcepts
E-@ CHEMICAL

] Synonyms
;| Properties
| Roles
| Inverse Roles
;l Concept Associstions
;| Inverse Concept Associstions
_4 Subconcepts

b CHEMICAL WIBWED _FUMCTIOMALLY

;l Inverse Roles

;| Concept Aszociations

;| Inverse Concept Associstions
| Subconcepts

You can open each “folder” and display the attribute values within.

Tree [ walker | Search |

Namespace: ITriad

View Axis: ISuperconcepts I Subconcepts
Subset: |

qo MULTI_COMPORENT_LABORATORY _PROCEDURE
=, b SINGLE_RESULT_LABORATORY_TEST
;l Syhoryins
;l Properties
;| Raoles
;] Inverse Roles
;| Concept Associstions
;] Inverse Concept Lssocistions
4 Subconcents
@ CELL_AND_ARTIFACT_TEST
] b CHEMISTRY_TEST
) Synohyms
= J Properties
-4\ cpmc_code: 32095
& print_name: Chemistry Test
- znomed_code; P3-70000
- _4 Roles
I_A all HAS_SUBSTANCE_MEASIURED: CHEMICAL
J Iverse Roles
[ 4 Concept Associstions
8 Analytic_Technigue: QUARNTITATIE_ANALYSIS
= J Inverse Concept Associstions
L Supset Mapsing [33381) CHEMISTRY_TEST
;I Subconcepts
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Inline View

The inline view lists all of the concept attributes that the Container View does, but
without the use of “folders.”

Tree | valker | Search |

Namespace: [Triad

View Axis: ISuperconcepts I Subconcepts

Subset: |

@ CHEMISTRY_TEST
v cpmo_code; 32098
-dh print_name: Chemistry Test
-dv znomed_code: P3-70000
A gl HAS _SUBSTAMCE_MEASURED: CHEMICAL
2 Analytic_Technigue: GUANTITATNVE_ARALYSIS
B Subset Mapping [33381) CHEMISTRY TEST
IMRALIMOLOGY TEST

Icons and Colors

The following icons indicate concept or term attributes in the DTS Editor. These icons
and colors are defined in advance for you (you cannot modify them).

Symbol/ color

Description

Indicates a concept in the Concept/Term Details panel.

Indicates a term in the Concept/Term Details panel.

Indicates a concept in the Concept Tree panel. In the Concept/Term Details panel,
indicates a subconcept of the concept displayed in the detailed view.

In the Concept/Term Details panel, indicates a superconcept of the concept
displayed in the detailed view.

In the Concept Tree and Concept/Term Details panels, indicates a synonym for a
concept.

In the Concept Tree and Concept/Term Details panels, indicates a property (such
as print name, medical code, etc.) for a concept.

In the Concept Tree and Concept/Term Details panels, indicates the role that
relates one concept to another.

In the Concept Tree panel, indicates the non-editable values concept Code,
concept ID, and Namespace.

In the Concept Tree and Concept/Term Details panels, indicates an association
between one concept and another.

In the Concept Tree and Concept/Term Details panels, indicates an association or
property qualifier for a concept.

@ & 0 L kb = ¥ 8 & %

In the Concept Tree panel, indicates that the concept in the detailed view is
included in the subset that is listed.
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Concept Name and Attribute Text Wrapping

If lengthy concept names and/or attribute text extend beyond the border of the Concept
Tree panel, the text will wrap around to a new line. The concept name or attribute text
also will be enclosed in brackets.

Tree | wWalker | Search

Hamespace: |SHOMED CT
View Axis: |Superconcepts [ Subconcepts
Subset:

Elb SMOMED CT Concept (SMNOMED RT+HCTYS)

----- # SHWOMED CT Concept  Preferred )

""" #* SMOMED CT Concept (SMOMED RT4+CTYE)

""" # SMOMED T First Release: 20020131 [R]
SNOMED T has been created by combining SMOMED
RT and a computer-based nomenclature and

----- # | classification known as Read Codes Yersion 3, which
was created on behalf of the UK, Department of
Health and is a Crown copyright.

----- # SMNOMED CT January 2003 Release: 20030131 [R]

""" # SMOMED CT July 2002 Release: 20020731 [R]

""" # SMOMED CT July 2003 Release: 20030731 [R]

----- #* ©2002 College of American Pathologists

----- 4 Codein Source: 138875005

----- 4 Concept Skatus: Current

-4 JTest [ jonTest i kest

----- & MHS Clinical Terms Yersion 31 XUOSD

=3 N EA AN

Wrapped || .. & SNOMED Legacy-style Code: R-00000

Concept =5 [test association bype [ jonTest | conceptdbask] 1 [
Attributes P LTestil] )

in Brackets : regh aggpciztion bype [ jonTast 1! Conbext-dependent

cabegovies {contexk-dependent catagory)
@ Attribute (attributs)
@ Body structure (body structure)

b Enwvironments and geographical locations
{enviranment | location)

Wrapped Concept Name Enclosed in Brackets

If you enlarge the Concept Tree panel, the panel size setting is retained if you disconnect
from the DTS Server, then reconnect. During the next session, the text wrapping and
brackets will be removed if they are not required in the larger panel.

Tree | walker | Search
MNamespace: |SNOMED CT
View Axis: | Superconcepks [ Subconcepts

Subset:

=)@ SMOMED CT Concept (SMOMED RT+CTYS)

----- # SMOMED CT Concept f Preferred )

""" # SHMOMED CT Concepk (SMOMED RTHCTY3)

""" # SMOMED CT Firsk Release: 20020131 [R]

SMOMED CT has been created by combining SNOMED RT and a computer-based
nomenclature and classification known as Fiead Codes Yersion 3, which was
created on behalf of the ULK, Department of Health and is a Crowven copyright,

L SRR

.

""" #  SMOMED CT January 2003 Relsase: 20030131 [R]
----- M SMOMED CT July 2002 Release: 20020731 [R]

----- M SMOMED CT July 2003 Release: 20030731 [R]

----- # ©z002 College of American Pathologists

----- dv Codein Source: 138575005

----- 4 Concept Status: Current

A JTestl [ jonTest ): rest

Ay MHS Clinical Terms Wersion 30 X050

Text Wrap and 4 SMOMED Legacy-style Code: R-00000

Brackets are B lest association bype [ jonTest ) conceptitestl 1 [ Taskl 3 )

Retained Onl ] » [J:e.s't Fegociation bype [ jonTest Jr Context-dependent categories
etaine nly {eontext-dependsnt category)

if Required @ Attribute (attribute)

[H- b Body struckure (body structure)
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Click to Edit (Ontylog or Thesaurus Tree)

The Click to Edit option is available for either an Ontylog or a Thesaurus tree (only
Click to Edit displays for a Thesaurus tree). If you click Click to Edit, any concept you
select displays automatically in the Concept/Term Details panel. This eliminates the
need to drag the selected concept to the Concept/Term Details panel for view.

# Classic View

Container Yigw

Inline View
v Click ko Edit

Multiple Panel Instances

The DTS Editor allows you to open multiple occurrences of the Concept Tree, Concept
Walker, and Search panels by selecting these options from the Tools menu, by clicking
the appropriate tab, or by clicking the corresponding icon in the toolbar. Each instance of
the panel displays as a free-floating, sizable window; the size and location of these
floating panels are retained for future sessions.

You can view, compare, and drag information from multiple instances of each window.
The data in each instance of the window can be from the same namespace, or can reflect
data from different namespaces. Drag and drop capability between the DTS Editor
windows and panels lets you create associations between namespaces, and view the
results immediately on the Concept Tree panel (refer to the Map Concepts or Terms
across Namespaces discussion later in the guide).

In the following illustration, two occurrences of the Concept Tree window are open
(covering the left panel) each reflecting a different namespace.

Fle view Toos Options Hep
al =
| @] 4] a|x|8] &) D)%% ] o[ @
'S Concept Tree E x| || concegt 1 Term Details |
Hamespace: [uorRT =1 Newr Delete
View Axis: [Superconcepts J Subconcepts =1
Subset: | ﬂ
=@ Active Ingredients -~
@ Amina Acids, Peptides, and Prateins
@ Biomedical and Dental Materisls
@ Carbohycrates and Hypoglycemic Agents
“@ Enzymes, Coenzymes, and Enzyme Inhibitors
@ Growth Substances, Pigments, and Yitaring
@ Heterooyolic Compounds
@ Inorganic Chemicals
@ Lipids and Antlipemic Agents
@ Nucleic Acids, Nucleatides, and Nucleosides
@ Organic Chemicals
@ Palycyclic Hydrocarbons
@ Unclassified Ingrsdisnts =l
s Concept Tree x|
Namespace: |MunumDrug =l
View Axis: |Supercuncep13 I Subconcepts ﬂ
Subset: | LI
7@ DRUG CONCEPT a
alternative medicines [drug category]
@ artiinfectives [drug category]
@ srtihyperlipidemic agerts [drug categary]
@ antineoplastics [drug categary]
“@ binlgicals [drug category]
b cardiovascular sgents [drug category]
“@ certral nervous system agerts [drug categary]
b coagulation modifiers [druy category]
@ uastrointestinl agerts [drug category]
“@ hormanes [drug category]
@ immunclogic agents [drug categary]
@ miscellaneous agents [drug categary] =l Swiltch View
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In the next illustration, the Concept Tree panel displays in the left pane, and multiple
Concept Tree floating windows display elsewhere on the DTS Main window. Note that
the active window is sized larger to accommodate the length of the concept names.

Fle view Toos Options Hep

EIEE

2| 8| &) 5] 2]%][*%]«] o|s (| @]

Tree | walker | Search |

Namespace: INDF-RT

View Axis: [Superconcepts J Subconcepts

Subset: |

@ Active ngredients

Aring Acids, Peptides, and Proteins

@ Biomedical and Dental Materials

“@ Carbohydrates and Hypoglycemic Agerts
@ Enzyies, Coenzymes, and Enzyme Inhibitors
@ Growth Substances, Pigments, and Yitamins
@ Heterocyclic Compaunds

@ Inorganic Chemicals

“@ Lipids and Antiipemic Agerts

b Mucleic: Acids, Nucleatides, and NMucleosides
“@ Organic Chemicals

“@ Palycyclic Hydracarbons

@ Unclassified Ingredients

74 Biologic Structures of Reciient

+] b Cellutar or Molecular Interactions

@ Clinical Kinetics

b Diseases, Manifestations or Physiologic States
@ HL7 Race

@ Pharmaceutical Preparations

@ Physiologicsl Effects

“@ Proposed HL7 Drug Dose Forms

Goneant § Term Details |
=l : 1 !
x|
=] — Namespace: [cRISP Thesaurus =l
View Axis: [Farent Of [ CRISP Thessurus | =
Focus Concept: [CRISP Thesaurus [C1140093] =
Subset: | LI

E-@ CRISP Thesaurus [C1140033]

'S Concept Tree

Namespace: |MunumDrug

View Axis: [Supsrconcepts J Subconcepts

Subset: |

bl L el el e

“@ srti-infectives [drug category]
@ artihypetiipidemic agerts [drug category]
@ artineoplastics [drug category]
@ biologicals [drug category]
@ cardiovascular sgents [drug category]
“@ certral nervous system agerts [drug category]
@ coagulstion madifiers [drug categary]
[F-@ oastrointestingl agerts [drug category]
‘@ S-aminosalicylates [drug categary]
g artacids [drug categary]
¥-@ Al hydroxide/Ca carbonateMy OHisimethicone: [generic name]

2
=] ‘O Al hydroxideMy hydrozidelsimethicone [generic narme]
| a1 hydroxidemy hydroxidessimethicons 200 mg-200 mo-20 g orltablet, chewsbls

Customize the Tree View

Follow these procedures to select the namespace for which you want to view data. The
format of the concept tree display depends in part on the type of namespace you select,
Ontylog or Thesaurus. Based on the view parameters, you configure the tree to display
in either a hierarchal format (subconcepts/superconcepts) or an association format that
reflects concepts associated with a specific focus concept. You can expand and collapse
the tree in either format, as needed.

Hierarchy Tree View

Select the namespace for which the concept tree will display from the Namespace
dropdown field list. Click the dropdown arrow to display all namespaces available for

view options.

When you select an Ontylog namespace for view, the default in the View Axis dropdown
field is Superconcepts/Subconcepts, which results in a hierarchal view of the namespace

concepts.

Hamespace: -

View Axis: ISuperconcepts I Subconcepts

Subset; |

[
=
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To expand a selection to view lower-level nodes, click adjacent the Expand button & .
When expanded, the concepts are listed in a hierarchical scheme, or “taxonomy.”

Tree [ valker | Search |

Namespace: nor.rT <

View Axis: ISuperconcep{s ! Subcaoncepts

L«

Subset: |

b Active Ingredients
‘@ Biologic Structures of Recipient
b Cellular or Molecular Interactions
E-@ Clinical Kinetics

= b & bsorption

tic
Abzorption Half-Life
b Affected by concomitant drug administration

b Atfected by foodiother nuttients
@ Affected by gastric pH
‘@ Affected by intestingl surface area

“@ Distribution

b Elirniniation

@ Kingtics

b Diseases, Manifestations or Physiologic States
‘@ HL7 Race

b Pharmaceutical Preparations

@ Physiological Effects

b Proposed HLT Drug Dose Forms

In the example, when you expand Absorption, five “children” are visible. If there is no
Expand button adjacent to a concept, it indicates there are no additional subconcepts
hidden for the concept. The nodes immediately above a concept are called direct
superconcepts (parents). Nodes immediately below a concept are called direct
subconcepts (children).

As you expand the tree, you may want to collapse the tree to view only the higher levels
of the hierarchy. Click the collapse button = to hide the subconcepts.

Association Tree View

Select the namespace for which the concept tree will display from the Namespace
dropdown field list. Click the dropdown arrow to display all namespaces available for
view options.

When you select an Ontylog namespace for view, the default in the View Axis dropdown
field is Superconcepts/Subconcepts, which results in a hierarchal view of the namespace
concepts. If you wish, you can configure a tree view that consists of all concepts for
which associations are established for a specified concept. An association is a
relationship between concepts and/or terms within a namespace, or across hamespaces.

The default association type for an association tree configuration is Parent of.
Note the illustration.

Hamespace: [s==R e

View Axis: IParent Of [ CRISP Thesaurus |

Focus Concept: ICRISP Thesaurus [C1140033]
Subset: |

Lelied e[
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The association tree that displays in the Concept Tree panel reflects the default
association type.

Tree | Walker | Search |

Namespace: |CRISP Thesaurus

\View Axis: IParem Of [ CRISP Thezaurus |

Focus Concept: ICRISP Thezaurus [C1140033]
Subset: |

Ledleflel]e]

@ CRISP Thesaurus [C1140093]

@ anatomy [COTFO027E]

@ behavioralizocial science [COS96159]
@ behavioralizocial science ressarch tag [COS96160]
@ communication [CO009452]

@ education [C0013621]

@ ethology [CO015040]

@ paychaology [CO033909]

@ zociclogyiarthropology [CO175548)
@ hiolagy [S0005532]

@ chemical [C0220806]

@ dizeaseidizorder [CO012634]

@ food sciencetechnology [C0178642)
@ medicing [C0025118]

@ named group [C0587010]

@ organisn [C0029235]

@ physical science [CO031516]

@ technologytechnigue [COS72057)

You have the option of selecting another association type on which to base the tree view.
Click the arrow on the View Axis field to list all existing concept associations in the
knowledgebase. Click the desired association to select it; the namespace in which the
association was created displays in parentheses.

You also have the option of establishing a focus concept in your association tree. The
focus concept serves as the root concept in your tree view.

Drag a concept from another panel or window (e.g., Concept /Term Details panel) and
drop it into the Focus Concept field. The focus concept sets the starting point (i.e., root,
or threshold) for the chain of associations to be displayed.

Tree [iwvalker | Search | Concept Term Details |
Namespace: ICRISP Thesaurus j ey Dielete
View Axis: [Parent Of [ CRISP Thesaurus | =l
Focus Concept: Iear dizorder [CO013447] [ CRISP Thesaurus | ;| =@ sar disorder [CO013447]
M Code: CO013447
Subset: | LI A 13947
E-@ ear cisorder [CO013447] - Mamespace: CRISP Thesaurus ( Thesaurus, Subscription, Read-Only )
@ congenttal ear disorder [CO596367] JSWDW’"S
@ cor infection [COBIAT44] s Prﬂperﬁej‘s
@ ear necplasm [CO013444] | Associstions
@ hearing disorder [CO260662)
@ labyrinth disorder [C0022390]
@ midclle ear dizorder [CO271428]

To view concepts with associations to those listed in the displayed association tree, click
the Expand button # next to the desired concept in the tree. Note the illustration.
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Tree | valker | Search |

Namespace: [cRISP Thesaurus

View Axis: IParent Of [ CRISP Thezaurus |

Focus Concept: Iear disorder [CO013447] [ CRISP Thesaurus |
Subset: |

Lll«flef]«

E-@ ear disorder [CO013447]
f—]—o congenital ear disorder [COS96367]

@ congenital deafress [C0339759]

'—o Usher syndrome [CO271097]
—@ ear infection [COE99744]
—@ ear neoplasm [C0013443)
@ hearing disorder [CO2E0662]
@ conductive hearing loss [C0018777]
——@ deafriess [C0011053]
@ congenital deafness [C0339759]
'—o Usher syndrome [CO271097]
@ roise induced deafness [C0537074]
—@ presbycusis [CO033074]
—@ senzotineural hearing loss [CO015754]
[E '—o Alport syndrome [CO027 706]
@ tinnitus [CO040264]

@ labyrinth dizorder [C0022890]
—@ cochlear lesion [C0596347)
—@ Meniere's dizease [CO0252581]
—@ ctosclerosis [CO029599]
@ middle ear dizorder [C0271428]

View Concepts in a Selected Namespace Subset

A subset is a segment of concepts that you can create from a designated namespace,
based on selection criteria that you define. You can create a subset from a subscription or
local namespace, or from a (classified) extension namespace.

The concepts in each subset can share associated attributes, and each subset may include
a few concepts or many concepts. Refer to the DTS Subset Editor Users Guide for
procedures on subset creation in DTS.

If the namespace in the view has one or more subsets created for it, you can choose to
highlight each concept in the Tree view that was selected for a subset. The Subset field
dropdown lists all existing subsets for (only) the namespace in the view; the subsets
display in gold color.

Tree I Walker I Search I

Namespace: [Triac

View Axis: ISuperconcepts I Subconcepts

Subset:

@ aniaLy 10 FrocEres Concepts Included in Subset of
‘o DlaGo THiEd Procedures Export «

g MEsela e Sk Tests < the Namespace in Tree View
L

L Jlef L] L

Click the desired subset in the list. Each namespace concept that is included in that
subset is highlighted (in gold color) in the hierarchy tree in the Concept Tree panel.
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Tree | valker | Search |

Namespace: ITriad

View Axis: ISuperconceptS [ Subconcepts

Lell«ll«

Subset: Il'riad Procedures

@ ANALYTIC_TECHMIQUE
‘@ DIAGNOSIS

‘@ MEASURABLE_SUBSTANCE
PROCEDURE
@ DIAGNOSTIC_PROCEDURE
E-@ LABORATORY _DIAGNOSTIC_PROCEDURE
@ MULTI_COMPONENT L ABORATORY _PROCEDURE
E-@ SINGLE_RESULT_LAEORATORY_TEST
@ CELL_tMD_ARTIFACT_TEST
G- CHEMISTRY_TEST
@ MMUNOLOGY _TEST
F INTRAYASCULAR_CHEMISTRY_TEST
@ NTR&YASCULAR_SODIUM_ON_TEST
@ FLASKMA_CHEMISTRY_TEST
@ SERUM_CHEMISTRY _TEST
@ WHOLE_BLOOD_CHEMISTRY _TEST
‘@ URINE_CHEMISTRY _TEST
@ MICROBIOLOGY _TEST
@ PHYSICAL_PROPERTY _TEST
[#-@ SPECIMEN_COLLECTION _PROCEDURE
—@ SAMPLEABLE_ENTITY
[+|]_—‘o SPECIMEN

LIITS

For an Ontylog namespace, you also can view the concept hierarchy within each of its
subsets. From the View Axis field dropdown list, select Subset Hierarchy (Subset
Hierarchy is enabled as a selection only when a namespace that has existing subsets is in

the view). From the Subset field dropdown list, select the subset for which you want to
view a concept hierarchy.

The hierarchy tree for the subset (only) displays, also in gold color.

Tree | walker | Search |

Namespace: Triad

View Axis: ISubset Hierarchy v

Subset: I'I'riad Procedures -

E—b CHEMISTRY _TEST
b INTRAVASCULAR_CHEMISTRY _TEST
b PLAZMA_CHEMIZTRY _TEST
b SERUM_CHEMIZTRY _TEST
b WHOLE_BLOOD_CHEMISTRY _TEST
b URIME_CHEMIZTRY_TE=T

Click the Expand ® and collapse = buttons to view and hide subconcepts, as needed.
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Concept Walker View

The Concept Walker provides a view of a selected concept’s place in the Concept Tree,
and its relationships with other concepts. You can configure the view to reflect either a
hierarchal format (subconcepts/superconcepts) or an association format that reflects

concepts associated with a specific focus concept.

Hierarchy View

Follow this procedure to display and use the Concept Walker panel to provide a view of
the selected concept’s relationships (i.e., ancestor and descendant concepts).

1. Click the Walker tab in the upper-left portion of the DTS Editor Main window.
The Concept Walker panel displays in the left pane.

Tree Walker | Searchl

A

Focus Concept: |

View Axis: I Superconcepts ! Subconcepts

Hamespace: |

Subset: |

uuuﬁ

A

Parent Section
(superconcepts)

Concept in View

Child Section
(subconcepts)

The dropdown field in the center of the panel (Focus Concept) is where you select
the concept for which relationships will be listed. If you used the Concept Walker
earlier in the current session, previous focus concepts are retained in the Focus

Concept field pulldown list for your selection.
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You can drag any concept visible on another window or panel (Search panel,
Concept/Term Details panel, etc.) to the Focus Concept field on the Concept
Walker panel. For example, click the Search tab to display the Search panel, or
click the Search icon in the toolbar to display the floating Search window; you
can position the floating window so that it is adjacent to the Concept Walker
panel.

Drag a concept to the Focus Concept field. When the field changes to yellow,
unclick the mouse to drop the concept.

When you select a focus concept from an Ontylog namespace for view, the
default in the View Axis dropdown field is Superconcepts/Subconcepts, which
results in a hierarchal view of the namespace concepts. Do not modify this field if
you want a hierarchal format for the view.

If the focus concept you selected is from an Ontylog namespace, the name of that
Ontylog namespace displays in the Namespace field. If any Ontylog Extension
namespaces exist for that namespace, these will be listed in the Namespace field
dropdown list.

An Ontylog Extension namespace is an extension of a specifically linked Ontylog
Subscription namespace. You create an Ontylog Extension namespace to create
and maintain new local content for the linked Ontylog subscription namespace.
From the list, select the Ontylog Extension namespace for which you want to
display a hierarchy view. Refer to the Concept Walker View and Ontylog
Extension Namespaces discussions in the Ontylog Extension Namespaces and
Extension Namespace Classification in DTS document for more on using the
Concept Walker with Ontylog Extension namespaces.

If your Focus Concept has one or more parents, these display in the Parent
section above the Focus Concept dropdown field. The section below the Focus
Concept dropdown field displays the subconcepts, or children, of the concept.

In the Parents section, you can expand any visible ancestor concept to list its
parent concepts. Click the Expand button ®. Higher-level concepts are listed in
inverse order to their place in the hierarchy tree.
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Tree Walker | Searchl

=@ Elimination
o\, Clinical Kinetics

Focus Concept: Metabolism [ NDF-RT |

View Axis: I Superconcepts [ Subconcepts

Namespace: [NDF-RT

Ll Ll el L]

Subset: |

b Enzymatic Pathwvay of Metabolism
Site of Metabolism

In the Subconcepts section, click the Expand button # to expand the hierarchy
and list children for any visible descendant of the concept you selected. The
focus concept is the root for this part of the view.

Tree ‘alker | Search'

=, Elimination
0\, Clinical Kinetics

Focus Concept: |Metabolism [ NDF-RT |

View Axis: ISuperconcem: I Subconcepts

Namespace: [NDF-RT
Subset: |

F_Fkl Enzymatic Pathwvay of Metabolism

—b Aromatic hydrozylation

—b Co-methrytransferase

—b Cytochromes

7’5 Epoxide hydrolases

—b Esterazes

—b Glucuronosyl transterases

7’5 Ghutathione s-transterazes

—b Monoamine oxidase

—b MN-acetyl transterases

7’5 Sulfatransterases

—b Thiopurine methyltransferase

[E-@ Site at Metabalist ]
b Hepatic: Metabolism

b [Lef e e 1]

nnnnnnnnnnnnnnnn
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Association View

You can configure a Concept Walker view that consists of all concepts for which
associations are established for a specified concept. Each association is a relationship
between concepts and/or terms within a namespace, or across namespaces.

Follow this procedure to display and use the Concept Walker panel to provide a view of
associations for the selected concept.

1. Click the Walker tab in the upper-left portion of the DTS Editor Main window.
The Concept Walker panel displays in the left pane.

The dropdown field in the center of the panel (Focus Concept) is where you select
the concept for which relationships will be listed. If you used the Concept Walker
earlier in the current session, previous focus concepts are retained in the Focus
Concept field pulldown list for your selection.

2. 'You can drag any concept visible on another window or panel (Search panel,
Concept/Term Details panel, etc.) to the Focus Concept field on the Concept
Walker panel. For example, click the Search tab to display the Search panel, or
click the Search icon in the toolbar to display the floating Search window; you
can position the floating window so that it is adjacent to the Concept Walker
panel.

3. Drag a concept to the Focus Concept field. When the field changes to yellow,
unclick the mouse to drop the concept. The focus concept will serve as the root
concept in your association view.

4. When you select a focus concept from an Ontylog namespace for view, the
default in the View Axis dropdown field is Superconcepts/Subconcepts, which
results in a hierarchal view of namespace concepts. Click the arrow on the View
Axis field to list all existing concept associations within all the namespaces in
your knowledgebase.

Focus Concept: ICIeansers, Denture [CO011448] [ UMDNS [Universal Medical Device Momenclature.. j

View Axis: |Parent Of [ UMDNS [Universal Medical Device Nomenclature System] | j
Subset: Parert Of [ NCI Thesaurus [Matiohal Cancer Institute Thesaurus]

Parert Of [ NIC [Mursing Intervertions Classification] |

Parert Of [ NOC [Mursing Qutcomes Clazsification] |

Parert Of [ Otriaha System |

Parent Of [ PDG [Physician Data Guery] ]

Parent OF [ RxMorm |

[Parent OF [ SPM [Standard Procuct Nomenclature] |

Parent Of [ UMDNE [Universal Medical Device Momenclature System] |

Click the desired association to select it (the namespace in which the association
was created displays in parentheses). The concept(s) for which there are
associations with the Focus Concept are listed in the Concept Walker panel. In
the following illustration for the focus concept Cleansers, Dentures, the concepts
associated through the association Parent Of are listed.
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Tree Walker | Search |

=-@ Dertures and Denture Products [C0BATE4T]
5, Dental Equipment and Supplies [COBE7548]
® Lniversal Mecical Devics Nomenclaturs Systen: praduct catsgory thesaunis [C1140120]

Focus Concept: [Cleansers, Derture [CO01 1448] [ LMDIS [Universal Mesical Devics Nomenciature.. |

Miew Axis: [Parert O [ UIMDNS [Lniverssl Medical Device Nomencleture Syster] | =1

Subset: | LI

You can drag the returned concept to the Concept/Term Details panel to view
attribute details.

View Subset Concepts in the Concept Walker

If the Focus Concept field concept is from a subscription, local, or (classified) extension
namespace for which a subset exists, you can choose to highlight in the displayed
hierarchy those concepts within that subset. From the Subset field dropdown (which lists
all subsets for the Focus Concept namespace field, in gold text) select the desired subset.

The Namespace field reflects the namespace from which the subset concepts were

derived. Each concept from the focus concept Namespace that is listed in the Parents
and Subconcepts hierarchies is highlighted (in gold color).

'S Concept Walker x|

=@, SNGLE_RESULT LABORATORY TEST
54, LABORATORY _DISGNOSTIC_PROCEDURE
(5@, DIAGHOSTIC_PROCEDLIRE
L@ proceoure

Focus Concept: |CHEMISTRY_TEST [ Triad |

View Axis: ISupechnCEpls i Subconcepts

Namespace: |Tnad

Lol Ll e s

Subset: hnad Procedures

b IMMUNCLOGY _TEST
@ NTRAVASCULAR_CHEMISTRY TEST

“O INTRAWASCULAR_SODIIM_ION_TEST .

@ FLASME_CHEMSTRY TEST P Concepts Included in Subset of

“@ SERUM_CHEMISTRY_TEST <« Focus Concept Namespace

= b WHOLE_BLOOD_CHEMISTRY_TEST

tb COAGULATION_TEST
10 WHOLE_BLOOD_SCDIUM_ION_TEST

@ URINE_CHEMISTRY TEST
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If the focus concept is from an Ontylog namespace, you also can view a select portion of
the concept hierarchy for each of the Ontylog namespace’s subsets. From the View Axis
field dropdown list, select Subset Hierarchy (Subset Hierarchy is enabled as a

selection only when the concept in the Focus Concept field is from a subset namespace).

From the Subset field dropdown list, select the subset for which you want to view a
portion of the concept hierarchy.

The hierarchy tree for the subset (only) displays, also in gold color.

'S Concept Walker x|

— @ CHEMISTRY_TEST

Focus Concept: IINTRAVASCULAR_CHEMISTRY_TEST [ Trigd ]

View Axis: ISubset Hierarchy

L el <]

Subset: I‘rriad Procedures

@ PLASMA_CHEMIZTRY_TEST
@ SERUM_CHEMISTRY _TEST
@ WHOLE_BLOOD_CHEMIZTRY _TEST

Click the Expand ® and collapse = buttons to view and hide subconcepts, as needed.

Concept Name and Attribute Text Wrapping

If a lengthy concept name text extends beyond the border of the Concept Walker panel,
the text display in the Parent and Child sections will wrap around to a new line. The
concept name text also will be enclosed in brackets.

& SHOMED CT Concept (SHOMED RT+CT43E)

Focus Concept: | Body structure (body struckure) [ SNOMED CT ]
View Axis: |Superconcepts | Subconcepts
Hamespace: |SNOMED CT
Subset:

EE RSN ES

H 'o Acquired body struckure (bady structure)
£ b Anatomical concepts (body struckure)

WrappEd Concept - g [Body structure, alkered from its original anatomical structure
Name Enclosed in P | (marphiolagic sbnormality)
Brackets
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If you enlarge the Concept Walker panel, then drag a different concept into the Focus
Concept field, any text wrapping and brackets will be removed if they are not required in
the larger panel.

Concept Walker w
------ ©, SNOMED CT Concept (SHOMED RT+CTYE)

il

Focus Concept: |Body structure (body struckure) [ SMOMED CT ] W |
\iew Axis: |Superconcepts | subconcepts v|
Namespace: | SHOMED CT v|
Subset: | v]

Text Wrap and 3 b Acquired body structure (body structure)

Brackets are : b Anatomical concepts (body structure)

Retained Only —p ~@ Body structure, alkered from its original anatomical structure (morpholagic abrormaliey)
if Required

[ZgRc
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Concept Search

Use the DTS Editor Search tab panel search features to search a selected namespace, or
all namespaces, and retrieve specific concepts, concept terms, or concepts and synonyms
that match the search criteria you specify. You then can drag and drop any retrieved
concept/term into another view panel (e.g., Concept/Term Details) for further review, or
onto one of the Editor windows (e.g., Synonym Editor, Property Editor). You can
display the Search panel as a floating window; this option is available from the toolbar on
the DTS Editor Main window menu bar, as well as from the Tools menu (Tools>Search).

Search a selected namespace, all namespaces, or a selected namespace subset based on
any of the following criteria:

e Name

e Synonym
e Property
¢ Role

e Inverse Role
e Concept Association
¢ Inverse Concept Association

You also can search within a specific knowledgebase silo, choosing the level of
“exactness” by which the search in the silo will be conducted.

To display the Search panel, click the Search tab on the DTS Editor Main window.

Tree | Walker Search |

Search: ¢ Concepts & Synonytis (¢ Concepts ¢ Tetms

Max. Results |10 LI Search |

Sesrch For |

Searchn: % Namespace ( Subsst © Sia

400 [Alcohol and Cther Drug Thesaurus]

Search By : iNama ﬂ

Search Results Matches Found
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Follow this procedure to search the namespace based on the criteria you specify.
1. Assure that the Search tab is selected and the search criteria fields display.

2. To search for both concepts and synonyms that match your search criteria,
Concepts & Synonyms applies. To search for matching concepts only, click
Concepts. To search for matching terms only, click Terms.

3. From the Maximum Results field dropdown list, select the maximum number of
concepts and/or terms to be retrieved from the namespace search. You can
specify that the search be completed as soon as 10, 50, 100, or 250 concepts
and/or terms that match the search criteria have been retrieved (10 is the default).

You also can select Enter a Number, then specify your own maximum, up to
9999, in the field that displays. If you anticipate numerous results from the
search, you should select Enter a number, then specify a large value. Note that
if you selected Concepts & Synonyms as a Search parameter, concept matches
will be returned first, followed by synonym matches. If the number of concept
matches exceeds the Maximum Results limit, no synonym matches are returned.

If you select Enter a Number, you must specify a number to perform the search.

Retrieved concepts or terms display in the Search Results area in the lower
portion of the tab. The total number of matched items retrieved is listed as well.
Note that a search with a larger Maximum Results number requires a longer period
of time to complete.

4. In the Search For field, specify the value (i.e., search string) for which you want
to search the namespace for a match. Specify the search string value in one of
these manners:

o Enter the specific search string in its entirety (e.g., abdomen endoscopy).

e Broaden the search criteria by entering the asterisk (*) wildcard character.
Note these examples when Name is the Search By parameter:

o To retrieve all concept/term names containing the string abdomen, type
*abdomen* as the search string in the Search For field.

0 To retrieve only concept/term names that begin with the string abdomen, type
abdomen* as the search string in the Search For field.

0 To retrieve concept/term names that end with the string abdomen, type
*abdomen as the search string in the Search For field.

5. Inthe Search In area of the panel, click the option that reflects where you want to
perform the search (Namespace, Subset, or Silo). If you select Namespace, the
accompanying dropdown lists all namespaces in your DTS knowledgebase.
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Searchin: (@ Namespace ( Subset € Sio

00 [Alcohol and Cther Drug Thesaurus] g

CCS [Clinical Classificstions Software]
COSTART [Coding Symbols for a Thesaurus of Adverse Reaction Ter
CRISP Thesaurus

D=M-1Y [Diagnostic and Statistical Manual of Mental Disorders] _lﬂ
| »

Click the namespace in which you want to perform the search. The default, All,
applies if you want to search in all existing namespaces. Note that if you select an
Ontylog Extension namespace to search, the results will be from the Extension
namespace only (no concepts from the linked Ontylog subscription namespace
will be returned). Refer to the Ontylog Extension Namespaces and Extension
Namespace Classification in DTS document for more on Extension namespaces.

If you select a Subset in which to search, the accompanying dropdown lists all
subsets that were created for namespaces in your DTS knowledgebase.

Searchin: { Mamespace ¢ Subset ¢ Silo

Click the subset in which you want to perform the search.

Each silo in DTS is a repository of customized concept terminology data acquired
from your knowledgebase, and optimized for searching. If you select a Silo in
which to search, the accompanying dropdown lists all namespace silos that were
created in your DTS knowledgebase. Click the desired silo in which you want to
perform the search.

In the Search By field, select the parameter that will be searched in the
namespace(s) or subset for the string you specified in the Search For field. Only
the Name option is available on searches for concepts & synonyms, and searches
for terms only.

For concept searches the following options are available:

e Name - This search will retrieve each concept (or each term, if you are
performing a term search) with a name that matches the search string
parameter you specified in the Search For field.

e Synonym - This search will retrieve each concept with a synonym that
matches the search string parameter you specified in the Search For field.

e Property - This search will retrieve each concept with a property value that
matches the search string parameter you specified in the Search For field, for
the property or properties you select.
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7.

If you select Property as the search parameter, a list of current
knowledgebase properties displays in the Search On list area; you select the
properties to be searched from this list.

o Word Match - A more generalized property search, in which you can
specify one or more words or numbers as the Search For value, and
the property must contain all of those search string words, in any
order.

e Role - This search will retrieve each concept with a role value (i.e., target
concept name) that matches the search string parameter you specified in the
Search For field, for the role type(s) you select (e.g., Procedure site). If you
select Role as the search parameter, a list of current role types displays in the
Search On list area; you select the role type(s) to be searched from this list.

e Inverse Role - This search will retrieve each concept with an inverse role
value that matches the search string parameter you specified in the Search For
field, for the inverse role type(s) you select (e.g., Procedure site). If you
select Inverse Role as the search parameter, a list of current inverse role
type(s) displays in the Search On list area; you select the inverse roles to be
searched from this list.

o Concept Association - This search will retrieve each concept that has an
association target concept with a name that matches the search string
parameter you specified in the Search For field, for the association(s) you
select (e.g., Is A Parent Of). If you select Concept Association as the search
parameter, a list of current association type(s) displays in the Search On list
area; you select the association type(s) to be searched from this list.

e Inverse Concept Association - This search will retrieve each concept that has
an inverse association from concept with a name that matches the search
string parameter you specified in the Search For field, for the inverse
association(s) you select (e.g., Is A Parent Of). If you select Inverse
Concept Association as the search parameter, a list of current inverse
association types displays in the Search On list area; you select inverse
association type(s) to be searched from this list.

After you specify all search criteria, click Search. The retrieved concepts and/or
terms are listed in the Search Results area in the lower portion of the tab. The total
number of retrieved matched concepts or terms is indicated as well (Matches
Found:). When you find the desired concept(s), you can drag the concept(s) to
the Concept Walker or Concept/Term Details panel to view details.

Note that after you click Search to begin the search, the button changes to
Cancel; to terminate a long-running search, click Cancel and enter alternate
search criteria. The button changes back to Search when the search is completed.
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Search for Concepts or Terms Based On Name
Follow this procedure to search for concepts or terms based on name.

1.

Concepts & Synonyms applies if you want to search for both concepts and
synonymous terms. To search for matching concepts only, click Concepts. To
search for matching terms only, click Terms.

Specify the name (i.e., search string) of the concept/term for which you are
searching in the Search For field.

In the Search In area, click the option (Namespace, Subset, or Silo) that indicates
where you want to search, then from the accompanying dropdown list, select the
specific namespace, subset, or silo to search.

For namespace and subset searches, select Name in the Search By field as the
search parameter for the string you specified in the Search For field.

Click Search. Concept/Term names matching the search string parameter you
specified in the Search For field display in the Search Results area in the lower
portion of the panel. Note the matched concepts retrieved from a namespace
search for the concept name search string *amino*; each returned concept
references the namespace from which it was retrieved.

Tree | Walker Search |

Search: (. Concepts & Synonyms o Concepts  Terms

Max. Results : |1D LI

Search For I*amino*

Search In : e " Subset Sio

[ |

FANDA [Classification of Mursing Diagnoses]
MBI Taxonomy [Mational Center for Biotechnology Infarmation Ta
NGl Thesaurus [Mational Cancer Institute Thesaurus]

MIC [Mursing Interventions Classification]

MO [Mursing Cutcomes Classification] -

K1 [ | _>l_I
Search By : IName LI
Search Results : Matches Found : 10

Aming Acid Metaholism, Inbarn Errors [ MOF-RT ]
Aninoaciduria, Renal [ MDF-RT ]

Aminophyline [ MOF-RT ]

Aminocuinolone Toxicty [ NDF-RT ]
Aminosalicylic Acids [ MDF-RT ]

Avitaminosis [ MOF-RT ]

MAMNGANESE AMIMNC ACID CHELATE [ MDF-RT |
METARAMIMOL BITARTRATE [ NDF-RT |

PR A-SMINCSODIURM SALICYLATE [ MDF-RT ]
POLY AMINCOPROPYL BIGUAMDE [ MDF-RT ]
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Search for Concepts With Selected Synonyms

Follow this procedure to search for concepts that have one or more selected synonyms
that match the search string.

1.
2.
3.

Click Concepts as your Search option.
In the Search For field, specify the synonym search string.

In the Search In area, click the option (Namespace, Subset, or Silo) that indicates
where you want to search, then from the accompanying dropdown list, select the
specific namespace, subset, or silo to search.

For namespace and subset searches, in the Search By field select Synonym as the
search parameter for the string you specified in the Search For field. A list of
current association types (each representing an association between a concept and
a synonymous term) displays in the Search On list area.

Concepts with synonyms that match the search string you entered will be
returned, provided the returned terms also meet the other search parameters you
specify. A synonym is a term associated with a concept by an association type
that represents a concept-to-term association; a synonym always is defined
between a concept and a term (however, two terms can be synonyms of the same
concept).

The Type Namespace field displays if you selected Synonym as the search
parameter in the Search By field. The default is to search All namespaces for
synonyms that match the other search criteria. The Type Namespace field gives
you the option of filtering the synonym search further.

You can restrict returned results to those synonyms for which associations
(concept to term type) were established with the search string term. From the
Type Namespace field dropdown list, select the namespace in which the synonym
association must exist in order to be included in the search results.

From the Search On field list, select one or more concept-to-synonymous term
association types for which to conduct the search.

e To select two or more nonadjacent association types, click the name of one
association type, then hold down Ctrl and click the name of each additional
association type. Each association type you select is highlighted.

e To select adjacent association types, click the name of the first association
type in the list, then hold down Shift and click the name of the last association
type in the list. All the association types between the first and last are
highlighted.
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For the selected concept-to-synonymous term association types, only concepts
with synonyms that match the specified search string will be matched and
retrieved. In the illustration, the search string *stomach* was specified.

Tree | Wialker Sesrch |

Search: { Concepts & Synonyms (5 Concepts € Terms

higx. Results |1D d :

Search For I*smmach*

Searchin: (% Mamespace ¢ Subset  Sio

800 [Alcohol ahd Cther Drug Thesaurus]

CCE [Clinical Classifications Software] -
4| 3
=
-

Search By : ISvnDnym

Type Mamespace: IA\I

Search On: Arh [ LocalNs1 ]
2 2cohal and Other Drug Th rus;
Synofytn [ CCS [Clinical Clagsificstions Software] | -
| | »
Search Results Matches Found

Click Search. Concepts with the selected association types with synonymous
term name values that contain the search string you specified in the Search For
field, display in the Search Results area in the lower portion of the panel. Note
the matched concepts retrieved when the selected association type in the specified
namespace is Synonym, and the search string is *stomach*. Each returned
concept references the namespace from which it was retrieved.

Tree | Walker Seatch |

search: { Concepts & Synonyms (¢ Concepts ¢ Terms

Max. Results I1D LI :

Search For I‘stomach*

Searchin: * Namespace ( Subsst ¢ Silo

0D [Alcohol and Other Drug Thesaurus]
CCS [Clinical Classifications Software] -
1 | »

Search By : ISynnnym

did 51

Type Namespace: IAII

Seatch On : Con Sy Term Arb [ Locallz |
= n [ A00 [A 1l ahdd Other Drug Thesaurus] |
Syhorytn [ CCS [Clinical Classifications Software] | -
1| »
Search Resuls : Matches Found @ 10

ichief cell (stamach) [CO524987] [ 200 [Alcohol and Cther Drug Thesaurus] ]
esophagus and stomach [C0391896] [ A0D [Alcohol and Other Drug Thesaurus] ]
food absorption (stomach) [C0639542] [ ACD [Alcohol and Other Drug Thesaurus] |
gastric lavage [CO017134] [ ACD [Alcohol and Cther Drug Thesaurus] |

gastric ulcer [CO038358] [ 40D [Alcohol and Other Drug Thesaurus] ]

stomach [CO035351) [ AOD [Alcohol and Cther Drug Thesaurus] |

stomach cel [COS14886] [ AOD [Alcohal and Other Drug Thesaurus] ]

stomach emptying [C0017127] [ 40D [Alcohal and Cther Drug Thesaurus] |
stomach surgery [C0192338] [ A00 [Alcohol and Other Drug Thesaurus] |

stomach tumar o cancer [C0033356] [ A0D [Alcohol and Cther Drug Thesaurus] |
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Search for Concepts With Selected Properties

Follow this procedure to search for concepts that have one or more selected properties
with values that match the search string.

1.
2.
3.

Click Concepts as your Search option.
In the Search For field, specify the property search string.

In the Search In area, click the option (Namespace, Subset, or Silo) that indicates
where you want to search, then from the accompanying dropdown list, select the
specific namespace, subset, or silo to search.

For namespace and subset searches, in the Search By field select Property as the
search parameter for the string you specified in the Search For field. A list of
current property types displays in the Search On list area.

From the Search On field list, select one or more property types for which to
conduct the search.

e To select two or more nonadjacent property types, click the name of one
property type, then hold down Ctrl and click the name of each additional
property type. Each property type you select is highlighted.

e To select adjacent property types, click the name of the first property type in
the list, then hold down Shift and click the name of the last property type in
the list. All the property types between the first and last are highlighted.

For the selected property types, only concepts with property values that match the
search string you specified will be matched and retrieved from the search. In the
illustration, the property type Reviewed By [NDF-RT] was selected.

Tree | Walker Search |

Search: Concepts & Synonyms o Concepts " Terms

Mz Results : |1 a LI '

Search For : I*pharmacologic*

Searchin: % Mamespace ¢ Subset ¢ Silo

MCI Thesaurus [Mational Cancer Institute Thesaurus]

MIC [Mursing Interventions Classification]

4 |

Search By : Ipmpem,.

I'_I;ILIL L

I

FxMorm_Strength [ NDF-RT |

™ wiord Match

Search Results Matches Found : O
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6. Click Search. Concepts with the selected property type(s), with values that
contain the search string you specified in the Search For field, display in the
Search Results area in the lower portion of the panel.

Note the matched concepts retrieved when the selected property type is Reviewed
By [NDF-RT], and the search string is *pharmacologic*; each returned concept
references the namespace from which it was retrieved.

Tres | Wialker Search |

Search: Concepts & Synonyms (o Concepts  Terms

hiax. Results |1 1] LI Search

Search For : I*pharmacologic*

Searchln: & Mamespace " Subset  Silo

NGl Thesaurus [National Cancer Institute Thesaurus]

MIC [Mursing Interverntions Classification]
4 |

Search By IPFDDEYTY

I'_I;ILI‘_ L]

Search 0N Ipharmacologic_sction [ MOF-RT |

I wiord Match

Matches Found @ 108

OLY ZED PREPARATION [ MDF-RT ]
CHLORIDE (&5 PO Lkg) PREPARATION [ MDF-RT |
CHOLESTYRAMIMNE PREFPARATICN [ MDF-RT ]
CINMARMEDRIME PREFPARATION [ MDF-RT |
POTASSIUM ACETATE PREPARATION [ NDF-RT ]
POTASSIUM BICAREONATE PREPARATION [ NDF-RT |
POTAZSIUM CHLORIDE PREPARATION [ MOF-RT ]
POTAZSIUM CITRATE PREPARATION [ MDF-RT ]
POTAZSIUM GLUCOMATE PREPARATION [ MDF-RT ]
FROFLANIME PREPARATION [ NDF-RT ]

Search for Concepts Using the Word Match Feature

The word match search feature works in conjunction with the property search. It allows
you to search for a concept based on property when you may not know the property’s
exact (search string) value. If you specify as the search string those words you believe
apply to the property value, the DTS Editor search will retrieve all concepts that contain
those words, in any arrangement, as part of the selected property type(s).

The word match search restricts the search to only those concepts with property types that
have the CONTAINS INDEX column marked T (true) in the setContains.sql file
(DTSInstall\ scripts\Oracle). Refer to the Configure Word Match Search discussion in
the Knowledgebase Administrators Guide for configuration instructions — note that the
Knowledgebase Administrator must run the Knowledgebase Admin utility in order for
the word match search feature to be implemented.
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Follow this procedure to search for concepts using the word match feature:

1. Specify the search string in the Search For field. For the property word match
search, you can specify two or more words. The search results will be those
concepts for which all of the specified search string words are included in the
property value (in any order) for the selected property types.

Note: When doing a word match search, you cannot perform a “search all”
wildcard search (i.e., you cannot enter a “*” in the Search For field). There must
be at least one other letter on which to base the word match search.

2. Inthe Search In area, click the option (Namespace, Subset, or Silo) that indicates
where you want to search, then from the accompanying dropdown list, select the
specific namespace, subset, or silo to search.

3. For namespace and subset searches, in the Search By field select Property as the
search parameter for the string you specified in the Search For field. A list of
current property types displays in the Search On list area.

4. From the Search On field list, select one or more property types for which to
conduct the search. In the example, property type NDF_Trade Name [NDF-
RT] is selected.

Tree I Walker Search I

Search: Concepts & Synonyms (:'Cuncapis  Terms

Max. Results © |1 0 LI :

Search Far : I*NEW FORMULA*

Searchlh: (:'Namespace " Subzet  Sio

MC| Thesaurus [Mational Cancer Institute Thesaurus]

MIC [Murzing Interverntions Classification]
d| |

Search By : Ipmpe”y

ILI;ILF_ L

Search 0N IWDF Single_or_Muli Source Product [ MDF-RT |
MDF _Strength [ MOF-RT ]
FDF_Trade_Mame [ NDF-RT |

MDF _Transmit_to_CMOP [ NDF-RT |

K

™ winedd htatrh

Search Results Matches Found :

|
5. Click the Word Match field checkbox to select the word match search parameter.

6. Click Search. Concepts with the selected property type(s), with values that
contain the specified search string words (in any order) specified in the Search
For field, display in the Search Results area in the lower portion of the panel.
Note the matched concepts retrieved when the word match option is selected, the
selected property type is NDF_Trade_Name [NDF-RT], and the search string is
*NEW FORMULA*; each returned concept references the namespace from
which it was retrieved.
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Tree | wialker Search |

Search: Concepts & Synonyms (o) Concepts " Terms

Mz, Results |1D LI :

Search For I*NEW FORRMUL2*

SearchIn: (% " subset Sio

MC| Thesaurus [Mational Cancer Institute Thesaurus]

[ |
MIC [Mursing Interventions Classification] -
R B
=
[ |
[ ]

Search By : IPFUDEVTY

Search On: |WDF_Single_or_Multi_Source_Product [ NDF-RT |
NDF_Strength [ NDF-RT |
MDF_Trade_Mame [ NDF-RT |
NDF _Transmit_to_CMOF [ NDF-RT ]

[ wiard Metch

Search Results © Matches Found : 10
ASA Z25MGEBUTALBITAL SOMGICAFM 400G TAE [MDC: 00904359230] [ MDF-RT ]
ASPIRIN 325MGACARISOPRODOL 200MG TAE [NOC: 00037210301] [ MDF-RT |

ASPIRIN 325MGACARISOPRODOL 200MG TAE [NODC: 00037210378] [ MDF-RT |

ASPIRIN 325MGACARISOPRODOL 200MG TAE [NODC: 00037210355] [ MDF-RT |
(CODEIME 16MG/ASA 32SMGICARISOPRODOL 200MG TAE [MDC: 00037240378] [ MDF-F
DIHY DROCODEINE 1 BMGIAPAP 356MGICAFN 30MG CAP [NDC: 000631 29006] [ MODF-RT
PHENYLEPHRIME HCL 0.5% SOLM MASAL SPRAY [MOC: 19510004701] [ NDF-RT ]
PHENYLEPHRIME HCL 0.5% SOLM MASAL SPRAY [MOC: 19510004702] [ NDF-RT ]
PHENYLEPHRIME HCL 0.5% MEMTHOL SOLM MASAL SPRAY [MDC: 19510004501] [ MOF
PHERYLEPHRIME HCL 0.5% MEMTHOL SOLM MASAL SPRAY [MDC: 19510004502] [ MOF

Only the concepts for which the selected property type (NDF_Trade_Name
[NDF-RT]) value includes both the words NEW and FORMULA were
retrieved.

Search For Concepts With Selected Roles
Follow this procedure to search for concepts that have one or more selected role types.

1.
2.

Click Concepts as your Search option.
In the Search For field, specify the search string for concept role values.

In the Search In area, click the option (Namespace, Subset, or Silo) that indicates
where you want to search, then from the accompanying dropdown list, select the
specific namespace, subset, or silo to search.

For namespace and subset searches, in the Search By field select Role as the
search parameter for the role type value string parameter you specified in the
Search For field. A list of current role types displays in the Search On list area.

From the Search On field list, select one or more role types for which to conduct
the search.

e To select two or more nonadjacent role types, click the name of one role type,
then hold down Ctrl and click the name of each additional role type. Each
role type you select is highlighted.
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e To select adjacent role types, click the name of the first role type in the list,
then hold down Shift and click the name of the last role type in the list. All the
role types between the first and last are highlighted.

Only concepts with role type values that contain the search string you specified,
for the selected role types, will be matched and retrieved from the search. In the
example, the role type Cl_with [NDF-RT] was selected.

Tree | Waker Sestch |

Search: { Concepls & Synonyms {* Concepts  { Terms

hax. Results : |1D LI :

Search For I*bnne"

Searchin: % Namespace § Subzet [ Siln

Ml Thesaurus [Mational Cancer Institute Thesaurus]

MIC [Mursing Interventions Classification]
| |

Search By : IRo\e

I'_ILILI; L]

Search On: o) PE [ NDF-RT |

effect_tnay_be_inhibted by [ NDF-RT |
gene_encodes_for [ NDF-RT |

=

Search Results : Matches Found : 0

Click Search. Concepts that have the selected role type, with values that contain
the search string you specified in the Search For field, display in the Search
Results area in the lower portion of the panel. Note the matched concepts
retrieved when the selected role type is ClI_with [NDF-RT], and the search string
IS *bone*; each returned concept references the namespace from which it was
retrieved.

Tree | waker Search |

Seatch: { Concepts & Synohyms  ©® Concepts  © Terms

Max. Results : |1E| ;I :

Search For : I*bnne*

Searchin:  Namespace ¢ Subset © Sio

MCI Thesaurus [Mational Cancer Institute Thesaurus]

=
MIC [Mursing Intervertions Classification] -
1] |

=l

]

Search By IRO‘e

Search On: o) PE [ NDF-RT |

effect_may_be_inhibited_by [ NDF-RT ]
gene_encodes_for [ NDF-RT ] LI

Search Results Matches Found @ 10

ACETOPHEMA ZIMNE MALEATE PREPARATION [ MDF-RT |
ACETOPHENAZINE PREPARATION [ NDF-RT |
AURANCFIN PREPARATION [ MOF-RT ]
AUROTHICGLUCOSE PREPARATION [ MDF-RT |
CARBAMAZEPINE PREPARATION [ NDF-RT ]

DEXTRAN 1 PREFARATION [ NDF-RT |

DEXTRAN 40 PREPARATION [ MDF-RT ]

DEXTRAN 70 PREPARATION [ MDF-RT ]

DEXTRAN 75 PREPARATION [ MDF-RT ]

DEXTRAN HW PREPARATION [ NDF-RT |
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Search for Concepts With Selected Inverse Roles
Follow this procedure to search for concepts that have one or more selected inverse role

types.
1.

2.
3.

Click Concepts as your Search option.
In the Search For field, specify the search string for concept inverse role values.

In the Search In area, click the option (Namespace, Subset, or Silo) that indicates
where you want to search, then from the accompanying dropdown list, select the
specific namespace, subset, or silo to search.

For namespace and subset searches, in the Search By field select Inverse Role as
the search parameter for the inverse role value string parameter you specified in
the Search For field. A list of current role types displays in the Search On list
area.

From the Search On field list, select one or more role types for which to conduct
the search.

e To select two or more nonadjacent role types, click the name of one role type,
then hold down Ctrl and click the name of each additional role type. Each
role type you select is highlighted.

e To select adjacent role types, click the name of the first role type in the list,
then hold down Shift and click the name of the last role type in the list. All the
role types between the first and last are highlighted.

Only concepts with inverse role values that contain the search string you
specified, for the selected role types, will be matched and retrieved from the
search. In the example, the role type CI_with [NDF-RT] was selected.

Tres | walker Search |

Search: { Concepts & Synonyms  ©* Concepts  © Terms

Ma. Results : |1D LI :

Search Far : I*POTASSIUM ICDIDE*

Searchln: % Mamespace ¢ Subset § Sio

MCI Thesaurus [Mational Cancer Institute Thesaurus]
MIC [Mursing Interventions Classification]
1| | B

Bl
-
Search By Ilnverse FRole LI
Bl
=

Search On: |c| pE [ NDF-RT ]

effect_may_he_inhibited_by [ MDF-RT |
gene_encodes_for [ NDF-RT ]

Search Results Matches Found : 0
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Click Search. Concepts that have the selected inverse role type, with values that
contain the search string you specified in the Search For field, display in the
Search Results area in the lower portion of the panel. Note the matched concept
retrieved when the selected role type is ClI_with [NDF-RT], and the search string
is *POTASSIUM IODIDE¥; the returned concept references the namespace
from which it was retrieved.

Tree | Walker Search |

Search: Concepts & Synonyms 1+ Concepts " Terms

e Results © |1 0 LI :

Search For I*POTASSIUM IODIDE*

 Subset © Silo

Searchin: (=

MCI Thesaurus [Mational Cancer Institute Thesaurus]
MIC [Mursing Interventions Classification] _I_I
4 | E

=
-
Search By : Ilnverse Role LI
|
[

Search On o) PE [ MDF-RT ]

effect_may_be_inhibited_by [ NDF-RT ]
gene_encodes _for [ NDF-RT |

Search Results : Matches Found : 1

Goiter [ NDF-RT ]

Search for Concepts With Selected Concept Associations
Follow this procedure to search for concepts that have one or more selected associations.

1.
2.

Click Concepts as your Search option.

In the Search For field, specify the search string for the name of the target
concept in the concept association.

In the Search In area, click the option (Namespace, Subset, or Silo) that indicates
where you want to search, then from the accompanying dropdown list, select the
specific namespace, subset, or silo to search.

For namespace and subset searches, in the Search By field select Concept
Association as the search parameter for the name of the target concept in the
concept association (i.e., the string you specified in the Search For field). A list
of current association types displays in the Search On list area.

The Type Namespace field displays if you selected Concept Association as the
search parameter in the Search By field. The default is to search All namespaces
for association types that match the other search criteria. The Type Namespace
field gives you the option of filtering the search further. From the Type
Namespace field dropdown list, select the namespace in which the association
type must exist in order to be included as a Search On selection option.
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6. From the Search On field list, select one or more association types for which to
conduct the search.

e To select two or more nonadjacent association types, click the name of one
association type, then hold down Ctrl and click the name of each additional
association type. Each association type you select is highlighted.

e To select adjacent association types, click the name of the first association
type in the list, then hold down Shift and click the name of the last association
type in the list. All the association types between the first and last are
highlighted.

Only concepts that have concept associations with target concept names that
contain the search string you specified, for the selected association type(s), will be
matched and retrieved from the search. In the example, the association type
Related To [AOD [Alcohol and Other Drug Thesaurus ]] was selected.

Treel Wyalker Search |

Search: { Concepts & Synonyms (% Concepts  ( Terms

e, Results |1D LI :

Search Far: I*alcohol*

Searchin: O Mamespace O Subzet O Sio

D [Alcohol and Cther Drug Thesaurus]

-

A0D

(CCS [Clinical Classifications Software] -

¥ ol
[
=

Search By IConcept Azsociation

Type Mamespace: IAII

Search On: Pozsibly Synonymous To [WHOART MAHO Adverse Reaction Termi;l

Related To [ ACD [Alcohaol and Other Drug Thesaurus] |
Felated To [ CCS [Clinical Clazsifications Software] | _ILI
1| »

-

Search Results Matches Found : 0

!

7. Click Search. Concepts that have the selected association type in the namespace
you designated, that have concept associations with target concept names that
contain the search string you specified in the Search For field, display in the
Search Results area in the lower portion of the panel.

Note the matched concepts retrieved when the selected association type is
Related To [AOD [Alcohol and Other Drug Thesaurus ]], and the search string
is *alcohol*; each returned concept references the namespace from which it was
retrieved.
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Tree | Walker  Search |

Search: { Concepts & Synonyms  {* Concepts  © Terms

Max. Resufts |1 1} LI 7

Search For I"alcuhul*

Searchin: 1= fl e  Supset  Silo

Cther Drug Thesaurus]

-
CCS [Clinical Classifications Software] -
1| | »
=l
=

Search By : |concept Associstion

Type Namespace: IAII

Seatch 0N Ipozsihly Synonyinous To [ WHOART MAHO Adverse Reaction Tarmi;l

s/cohnl and Cther Drug Thesaurus] |
Relsted To [ CCS [Clinical Classifications Software] | _ILI
4| 3

Search Results : Matches Found : 10

acetaldehyde (CO000966] [ ACD [Alcohal and Cther Drug Thesaurus] |

mcetone [CO001002] [ AOD [Alcohal ahd Cther Drug Thesaurus] |

mchvertizing [CO001690] [ ACD [Alcohol and Cther Drug Thesaurus] |

agoraphobis [(C0001815] [ ACD [Alcohol and Other Drug Thesaurus] |

zlcohal dependence [CO001973] [ 20D [Alcohal and Cther Drug Thesaurus] |

alcohal in any form [CO001975] [ ACD [Alcohol ahd Cther Drug Thesaurus] |

alcohol intoxication [C0001963] [ ACD [Alcohol and Cther Drug Thesaurus) |

alcohalic Werhicke-Korsakotf peychosis [CO001940] [ AQD [Alcohol ahd Other Drug Thes:
alcoholic beverage [CO001967] [ ACD [Alcohol and Cikher Drug Thesaurus] |

aldehydes [CO001992] [ ACD [Alcohol and Cther Drug Thesaurus] ]

Search for Concepts With Selected Inverse Concept Associations
Follow this procedure to search for concepts with the selected inverse association types.

1.
2.

Click Concepts as your Search option.

In the Search For field, specify the search string for the name of the from concept
in the concept association.

In the Search In area, click the option (Namespace, Subset, or Silo) that indicates
where you want to search, then from the accompanying dropdown list, select the
specific namespace, subset, or silo to search.

For namespace and subset searches, in the Search By field select Inverse
Concept Association as the search parameter for the from concept name string
specified in the Search For field. A list of current association types displays in
the Search On list area.

The Type Namespace field displays if you selected Inverse Concept Association
as the search parameter in the Search By field. From the Type Namespace field
dropdown list, select the namespace in which the association type must exist in
order to be included as a Search On selection option.

From the Search On field list, select one or more association types for which to
conduct the search.

e To select two or more nonadjacent association types, click the name of one
association type, then hold down Ctrl and click the name of each additional
association type. Each association type you select is highlighted.
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e To select adjacent association types, click the name of the first association
type in the list, then hold down Shift and click the last association type in the
list. All the association types between the first and last are highlighted.

Only concepts that have concept associations with from concept names that
contain the search string you specified, for the selected association type(s), will be
matched and retrieved from the search. In the example, the association type
Parent Of [AOD [Alcohol and Other Drug Thesaurus ]] was selected.

Tree | wialker Search |

Search: { Concepts & Synonyms (% Concepts ¢ Terms

Max. Results © |1 o LI :

Search For I*fetal*l

Searchin: (% Namespace ¢ Subset ¢ Silo

CCS [Clinical Classifications Software]
I .

Search By Ilnverse Concept Association

=
Type Mamespace: IAII LI
]

Search On -

Marrover Than [WVWHOART MWHO Adverse Reaction Terminology]
Parert Of [ AQD [2 ol Cther Drug Thesaurus] ]

Parent Of [ CCS [Clinical Classifications Software] ] -
- PSS - .,I_ "_I

hago

Search Results Matches Found : 0

I

Click Search. Concepts that have the selected association type, in the namespace
you designated, with associations that have from concept names that contain the
search string you specified in the Search For field, display in the Search Results
area in the lower portion of the panel.

Note the matched concepts retrieved when the selected association type is Parent
Of [AOD [Alcohol and Other Drug Thesaurus ]], and the search string is
*fetal*; each returned concept references the namespace from which it was
retrieved.

© 1999-2009 Apelon, Inc. All Rights Reserved.
Page 56 of 147



Tree | Walker | Search |

Search: { Concepts & Synonyms (% Concepts  © Terms

e, Results |1 o LI :

Search Far I*fetal*

Search In: g (" Subset { Sio

Search By Ilnverse Concept Association LI
Type Namespace: IAII ﬂ

Search On:

K1 - |

Search Results Matches Found : 7

F A5 with confirmed maternal alcohol exposure [C0814157] [ ACD [Alcohol and Cther Drug
FaS without confirmed maternal alcohol exposure [C0314156] [ A0D [Alcohol and Cther Dr
alpha fetoproteins [CO002210] [ &00 [Alcohal and Cther Drug Thesaurus] |

beta fetoproteins [CO301696] [ ACD [Alcohol and Other Drug Thesaurus] |
cardictocography [CO007 208] [ A0D [Alcohol and Other Druy Thesaurus] ]

fetal aspiration syndrome [C0349465] [ A0D [Alcohol and Cther Drug Thesaurus] |

partial FAS with confirmed maternal alcohol exposure [CO514155] [ ACD [Alcohal and Othe

Search for Concepts in a Knowledgebase “Silo”

Follow this procedure to search for concepts that contain the specified search string, and
that also reside within a specific knowledgebase silo. Each silo is a generated repository
of customized concept terminology data acquired from your knowledgebase, and
optimized for searching.

Included with Apelon DTS are the components you can use to generate and populate silos
with customized knowledgebase data. Refer to the DTS Knowledgebase Administrators
Guide for procedures on customizing the silos with data from your knowledgebase.

Follow this procedure to search for concepts within the knowledgebase silo(s) you select.
1. Click Concepts as your Search option.

2. Inthe Search For field, specify the concept/term search string.

3. Inthe Search In area, select Silo to indicate where you want to search for the
string you specified in the Search For field. If your DTS knowledgebase
administrator ran the DTS Selector & Extractor utility to create knowledgebase
silos, these generated silos are listed. Select the specific database silo in which to
search; only the selected silo will be searched for the string you specified.

Depending on the configuration for populating the silos, each silo may contain
data from multiple namespaces, or from a single namespace. Note that the
Namespace dropdown field is not available when you perform a silo search (this
is because the silo configuration determines which namespaces will be searched).
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4. At this point you can choose from a series of search features that allow you to

specify the level of “exactness” for the search of the selected silo. These are
referred to as the MatchPack matching options.

U CURPTCRN P artisl Lnder Match

[~ BestMatch Only [ Spell Checking

The Match Type allows you to choose from three increasingly tolerant types of
search matching. Matches are attempted in the order shown in the following
discussions.

. Complete Match: This is the most exact method of matching the search string
that you specify to either a concept name, or the name of one of its synonyms, , in
the silo you selected. Complete Match is always active (even if you choose one
of the other, more tolerant, matching methods).

e Through Complete Match, a match occurs and a concept is retrieved when
either the concept name, or the name of one of its synonyms, in the silo
contains the same words as the search string you specify, in any order.

e Every concept in the silo that has a name, or a synonym with a name, that
contains all the words in the search string (in any order) is retrieved.

. Under Match: If Under Match is activated, and Best Match Only also is active,
Complete Match is performed first (i.e., if either a concept name, or the name of
one of its synonyms, in the specified silo contains every word in the search string,
in any order, a match occurs). If complete matches are found, only these matches
are returned and no further matching attempt is made. If no concept matches
occur from the Complete Match, Under Match is attempted. If under matches are
found, only these matches are returned.

e If Under Match is activated, and Best Match Only is inactive, under
matches will be returned in addition to the complete matches.

e Through Under Match, a match occurs and a concept is retrieved if either
the concept name, or the name of one of its synonyms, in the silo matches
the search string words (in any order) and the concept term in the silo
contains words in addition to those in the search string.

. Partial Under Match: If Partial Under Match (the default) is activated, and Best
Match Only also is active, Complete Match is performed first (i.e., if either a
concept name, or the name of one of its synonyms, in the specified silo contains
every word in the search string, in any order, a match occurs). If complete
matches are found, only these matches are returned and no further matching
attempt is made.

e If no matches occur from Complete Match, Under Match is attempted. If
under matches are found, only these matches are returned.
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If no matches occur from Under Match, Partial Under Match matches are
attempted.

e If Partial Under Match is activated, and Best Match Only is inactive,
partial under matches are returned in addition to complete matches and
under matches.

e Through Partial Under Match, a match occurs and a concept is retrieved if
either the concept name, or the name of one of its synonyms, in the
specified silo contains all remaining words (in any order) after all
stopwords have been removed.

The following stopwords are those words that are considered as
unnecessary for the search:

A
and

by
for
in
NOS
of
on
the
to
with

e Example: For the search string attack in the heart and brain, the string
becomes attack heart brain because the stopwords in, the, and and are
discarded. If the words in the modified search string match either a
concept name, or the name of one of its synonyms, in the silo (in any
order) a match is returned.

5. The Spell Checking option is another of the MatchPack options you can use to
search the selected silo. In the event you enter a misspelled search string word,
spell checking generates suggested spelling variants against which matches are
attempted; concepts matched against these variants then are retrieved. If you
click the Spell Checking field checkbox, spelling correction will occur when
MatchPack attempts to match either a concept name, or the name of a concept
synonym, with the search string you specify.

You can use spell checking regardless of the matching option you select
(Complete Match, Under Match, or Partial Under Match). However, the
number of matched concepts retrieved from the search is dependent on the
matching method you select.

6. Click Search. Concepts in the selected silo that meet the search criteria you
specified display in the Search Results area in the lower portion of the panel.
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Search for Concepts in a Namespace Subset

Follow this procedure to search for concepts that contain the specified search string, and
that also reside within a specific namespace subset. A subset is a segment of concepts
created from a designated namespace, based on selection criteria that you define. Refer
to the DTS Subset Editor Users Guide for procedures on subset creation in DTS.

Follow this procedure to search for concepts in the namespace subset you select.
1. Click Concepts as your Search option.
2. Inthe Search For field, specify the concept/term search string.

3. Inthe Search In area, select Subset to indicate where you want to search for the
string you specified in the Search For field, then from the accompanying
dropdown list, select the specific subset in which to search.

Searchin: Matnespace * subzet  Silo

hALIED
MCEl Tax

4. In the Search By field, select the desired search parameter (e.g., Role, Property,
Concept Association, etc.).

Only concepts in the selected subset that match your search criteria, including the
search string you specified, will be retrieved from the search. In the example, the
subset NDF-RT was selected for a concept Name search.

Tree | Walker Search |

Search: ( Concepts & Synonyms % Concepts  ( Terms

Max. Results : |1 u] LI :

Search For : I*recep‘for"

Searchln: { Mamespace = Subset  Sio

Al
=
=
Search By : [lame LI
Search Results Matches Found :

5. Click Search. Each concept in the selected subset that has a concept name that
includes the search string you specified in the Search For field displays in the
Search Results area in the lower portion of the panel.
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Note the matched concepts retrieved from a concept Name search when the
selected subset is NDF-RT, and the search string is *receptor*; each returned

concept references the subset from which it was derived.

Tree | walker Search |

Search; ( Concepts & Synonyms  (* Concepts ) Terms

iz, Results |1 a LI :

Seatch Far I*receptor*

Searchin: € ]

& subset { Silo

Search BY : [ame LI

A

Search Results Matches Found : 10

a-hydroxytryptamine Receptor 24 [ NDF-RT ]
Beta 1 Receptor Gene Yariants [ NDF-RT |
Beta 1 Receptor Gene [ NDF-RT |

Beta Adrenergic Receptor [ MDF-RT ]
Eeta-1-Adrenergic Receptor [ MDF-RT ]

Cell Surface Receptor [ MDF-RT ]

5 Protein-Coupled Receptor Gene [ MDF-RT ]
5 Protein-Coupled Receptor [ MDF-RT |
Receptor Gene [ NDF-RT ]

Receptor [ MDF-RT ]
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Namespace Maintenance

Overview

Each namespace in DTS represents an individual source terminology (e.g., SNOMED,
ICD-9-CM). The DTS Editor provides a set of options that allow you to view data in all
namespaces, edit namespaces of certain types, and create new, local namespaces.

A namespace authority indicates the organization (e.g., U.S. National Library of
Medicine, U.S. Medical Terms Review) that approved and/or certified a specific
terminology. A namespace authority must be specified as part of each namespace
definition. In addition to namespace maintenance, authority maintenance is discussed in
this section.

A namespace’s locality indicates how the namespace data was acquired. A Subscription
namespace is one for which content was loaded into DTS through a subscription import.
A Local namespace is one that was created using the DTS Editor, or loaded from TDE
using the Knowledgebase Load utility, for the purpose of creating and maintaining local
terminology content.

In DTS a namespace is one of four distinct types: Ontylog, Thesaurus, Connection, or
Ontylog Extension. Each namespace type is described briefly, as well as the level of
functionality available in each namespace type using the DTS Editor.

Ontylog Namespaces

Ontylog is a language used to build and maintain large knowledgebases using description
logic. Concepts in Ontylog are organized into a taxonomy by a process called
classification. An Ontylog namespace is one developed using Apelon’s Terminology
Development Environment (TDE) suite of tools, including the Ontylog Editor.

The DTS Editor provides view capabilities for Ontylog subscription namespaces. In the
DTS Editor you can view the concept hierarchy tree in any selected Ontylog terminology
namespace. You also can view attribute details (e.g., properties, roles) for any selected
concept in the namespace.

You cannot use the DTS Editor to perform edits directly to an Ontylog-type subscription
namespace. However, the DTS Editor allows you to create and maintain new content for
the Ontylog subscription namespace through two different approaches.

e You can create a new local, editable Thesaurus namespace using the DTS Editor

0 Within this local namespace you can add new properties to the Ontylog
subscription concepts, create synonyms, create associations, and add
qualifiers to properties and associations.
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0 Because the local content is in a separate namespace, this approach
prevents inadvertent overwrite of any new local data (entered using the
DTS Editor) if updated TDE content is migrated into the DTS
knowledgebase at a later time. Refer to the Current Local Namespace
discussion later in this section.

e You can create an Ontylog Extension namespace

o0 Asits title implies, each Ontylog Extension namespace is an extension of
a specific Ontylog subscription namespace, created for the purpose of
creating/maintaining new local content for the linked Ontylog subscription
namespace.

0 In the Extension namespace you can add new concepts, add or change
concept relationships (i.e., superconcept/subconcept relationships) add or
change role relationship values, and add new associations for the Ontylog
namespace.

0 You can classify the Extension namespace against the linked Ontylog
subscription namespace, then view the new hierarchy for the Ontylog
Extension namespace; the displayed Extension namespace hierarchy
reflects both the linked Ontylog subscription namespace concepts, and
concepts from the Extension namespace.

0 Refer to the Create and Maintain Ontylog Extension Namespaces and
Classify an Ontylog Extension Namespace discussions in the Ontylog
Extension Namespaces and Extension Namespace Classification in DTS
document for more on Ontylog Extension namespaces and classification.

Note: You also can perform maintenance on Ontylog namespaces using the TDE Ontylog
Editor tool. Refer to the Ontylog Editor User Guide, included with the TDE product, for
details on maintaining Ontylog namespace data using that tool.

Thesaurus Namespaces

In DTS a Thesaurus hamespace is one that is created as a more localized collection of
concepts and terms. For Thesaurus namespaces, concepts are organized based on
relationships (associations) with other concepts.

Subscription namespaces with the type of Thesaurus are not editable in the DTS Editor.
However, you can create a new local namespace that is a Thesaurus type and create and
maintain content locally.

Connection Namespaces

Connection namespaces do not contain any concepts or terms. Rather, they contain
associations between concepts or terms in other namespaces.
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Current Local Namespace

Select Set Current Local Namespace from the Options menu to set a current local
namespace using the Set Current Local Namespace window. The namespace you specify
here becomes the default local (writable) namespace for the addition and maintenance of
the property types, association types, and qualifier types used during the addition of local
content to a subscription namespace.

Set Current Local Namespace B]

Choose a local namespace for storing local additions
to subscription namespaces. These may consist of
additional synonyrms, properties, or qualifiers.

Namespace: [NTENENEa

Ok, Cancel

Thereafter, you can add a new property, synonym, or association to a concept or term in a
subscription namespace, as long as the appropriate attribute type (e.g., property type)
exists in the current local namespace. You have the option of changing the local
namespace at a later time.

Attributes added in this manner to a concept or term in a subscription namespace are
listed in italics in the Concept/Term Details panel view, as well as in the Concept Tree
panel view (Container and Inline versions of the Ontylog Tree view). Note the
illustration.

El- 4 Synonyms

. -3¢ Boophilosis

-# Infestation by Boophilus { Prefarred )
-# Infestation by Boophilus (disorden
-# Infestation by Boophilus, MOS

""" # Synoynm Added o Subscription Wamespsceq—4—  Subscription Content Added to Local Namespace

The attributes themselves actually are written to the local namespace; no database
updates occur for the subscription namespace itself.

You must create at least one local namespace using the DTS Editor. The Editor allows
you to select a current, or working local namespace in which local content for any
subscription namespaces will be stored. You can change the current local namespace at
any time; the DTS Editor remembers the local namespace the next time you connect to it.
For your reference, the current local namespace always displays in the right-most panel
of the Status Bar at the bottom of the DTS Editor Main window.

For the purpose of adding local content, you will create property types, concept or term
association types, and qualifier types in a local namespace. When you add properties to a
concept, the property types do not have to reside in the same namespace as the concept,
but can be in a local namespace.
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Synonymous association types and synonyms also may reside in a local namespace.
Qualifier types may reside in the local namespace as well, and do not have to be in the
same namespace as the properties or associations they modify.

Since the current local namespace may be changed, it is not necessary for local content
for a subscription namespace to be stored in a single local namespace. Local concepts
and terms may, of course, be created in a local namespace and associated with concepts
and terms in the subscription namespace.

Since properties, synonyms, and associations are attached directly to concepts in the
subscription namespace, you can retrieve these details along with the existing
subscription attributes of the concepts. In the DTS Editor, when you add or modify
properties, synonyms, associations, or qualifiers of a subscription concept, the list of
types (e.g. property types) will be those defined in the current local namespace, rather
than those in the subscription namespace. When you perform a search in the DTS Editor,
the list of relevant types offered as search options will be those types defined in the
selected subscription or local namespace.

Create a Local Namespace

Follow this procedure to add a new local namespace to your knowledgebase. Note: You
cannot create a local namespace if you connected to the DTS Editor using a secure socket
server connection (the New button is disabled). You must connect to the DTS Editor
using a JDBC connection or socket server connection in order to add a new namespace.
Refer to the Connect to DTS Editor discussions for connection procedures.

1. To create a new namespace, select Namespace from the DTS Editor Main window
Tools menu. The Namespace Editor window displays.

S Mamespace Editor |
Delete |
Namespace | Type | Local | Extenss |
ACD [Alcohol and Cther Drug Thesaur... Thesaurus FALSE -
CCS [Clinical Classifications Software]  Thesaurus FALSE
COSTART [Coding Sytrbols for & Thes... Thesaurus FALSE
CPT Cntylog FALSE
CRISP Thesaurus Thesaurus FALSE
DStV [Disgnostic and Statistical Man... Thesaurus FALSE
HCPCS Thesaurus FALSE
HH [Heme Health Mare Classifiestion]  Thesair s Fil oF LI
Name: |
ID: |
Code: |
Authority: | IApeInnS LI
Type: |Onwlug Ll
Linked Hamespace: | LI
Permission: IRead—OnIy LI
Locality: ISubscrlmmn LI
Apply | Cloge

2. Click New. The fields in the lower portion of the window are enabled.
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In the Name field, specify the name (i.e., title) of the namespace you are creating.
Note that the namespace name should not include double quotes (7).

In the ID field, specify the ID for your new local namespace, which can be
between zero and 65535. If you specify a number less than 32768, DTS adds the
number 32768 to the ID number you specify to create an internal namespace ID.

The calculated ID displays for your reference, as well as the ID number you

entered (referred to as the relative ID). If the calculated ID number is in use
already, a message displays to indicate the duplication; enter an alternate 1D

number.

You must specify this internal namespace ID if you want to publish this local
namespace content for your own subscribers using the kbcontent-publish utility.
Refer to the Publish Client’s Local Namespace discussion in the Knowledgebase
Administrators Guide for local content publishing procedures.

Specify a namespace Code for additional namespace identification; the code can
be formatted however you want.

An authority indicates the organization (e.g., U.S. National Library of
Medicine) that approved and/or certified a terminology. From the Authority field
dropdown list, select the established authority for the new namespace. Refer to
the Authority View and Maintenance discussions for procedures on viewing and
creating authorities.

. A namespace is one of four types: Ontylog, Thesaurus, Connection, or Ontylog
Extension. You can create Thesaurus, Connection, or Ontylog Extension
namespaces locally and make them read-only or editable. From the Type field
dropdown list, select the type of terminology (Thesaurus, Connection, or
Ontylog Extension) represented in this namespace. Refer to the Overview
discussions under Namespace Maintenance for more on the Thesaurus and
Connection namespace types.

You can create an Ontylog Extension namespace as an extension of an Ontylog
subscription namespace. In the Ontylog Extension namespace you can create
new concepts for an Ontylog subscription namespace, then classify the Extension
namespace against the linked Ontylog subscription namespace.

Refer to the Create and Maintain Ontylog Extension Namespaces and Classify an
Ontylog Extension Namespace discussions in the Ontylog Extension Namespaces
and Extension Namespace Classification in DTS document for more on Ontylog
Extension namespaces and classification.
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8.

10.

11.

12.

The Linked Namespace field is enabled only if you are creating an Ontylog
Extension namespace for an existing Ontylog subscription namespace (i.e., the
value in the Type field is Ontylog Extension). The field is disabled for all
namespaces other than those of the Ontylog Extension type. In the Namespace
Editor window, the linked Ontylog subscription namespace is referenced in the
Extends column.

Select the Ontylog subscription namespace for which you are creating the new
Extension namespace. In the Extension namespace you can create and edit
concepts for the linked Ontylog subscription namespace. You also can classify
concepts in the Extension namespace against the content in the Ontylog
subscription namespace.

Refer to the Create and Maintain Ontylog Extension Namespaces and Classify an
Ontylog Extension Namespace discussions in the Ontylog Extension Namespaces
and Extension Namespace Classification in DTS document for more on Ontylog
Extension namespaces and classification.

The namespace permission indicates whether or not the local namespace is
editable. From the Permission field dropdown list, select the level of permission
(Read-Only or Read-Write) a user will have in this namespace.

The namespace Locality indicates how the namespace data was acquired. Local
is the value for a namespace created using the DTS Editor, or loaded from TDE
using the Knowledgebase Load utility, for the purpose of creating and
maintaining local terminology content; the field is not editable.

Click Apply to add the namespace to the knowledgebase. The new namespace is
added to the table on the Namespace Editor window, which remains displayed,;
you can click New again and create additional local namespaces.

When you finish creating, viewing, and editing namespaces, click Close to close
the Namespace Editor window.
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View and Edit an Existing Namespace

Follow this procedure to view information for an existing subscription namespace, or
local namespace in your knowledgebase. For a local namespace, you can edit the
information as necessary. Subscription namespace information is not editable.

1. To view or edit an existing namespace, select Namespace from the DTS Editor
Main window Tools menu. The Namespace Editor window displays.

& Namespace Editor x|
MNamespace | Type | Local | Extends |
A00 [Alcohol and Other Drug Thesaur... Thesaurus FALSE -~
(CCS [Clinical Classifications Software]  Thesaurus FALSE
COSTART [Coding Symbols for a Thes... Thesaurus FALSE
CPT Critylog FALSE
CRISP Thesaurus Thesaurus FALSE
DSh-1Y [Diagnostic and Statisticsl Man... Thesaurus FALSE
HCPCS Thesaurus FALSE
HHI™ HAme Health Pare Classification]  Thesaon s Fal oF LI
Name: |
D: |
Code: |
Authority: | [2nelone |
Type: IOnhrog ;I
Linked Namespace: | LI
Permission: |Read-0n\y LI
Locality: |5ubscr|pt|on LI
Al | Cloze |

Information for each existing namespace is listed in a table format. Information
includes the namespace name and namespace type (Ontylog, Thesaurus,
Connection, or Ontylog Extension). An indicator referencing if each namespace
is a local namespace (TRUE, FALSE) is included as well. For each listed
Ontylog Extension namespace, the name of the Ontylog subscription namespace
to which it is linked is referenced.

You can resize the table columns. To change the sort for the namespace list, click
the column header for the characteristic (Namespace, Type, Local, or Extends)
on which you want to base the sort.

2. Inthe table listing, click the namespace you want to view or modify to highlight
the row. The data in the bottom portion of the window changes to reflect
information from that namespace.
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= Namespace Editor x|
oo |
| Matmespace I Type I Lacal I Extends I
I I -
SMOMED CT EXTEMSIORN Crtylog Extension  TRUE SMNOMED CT
SMOMED CT Inactive Thesaurus FALSE
'SPM [Standard Product Nomenclature]  Thesaurus FALSE
Triac Oritylog FALSE
UMDNS [Universal hedical Device Mom... Thesaurus FALSE J
UMLE Aszociations Connection FALSE LI
Mame: [SHOMED CT
ID: o0
Code: [SHONED
Authority: | IApeIonS LI
Type: |Ontvlng I
Linked HNamespace: | LI
Permission: |Read-0nly j
Locality: ISubscript\nn LI
Apply. | Close

The namespace Name displays. This field is editable for a local namespace.

The ID for an existing namespace is not editable, regardless of whether it is a
subscription or local namespace. See the Create a Local Namespace discussion
for information on assigning a namespace ID to a new local namespace.

The Code provides additional namespace identification, and can be formatted
however you want. The Code for an existing namespace is not editable,
regardless of whether it is a subscription or local namespace.

An authority indicates the organization (e.g., U.S. National Library of
Medicine) that approved and/or certified a terminology. For a local namespace,
select an alternate, established authority from the Authority field dropdown list.
Refer to the Authority View and Maintenance discussions for procedures on
viewing and creating authorities.

A namespace is one of four types: Ontylog, Thesaurus, Connection, or Ontylog
Extension. Each namespace may be a subscription namespace, or a local
namespace. Refer to the Overview discussions under Namespace Maintenance
for more on namespace types.

Using the DTS Editor you can create an Ontylog Extension namespace as an
extension of an Ontylog subscription namespace. In the Extension namespace
you can create new concepts for an Ontylog subscription namespace, then classify
the Extension namespace against the linked Ontylog subscription namespace.

Refer to the Create and Maintain Ontylog Extension Namespaces and Classify an
Ontylog Extension Namespace discussions in the Ontylog Extension Namespaces
and Extension Namespace Classification in DTS document for more on Ontylog
Extension namespaces and classification.
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10.

11.

A Thesaurus namespace may be either a subscription namespace or a local
namespace. Using the DTS Editor you can create a new local namespace as either
a Thesaurus or Connection namespace. For a local namespace, select the type
of terminology represented by this namespace from the Type field dropdown list.

If you are viewing or editing information for an Ontylog Extension namespace,
the value in the Linked Namespace field reflects the Ontylog subscription
namespace to which it is linked. The field is blank for namespaces other than
those of the Ontylog Extension type. In the Namespace Editor window, the
linked Ontylog subscription namespace is referenced in the Extends column.

Refer to the Create and Maintain Ontylog Extension Namespaces and Classify an
Ontylog Extension Namespace discussions in the Ontylog Extension Namespaces
and Extension Namespace Classification in DTS document for more on Ontylog
Extension namespaces and classification.

The namespace Permission indicates whether or not the namespace is writable.
For a local namespace, select the level of permission (Read-Only or Read-
Write) in this namespace from the Permission field dropdown list. Subscription
namespaces are Read-Only.

The namespace Locality indicates how the namespace data was acquired.
Subscription indicates a load of namespace content into DTS through a
subscription import. Local indicates the namespace was created using the DTS
Editor, or loaded from TDE using the Knowledgebase Load utility, for the
purpose of creating and/or maintaining local terminology content. This field is
not editable for existing namespaces.

Click Apply (which becomes enabled if you make an edit) to update any
namespace edits. To ignore the edits, click on any other namespace listed in the
table to display information specific to that namespace.

When you finish viewing/editing namespaces, click Close to close the Namespace
Editor window.
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Delete a Local Namespace

Follow this procedure to delete an existing local namespace from your knowledgebase
(i.e., one that is not set as the current local namespace). Note: You cannot delete a local
namespace if you connected to the DTS Editor using a secure socket server connection
(the Delete button is disabled). You must connect to the DTS Editor using a JDBC
connection or socket server connection in order to delete an existing local namespace.
Refer to the Connect to DTS Editor discussions for connection procedures.

1. To delete an existing local namespace, select Namespace from the DTS Editor
Main window Tools menu. The Namespace Editor window displays.

s Namespace Editor x|
Delete |
Mamespace | Type | Local I Extenids I
SO0 [Alcohol and Cther Drug Thesaur... Thesaurus FALSE &
CCS [Clinical Classifications Software]  Thesaurus FALSE
COSTART [Coding Sytrbols for & Thes... Thesaurus FALSE
CPT Cntylog FALSE
CRIZP Thesaurus Thesaurus FALSE
DSh-IY [Disgnostic and Statistical Man... Thesaurus FALSE
HCPCS Thesaurus FALSE
HHI™ [Hrame Health Mare Clascificstion]  Thesain = Fal <F LI
Hame: I
ID: |
Code: |
Authority: | IApeInnS LI
Type: |Ontylog 7]
Linked Namespace: | Ll
Permission: |Read-0nly LI
Locality: ISubscripﬁon ;I
AR | Close

Information for each existing namespace is listed in a table format. Information
includes the namespace name and namespace type (Ontylog, Thesaurus,
Connection, or Ontylog Extension). An indicator referencing if each namespace
is a local namespace (TRUE, FALSE) is included as well. For each listed
Ontylog Extension namespace, the name of the Ontylog subscription namespace
to which it is linked is referenced.

To change the sort for the namespace list, click the column header for the
characteristic (Namespace, Type, Local, or Extends) on which you want to base
the sort.

2. Inthe namespace table listing, click the namespace you want to delete to highlight
the row. The data in the bottom portion of the window changes to reflect
information from that namespace.

3. The Delete option is not available if you selected a subscription namespace.
Click the enabled Delete button if you selected a local namespace for deletion; a
confirmation window similar to the following displays.
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5.

Confirm Delete x|

Are you sure you wank to delete the Mamespace
PM -10 { 12587, 454544, Thesaurus )7
All concepts and other objects in this Mamespace

will be deleted,
Cancel |

Click OK to delete the namespace from the knowledgebase; the namespace is
deleted from the table on the Namespace Editor window. All concepts, terms,
and associations from the namespace are deleted as well. Click Cancel to ignore
the deletion.

The DTS Editor will not permit you to delete the current local namespace. If you
select the current local namespace for deletion, a window like the following
displays .

This Mamespace is set as the Current Local Namespace,
you musk choose another local namespace as wour Current
Local Namespace before it can be deleted.

Before you attempt to delete this namespace again, you must set an alternate local
namespace. Refer to the Current Local Namespace discussion for instructions on
setting the local namespace.

Click Close to close the Namespace Editor window.

Authority View and Maintenance

A namespace authority indicates the organization (e.g., U.S. National Library of
Medicine, U.S. Medical Terms Review) that approved or certified a terminology. A
namespace authority must be specified as part of each namespace definition.

Create an Authority
Follow this procedure to create an authority that you can assign to a local namespace.

1.

Click the Authority field button on the Namespace Editor floating window. The
Authority Editor window displays.

Authority Editor x|

LILUTT TS National Library of Medicine

Name: |U.S Mational Library of Mecicine
0 2

Ok Cancel
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2. Click New. The information for the existing displayed authority is cleared.

Authority Editor x|

I |

Authority: | =

Name: I

D |

3. Specify the name of the authority for a local namespace in the Name field.

4. Inthe ID field specify the ID number of the authority for a local namespace. To
avoid using an ID value already reserved for use by Apelon, enter an authority ID
number between 1000 and 2000 (inclusive).

5. Click OK to update the knowledgebase with the new authority, or click Cancel to
ignore the addition.

View an Existing Authority for a Local Namespace
Follow this procedure to view information for an existing, local namespace authority.

1. For a local namespace, click the Authority field button on the Namespace Editor
window. The Authority Editor window displays.

Authority Editor x|
|

LT UGTAA LS. hational Library of Medicine

Mame: ILI 5. National Library of Medicine

D 2

Ok Cancel

The information listed is from the first authority in the knowledgebase, listed in
alphabetical order.

2. From the Authority field dropdown list, select the authority you want to view (the
list is alphabetical). The data in the window changes to reflect information from
that authority.

3. The title for this authority displays in the Name field.
4. The identification number assigned to this authority displays in the ID field.

5. Click OK when you are through viewing authority information, and to close the
Authority Editor window.
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Delete an Authority

Follow this procedure to delete an existing authority. Note that you can delete the
authority if it is used by editable local namespaces only; you cannot delete the authority
if it is used by a subscription namespace, or by a read-only local namespace.

1. Click the Authority field button on the Namespace Editor window. The
Authority Editor window displays.

Authority Editor x|

ey Delete |

FILG TPl LS, Mational Library of Medicine

MHame: IU.S. National Library of Medicine
D 2

Ok Cancel

The information listed is from the first authority in the knowledgebase, listed in
alphabetical order.

2. From the Authority field dropdown list, select the authority you want to delete.
The data in the window changes to reflect information from that authority.

3. Click Delete. A confirmation window similar to the following displays.

Confirm Delete x|
@ Are yaou sure you want o delete the Authority:
SSC{ET

Cancel |

4. Click OK to delete the authority from the knowledgebase. Click Cancel to ignore
the deletion.
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Association Maintenance

This section includes basic procedures for creating and maintaining associations between
concepts or terms. An association type (e.g., Related To) is assigned to each association
between concepts or terms to define the nature of the association. An association may
also have a qualifier, which provides additional detail regarding the nature of the
association (e.g., Usually). Procedures for creating and maintaining association types
and qualifiers are included as well.

In a writable namespace you can create associations between concepts and terms that
reside in one namespace (writable or not) or create associations between concepts and
terms across namespaces. Refer to the Create a Concept/Term Association Within a
Namespace and Map Concepts or Terms Across Namespaces discussions for examples of
these scenarios.

Association Types

Each association you create between two concepts or terms must be assigned a specific
type to indicate the nature of the link (e.g., one concept is Broader Than the other, or is
a Parent of the other). The following procedures pertain to creating and maintaining
association types.

Create Association Types

Follow this procedure to add one or more new association types to an editable
namespace.

1. Select Association Types from the Tools menu. The Association Type Editor
window displays.

'S Association Type Editor x|
Delete |
Azsocistion Type I Matnespace | Connects I
Access (atribute) SMOMED CT Tuvo Concepts ﬁ’
Approach (stribute) SMOMED CT Tuvo Concepts
Aftribute PM -10 Twyo Concepts
Eroader Than CCS [Clinical Classifications Sof... Two Concepts
Eroader Than Crnaha System Twyo Concepts
Eroader Than DSM-IY [Disgnostic and Statistic... Two Concepts
Eroader Than ICD-10 Twyo Concepts
Broader Than MeSH Twwo Concepts
Broader Than A0D [Alcohol and Other Drug T... Twwo Concepts ;I

Name: |

: |
Code: |

Hamespace: |PM -0

Connects: ITwn Concepts

S

Purpose: |Arb'rtrary

Inverse Name: |

Apply Close |
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10.

11.

Information for each existing association type is listed in a table format.
Information includes the association type name, the namespace in which the
association was created, and an indicator that references if the association type is
for a connection between Two Concepts, between a concept and a synonym
(Concept With Synonymous Term) or between Two Terms.

To change the sort for the association type list, click the column header for the
characteristic (Association Type, Namespace, or Connects) on which you want
to base the sort.

Click New. The fields in the lower portion of the window are enabled.

In the Name field, enter a name that identifies the type of association you are
creating.

The association type ID is generated automatically, and displayed in the ID field.
You cannot modify the generated association type ID.

The association type code is generated automatically, and displayed in the Code
field. You cannot modify the generated association type code.

In the Namespace dropdown field, select the local, editable namespace in which
you are creating this association type. Only local namespaces are included in the
list.

The value in the Connects dropdown field indicates if the association type
represents a connection between Two Concepts, between a concept and a
synonym (Concept With Synonymous Term) or Two Terms. Select the kind of
connection this association type represents.

The value in the Purpose dropdown field indicates how associations assigned this
type will be used. Select Mapping when the association is to map concepts or
terms across namespaces. Select History when the association is created to
archive relationships between concepts or terms (for example, if a concept is
expected to be retired). Arbitrary (the default) applies for all other associations.

The Inverse Name describes the inverse relationship of this association, and
displays when you view Inverse Concept Associations (e.g., when you perform a
search). For example, "Is Narrower Than" is the inverse of "Is Broader Than."

Click Apply to update the selected local namespace with the new association
type; the new association type is added to the table on the Association Type Editor
window. The Association Type Editor window remains displayed; you can click
New again and create additional association types in the local namespace.

When you finish creating association types, click Close to close the Association
Type Editor window.
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View and Edit an Association Type

Follow this procedure to view information for an existing association type that exists in
any namespace, and edit the information if the association type was created in a local,
writable namespace.

1. Select Association Types from the Tools menu. The Association Type Editor
window displays.

3.

'S Association Type Editor x|
Delete |
Association Type Marmespace | Connects I
Access (attribute) SMOMED CT Twyo Concepts ﬂ
Approach (attribute) SMOMED CT Twyo Concepts
Aftribute PM -10 Twyo Concepts
Broader Than CCS [Clinical Classifications Sof... Two Concepts
Broader Than Omaha System Twwo Concepts
Broader Than DEM-IY [Diagnostic and Statistic. .. Two Concepts
Broader Than ICD-10 Twwo Concepts
Broader Than Me=H Twwo Concepts
Broader Than A0D [lcohol and Cther Drug T... Two Concepts LI

Name: |

: |
Code: |

Namespace: [ii-10

Connects: ITWo Concepts

N

Purpose: |Arb'rtrary

Inverse Name: |

Apply Close |

Information for each existing association type is listed in a table format, in
columns that you can resize. Information includes the association type name, the
namespace in which the association was created, and an indicator that references
if the association type is for a connection between Two Concepts, between a
concept and a synonym (Concept With Synonymous Term) or between Two
Terms.

To change the sort for the association type list, click the column header for the
characteristic (Association Type, Namespace, or Connects) on which you want
to base the sort.

In the association type table listing, click the association type you want to view or
modify to highlight the row. The lower portion of the window changes to reflect
information from that association type. If the association type you selected was
created in a subscription namespace, none of the fields are editable. If the
association type was created in a local, writable namespace, the editable fields are
enabled.

In the Name field, modify the association type name, as necessary.

© 1999-2009 Apelon, Inc. All Rights Reserved.
Page 77 of 147



10.

11.

The ID that was generated when the association type was created displays; the ID
is not editable, for any type of namespace.

The association type Code that was generated when the association type was
created displays; the code is not editable, for any type of namespace.

The Namespace in which the association type was created is not editable, for any
type of namespace.

The value in the Connects dropdown field indicates if the association type
represents a connection between Two Concepts, between a concept and a
synonym (Concept With Synonymous Term), or Two Terms. The value in the
Connects field is editable as long as this is an association type that was created in
a writable namespace, and no concepts exist that have this association type.

The value in the Purpose dropdown field indicates how associations assigned this
type will be used. Select Mapping when the association is to map concepts or
terms across namespaces. Select History when the association is created to
archive relationships between concepts or terms. Arbitrary (the default) applies
for all other association types.

The Inverse Name describes the inverse relationship of this association, and
displays when you view Inverse Concept Associations (e.g., during a search).
For example, "Is Narrower Than" is the inverse of "Is Broader Than."

Click Apply (which becomes enabled if you make an edit) to update the selected
local namespace with the association type edits; the Association Type Editor
window remains displayed for additional edits and/or additions.

To ignore the edits, click on any other association type listed in the table to
display information specific to that association type. When the confirmation
window similar to the following displays, click No to proceed without update of
the edits.

Select an Option x|

@ Do vou want save changes to Association Type PM Con 2 Term?

Ma | Cancell

Click Close to close the Association Type Editor window.
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Delete an Association Type

Follow this procedure to delete an existing association type that was created in a local,
writable namespace. If there are associations that exist with this association type, you
will not be permitted to delete the association type.

1. Select Association Types from the Tools menu. The Association Type Editor
window displays.

:E: Association Type Editor x|
[DElEtE |
Association Type Marmespace | Connects I
Acocess (attribute) SMOMED CT Twwo Concepts ﬂ
Approach (sttribute) SMOMED CT Twvo Concepts
Attribute PM 10 Twwo Concepts
Eircacder Thar CCS [Clinical Classifications Sof... Two Concepts
Broader Than Omaha System Twwo Concepts
Eroacder Than DSk [Diagnostic and Statistic... Two Concepts
Broader Than ICD-10 Twwo Concepts
Eroader Than hMesH Twvo Concepts
Broader Than A0D [Alcohol and Other Drug T... Two Concepts LI

Name: |

ID: |
Code: |

Mamespace: |PM -0

Connects: ITWU Concepts

L Lef Ll

Purpose: IArb'rtrary

Inverse Name: |

Apply Cloze |

Information for each existing association type is listed in a table format, in
columns that you can resize. Information includes the association type name, the
namespace in which the association was created, and an indicator that references
if the association type is for a connection between Two Concepts, between a
concept and a synonym (Concept With Synonymous Term) or between Two
Terms.

To change the sort for the association type list, click the column header for the
characteristic (Association Type, Namespace, or Connects) on which you want
to base the sort.

2. In the association type table listing, click the association type you want to delete
to highlight the row. The lower portion of the window changes to reflect
information from that association type.
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3. Click Delete. A window similar to the following displays if associations with this
type exist in a local namespace.

Cannot delete Association Type because
® Associations of this Type
exist in the knowledgebase.

As long as associations of this type exist, you will not be permitted to delete the
association type. If no associations with this type exist, a delete confirmation
window similar to the following displays.

Confirm Delete

2 Are wou sure you wank ko delete the Association Type
‘“--r'i Synorwmous With {35, AZ )7

Click OK to delete the association type from the namespace in which it was
created; the association type is removed from the table on the Association Type
Editor window. Click Cancel to ignore the deletion.

4. Click Close to close the Association Type Editor window.

Association Qualifier Types

For each association you can specify (optionally) an established qualifier type and
value. For an association type, a qualifier provides additional detail regarding the nature
of a concept or term association (for example, the origin of an association, or the degree
of accuracy of a mapping between concepts, such as Usually). You can assign a qualifier
type and value to each association between concepts or terms. The following procedures
pertain to creating and maintaining qualifier types.

Create Association Qualifier Types

Follow this procedure to add one or more new association qualifier types to a local,
editable namespace.

1. Select Qualifier Types from the Tools menu. The Qualifier Type Editor window
displays.
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'S Qualifier Type Editor =

Delete |
Qualifier Type I Marmespace I Qualifies I
Crver flowy Order CPT Term Property ;I
Crverflove Order CCE [Clinical Clazsifications Sof... Term Property
Crverflove Order Cmaha System Tettn Propetty J
Crverflowy Order DEM-IY [Disgnostic and Statistic... Term Property
Crverflowy Order 1010 Term Property
Overflowy Order MesH Term Property
Crverflove Order SO0 [Alzohol and Other Drug T Term Property
Crverflove Order ICPC2P [International Clazsificati.. Term Property
Crverflowy Order MCI Thesaurus [Mational Cancer... Term Property
Crverflowy Order SPM [Standard Product Momencl... Termn Property
Orverflowy Order HL? Term Property
Crverflove Order COSTART [Coding Syibals for ... Term Property LI

Name: |

: |
Code: |

Namespace: |PM -10

L L

Qualifies: IConcept Azsocition

Apply | Close |

Information for existing qualifier types (for both associations and properties) is
listed in a table format in columns you can resize. Qualifier types from both
writable and non-writable namespaces are listed.

Table information includes the qualifier type name, the namespace in which the
qualifier was created, and an indicator that references the kind of association it
qualifies, either Concept Association or Term Association (the Concept
Property and Term Property values relate to qualifier types for concept and
term properties). To change the sort for the qualifier type list, click the column
header for the characteristic (Qualifier Type, Namespace, or Qualifies) on
which you want to base the sort.

Click New. The fields in the lower portion of the window are enabled.
Specify a name for the new association qualifier type in the Name field.

The qualifier type ID is generated automatically, and displayed in the 1D field.
You cannot modify the generated qualifier type ID.

The qualifier type code is generated automatically, and displayed in the Code
field. You cannot modify the generated qualifier type code.

From the Namespace field dropdown list, select the local namespace to which this
association qualifier type should be written. Since a qualifier type can be written
to editable namespaces only, only these namespaces are included in the list.
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7. The value you select in the Qualifies field dropdown list indicates the kind of
association this qualifier type will qualify. Select Concept Association for a
qualifier of an association between two concepts, or Term Association for a
qualifier of an association between two terms. (The Concept Property and
Term Property options relate to qualifier types for concept and term properties.)

8. Click Apply to update the selected local namespace with the new association
qualifier type; the new qualifier type is added to the table on the Qualifier Type
Editor window. The Qualifier Type Editor window remains displayed; click New
again to create additional association qualifier types in the local namespace.

9. Click Close to close the Qualifier Type Editor window.

View and Edit an Association Qualifier Type

Follow this procedure to view information for an existing association qualifier type, and
to perform any required edits.

1. Select Qualifier Types from the Tools menu. The Qualifier Type Editor window
displays.

:E: Qualifier Type Editor 1[
Delete |
Guialifier Type I Mamespace I Gualifies I
Overflowy Order CPT Term Property ;I
Crverflove Order CCS [Clinical Classifications Sof... Term Property
Crverflove Order Cmaha System Tettn Propetty J
Crverflowy Order DEM-IY [Disgnostic and Statistic... Term Property
Crverflowy Order 1010 Term Property
Crverflowy Order MesH Term Property
Crverflo Order A00 [Alzohol and Other Drug T Term Property
Crverflove Order ICPC2P [International Classificati... Term Property
Crverflowy Order MCI Thesaurus [Mational Cancer... Term Property
Crverflowy Order SPM [Standard Product Momencl... Termn Property
Crverflowy Order HL? Term Property
Overflowy Order COSTART [Coding Symbolz for ... Term Property LI

Name: |
: |
Code: |

Hamespace: |PM -0

L L

Qualifies: IConcept Azzocition

Apply | Close |

Information for existing qualifier types (for both associations and properties) is
listed in a table format in columns you can resize. Qualifier types from both
writable and non-writable namespaces are listed.

Table information includes the qualifier type name, the namespace in which the
qualifier was created, and an indicator that references the kind of association it
qualifies, either Concept Association or Term Association (the Concept
Property and Term Property options relate to qualifier types for concept and
term properties).
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To change the sort for the qualifier type list, click the column header for the
characteristic (Qualifier Type, Namespace, or Qualifies) on which you want to
base the sort.

. In the qualifier type table listing, click the association qualifier type you want to
view or modify to highlight the row. The data in the bottom portion of the
window changes to reflect information for that association qualifier.

If the association qualifier type was created in a local (writable) namespace, you
can modify the qualifier type Name, as needed. The Name is not editable if the
association qualifier type is from a subscription namespace.

The ID generated for the association qualifier type when it was created displays.
The field is not editable.

The Code generated for the association qualifier type when it was created
displays. The field is not editable.

The Namespace in which this association qualifier type was created displays. The
field is not editable.

The value in the Qualifies field indicates the kind of association this type qualifies
(the field is not editable, regardless of the namespace in which the qualifier type
was created). Concept Association represents a qualifier of an association
between two concepts; Term Association represents a qualifier of an association
between two terms. (The Concept Property and Term Property options relate
to qualifier types for concept and term properties; these options are addressed in
the Properties discussions.).

Click Apply (which becomes enabled if you make an edit) to update the selected
local namespace with the association qualifier type edits; the Qualifier Type
Editor window remains displayed if you want to view or edit other qualifier types.

To ignore the edits, click on any other association qualifier type listed in the table
to display information specific to that association type. When the confirmation
window similar to the following displays, click No to proceed without update of
the edits.

Select an Option |

@ Do you wank save changes to Qualfier Tyvpe First Calendar Quarker?

o | Cancell

Click Close to close the Qualifier Type Editor window.
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Delete an Association Qualifier Type

Follow this procedure to delete an existing association qualifier type from a local
namespace. The association qualifier type must have been created in a local (i.e.,
writable) namespace in order for you to delete it.

1. Select Qualifier Types from the Tools menu. The Qualifier Type Editor window

'S Qualifier Type Editor x|
Delete |
Qualifier Type I Iamespace I Qualifies I
Crverflowy Order CPT Term Property d
Crverflowy Order CCS [Clinical Classifications Sof... Term Property
Crverflowy Order Crnaha System Term Property J
Crverflo Order DSM-IY [Diagnostic and Statistic... Term Property
Crverflove Order ICD-10 Tettn Propetty
Crverflowy Order MesH Term Property
Crverflowy Order ACD [Alcohol and Other Drug T... Termn Property
Crverflowy Order ICPC2P [International Classificati... Term Property
Crverflo Order MCI Thesaurus [Mational Cancer... Term Property
Crverflove Order SPM [Standard Product Mormencl... Term Property
Crverflowy Order HL? Term Property
Crverflowy Order COSTART [Coding Symbals for .. Term Property ﬂ
Name: |
I0: |
Code: |
Namespace: [ii-10 =l
Qualifies: IConcept Azzociation d
Apply | Close |

Information for existing qualifier types (for both associations and properties) is
listed in a table format in columns you can resize. Qualifier types from both
writable and non-writable namespaces are listed.

Table information includes the qualifier type name, the namespace in which the
qualifier was created, and an indicator that references the kind of association it
qualifies, either Concept Association or Term Association (the Concept
Property and Term Property options relate to qualifier types for concept and
term properties).

To change the sort for the qualifier type list, click the column header for the
characteristic (Qualifier Type, Namespace, or Qualifies) on which you want to
base the sort.

2. Inthe qualifier type table listing, click the association qualifier type you want to
delete to highlight the row. The lower portion of the window changes to reflect
information from that association qualifier type.

3. Click Delete. If the association qualifier type you selected for deletion is from a
non-writable namespace, a message window displays indicating that you cannot
delete that type.
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& Zannok deleke Qualifier Tvpe,
The target Namespace must be "Writable',

Click OK, then select an association qualifier type from a writable namespace and
click Delete.

Note: If the qualifier type has been assigned to one or more associations in a local
namespace, a window displays indicating that you will not be permitted to delete
this qualifier type. Click OK to exit the delete process. If there are no
associations that have been assigned this qualifier type, a delete confirmation
window similar to the following displays.

Confirm Delete X|

@ Are ywou sure you want to delete the Qualifier Type
Qual3 Term assoc | 34555, 55555 )7

| cancel |

4. Click OK to delete the association qualifier type from the namespace; the
association qualifier type is removed from the table on the Qualifier Type Editor
window. Click Cancel to ignore the deletion.

Create Associations

Follow this procedure when you want to add one or more new associations between two
existing concepts or terms in a local namespace. You also can add an association
between concepts or terms in a subscription namespace, provided the desired association
type (and optional qualifier type) was created in the current local namespace.

1. Select Associations from the Tools menu, or click the Association Editor icon
on the DTS Editor Main window toolbar. The Association Editor window

displays.
S Association Editor BJ
From Concept / Term: | I
Child OF [ PM-10] v
To Concept / Term: b
-
Qualifier Value: 4
[ Add ] [ Remove ] [ Clear ]
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From another displayed panel or window (e.g., Concept Tree panel) drag the
from concept in the From/To association, then drop it into the From
Concept/Term field on the Association Editor window. The name of the
concept/term displays; the namespace in which it was created displays in brackets.

A new association is written to the local namespace where the association type
was created. From the Association Type field dropdown list, select the type of
association (e.g., Broader Than, Narrower Than) you are creating between the
concepts or terms. Only association types from the current local namespace are
listed, alphabetically. Refer to the Association Types discussions.

You have the option of filtering the association types that are available from the
Association Type field dropdown list by creating a pre-defined, filtered list of
types. When you attempt to select an association type from the Association Type
field dropdown list, or select an alternate association type, only the pre-selected
types display in the list. Refer to the Filter Association Types discussion.

From another displayed panel or window, drag the target concept/term in the
association in the To Concept/Term dropdown field. The name of the to
concept/term displays; the namespace in which it was created displays in brackets.

From Concept ! Term: IDrug Testing [U000741][ CPT] j
Association Type: | Child Of [ PM -10]

To Concept / Term: IPathoIogy and Laboratory Tests [U0O0739] [ CPT ] j

For each association you can add one or more qualifiers, each of which consists of
an established association qualifier type and value. Qualifiers provide additional
detail regarding the nature of a concept or term association (e.g., Usually).

From the Qualifier Type field dropdown list, select a qualifier type to assign to
this association. The list reflects association qualifier types that were created in
the same local namespace where the selected association type was created (refer
to the Association Qualifier Types discussions).

For the qualifier (type) you selected for this association, specify the association
qualifier value in the Qualifier Value field. For each association you can create
multiple qualifiers of different types, or create occurrences of the same qualifier
type, each with a separate value. Click Add after you specify the Qualifier Type
and Qualifier Value; both are added to the display area in the lower portion of the
window. Note the illustration.

Qualifier Type: | |Usually [ PM-10] -

Oualifier Value; Reviewed Annually v

[ Add ][ Remove ][ Clear ]

Usually [PM-10]: Reviewed Annually
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To remove an individual qualifier type/value combination from the association,
highlight the appropriate line in the display area and click Remove. To clear all
displayed association qualifier type/value combinations, click Clear.

As is the case for association types, you have the option of filtering the
association qualifier types that are available from the Qualifier Type field
dropdown list by creating a pre-defined, filtered list of types. When you attempt
to select a qualifier type from the Qualifier Type field dropdown list, or select an
alternate Qualifier type, only the pre-selected types will be included in the list.
Refer to the Filter Association Qualifier Types discussion later in this section.

7. Click Apply to add the new association. If you added this association for a
concept/term in a subscription namespace, then you later view the concept/term
(e.g., on the Concept/Term Details panel) the association will display in italics to
indicate that it was added as local content for the subscription namespace.

The Association Type Editor window remains displayed. You can click New
again and create additional associations in the local namespace.

8. Click Close to close the Association Editor window.

Filter Association Types

You can filter the list of association types that are available from the Association Type
dropdown field. Using the filtered list may simplify data entry if you are creating many
associations at one time.

1. Tofilter the association type list, click the Association Type field button on the
Association Editor window.

Association Type: | ass0oc concept wilnverse [ P -10]

The Filter Association Types window displays.

= Filter Association Types E]
Available Association Types: @ Eonespls O Terms
Association Type Mamespace
Child Of Fl-10 ~
Just-Like PH-10
Farent Of SHOMED CT EXTENSION
Related To Pl-10
Subset Mapping [38208] Triad Procedure Subset
Subset Mapping [38665] Triad Procedures Subset
localAssTypesd jonTest b
[ Add ] [ Remove ] [ Clear ]
Fittered Assaociation Types:
Associstion Type Mamespace
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In the table in the top portion of the window, association types from all local
namespaces for which the user has been granted edit permission are listed
alphabetically for Concept associations (the default) or Term associations (click
Terms at the top of the window). Refer to the Create User/Assign Namespace
Permissions discussion in the DTS Server Operations Guide for procedures on
assigning namespace edit permissions to a user.

Each association type name is listed, along with the namespace where the type
was created. To change the list sort, click the column header for the characteristic
(Association Type, Namespace) on which you want the sort based.

In the association type table in the upper portion of the window, click one of the
desired association types to highlight it for selection (you must select each
association type individually).

Click Add. The type you selected is added to the Filtered Association Types
area; the namespace where the association type was created also is listed.

'S Filter Association Types Y

Rvailable Association Types: (®) Concepts O Terms

Association Type Mamespace
Child OF PH-10 ~
Just-Like Ph-10
SMOMED CT EXTENSION

Related T PM-10

Subset Wapping [38208] Triad Procedure Subset

Subset Wapping [39665] Triad Procedures Subset
localAssType2 JonTest b

[ Add ][ Remove ]l Clear ]

Filtered Association Types:

Association Type Marmespace
Child OF Pi-10
Related To Pi-10
Parent Of SHOMED CT EXTENSION

OK Cancel

To remove an individual association type from the filtered list, highlight the
appropriate line in the Filtered Association Types area and click Remove. To
clear all displayed association types from the filtered list, click Clear.

When you are satisfied with your filtered list selections, click OK. Those filtered
association types, that also are in the current local namespace, will be the only
ones listed in the Association Type field dropdown list on the Association Editor
window. If the filtered list includes no association types from the current local
namespace, then no types are listed in the Association Type field dropdown list.

Based on the selections in the previous illustration, the association types Child Of
and Related To would be listed in the Association Type field dropdown list (the
filtered association types are in the current local namespace).
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Association Type: | |chig of [Pm 107 L||

To Concept ! Term:

Related To [Pt -10]

To select a new set of filtered association types for the list, click the Association
Type field button again and select from the Filter Association Types window.

Filter Association Qualifier Types

You can filter the list of association qualifier types that are available from the Qualifier
Type dropdown field. Using the filtered list may simplify data entry if you are entering
many qualifiers at one time.

1. To filter the association qualifier type list, click the Qualifier Type field button on
the Association Editor window.

Qualifier Type: Usually [ PM-10 ]

The Filter Qualifier Types window displays.

'S Filter Qualifier, Types @
Available Qualifier Types: & Eancepts O Terms
Qualifier Type Mamespace
Pending Approval SHNOMED CT EXTENSION
FPending Review PM-10
Usually PM-10
test jonTest
Add ] [ Remove ] [ Clear ]
Fittered Qualifier Types:
Qualifier Type Mamespace

In the table in the top portion of the window, association qualifier types from all
local namespaces for which the user has been assigned edit permission are listed
alphabetically for Concepts (the default) or Terms (click Terms at the top of the
window). Refer to the Create User/Assign Namespace Permissions discussion in
the DTS Server Operations Guide for procedures on assigning namespace edit
permissions to a user.

Each association qualifier type name is listed, as well as the namespace where the
type was created. To change the list sort, click the column header for the
characteristic (Qualifier Type, Namespace) on which you want the sort based.
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2. Inthe qualifier type table in the upper portion of the window, click one of the
desired association qualifier types to highlight it for selection (you must select
each type individually).

3. Click Add. The association qualifier type you selected is added to the Filtered
Qualifier Types area in the lower portion of the window; the namespace where
the qualifier type was created also is listed.

S Filter Qualifier Types E
Available Qualifier Types: (&) Concepts O Terms
Qualifier Type Mamespace
Fending Review Phl-10
Usually Fh-10
Pending Approval SMOMED CT EXTENSION
test jonTest
add ] [ Remove ] [ Clear ]
Filtered Qualifier Types:
Qualifier Type Namespace
Pending Review Pu-10
Fending Approval SMOMED CT EXTENSION
Lsually Phl-10

4. Toremove an individual association qualifier type from the filtered list, highlight
the appropriate line in the Filtered Qualifier Types area and click Remove. To
clear all displayed qualifier types from the filtered list, click Clear.

5. When you are satisfied with the selections in the filtered list, click OK.

Those filtered association qualifier types that are in the current local namespace,
and that also match the Association Type local namespace, will be the only ones
listed in the Qualifier Type field dropdown list on the Association Editor
window. If the filtered list includes no association qualifier types from the current
local namespace that also match the Association Type local namespace, then no
types are listed in the Association Type field dropdown list.

Based on the selections in the previous illustration, the types Pending Review
and Usually would be listed in the Qualifier Type field dropdown list (the
Association Type and these filtered types are in the current local namespace).

Qualifier Type: | |Fending Review [ PM-10] I

] Pending Review [ PM-10]
Qualifier Value: |\o, )., [ pM-10 |

To select a new set of filtered qualifier types for the list, click the Qualifier Type
field button again and make your selections on the Filter Qualifier Types window.
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Synonym Maintenance

Any concept, in any namespace, can have one or more synonymous terms. In DTS, a
term is an occurrence of a character string in a namespace (i.e., terminology). However,
an identical string can have different meanings within, or across, namespaces.

For example, Cold can indicate a temperature reference, and cold can indicate an
infection. If you wanted to establish a relationship between the concept Respiratory
Infection and the term cold (the illness) you could establish cold as a synonym of
Respiratory Infection.

This section includes procedures for creating and maintaining associations between
concepts and synonymous terms. A synonym always pairs a concept with a synonymous
term (never a concept with a concept, or a term with a term).

You must assign an established association type (e.g., Assoc. Concept w/Synon. Term)
to each synonymous association between concepts and terms. You can create
associations between concepts and terms that reside in the same namespace, or across
namespaces.

Create Synonyms

Follow this procedure when you want to create a relationship (i.e., an association)
between a concept and one or more synonymous terms. You can create the relationship
between the concept and the synonymous term if the concept is in a subscription
namespace, provided the desired association type, and optional qualifier type, were
created in the current local namespace.

1. Select Synonyms from the Tools menu. The Synonym Editor window displays.

= Synonym Editor x|

Concept: |

Synomym Type: | Swnonymous With [ PM-10 ]

Term: |

" Is Preferred Create Mew Term ...

cse |

2. From another displayed panel or window (e.g., Concept Tree panel) drag the
concept/term for which you are establishing a synonym, then drop it into Concept
field on the Synonym Editor window. The name of the concept/term displays; the
namespace in which it was created displays in brackets.

3. A new (synonymous) association between the concept and the term you select
will be written to the local namespace where the association type was created.
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From the Synonym Type field dropdown list, select the type of association (e.g.,
Concept to Term Assoc) you are creating between the concept and the term you
intend to select.

Note that this alphabetized list includes only association types that represent a
connection between a concept and a synonymous term, created in the current
local namespace (which displays in brackets). Refer to the Association Types
discussions.

You have the option of filtering the association types that are available from the
Synonym Type field dropdown list by creating a pre-defined, filtered list of types.
When you attempt to select an association type from the Synonym Type field
dropdown list, or select an alternate association type, only the pre-selected
association types will be included in the list. Refer to the Filter Association Types
discussion earlier in the guide for instructions on creating a filtered list of
associations types between concepts and synonymous terms.

From one of the other display windows or panels, drag the term you want to
establish as a synonym, and drop it into the Term field on the Synonym Editor
window. The term displays, with the namespace in which it was created
displayed in brackets.

"= Synonym Editor x|

Concept: |P.cquired ichthyosis {disorder) [ SNOMED CT ]

Synonym Type: | ICDncept to Term [ SNOMED CT EXTENSION ] =]

Term: |Acquired ichthwosis [ SMOMED CT EXTENSION ]

" Is Preferred Create Mew Term ... |
Applhy Close |

If you would rather create a new term to establish as a synonym, click Create
New Term. The Create New Term window displays.

Create New Term 5'

Name: |

LT TN Sy onyrmous Disorder

« & MNew Term
Ok | Cancel |

Specify the Name of the new synonymous term. From the Namespace field
dropdown list, select the local, editable namespace in which it will reside (local
namespaces are listed alphabetically).
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If the concept for which you are creating a synonymous term is from a
subscription namespace, you should create the synonymous term in the current
local namespace. The synonym you are adding is a New Term (the only option).
Click OK.

5. In the event multiple synonyms exist for a specific concept, you can designate that
one of the synonyms Is Preferred. Click the Is Preferred field checkbox on the
Synonym Editor window to designate this synonym as the preferred synonym.

6. Click Apply to add the synonym to the (editable) namespace.

7. Click Close to close the Synonym Editor window.
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Property Maintenance

A property is a piece of user-defined information that can be linked to a concept or term,
and can be used for any purpose. For example, a property can be a textual definition for a
concept, or can identify the source terminology where a term originated.

A property type (i.e., definition) is assigned to each property to define the nature of the
property. One or more qualifier types and values can be assigned to each property as
well. Procedures for creating properties, property types, and property qualifier types are
included in the following discussions.

Property Types

Create Property Types

Follow this procedure to add a new property type to a local namespace. You then can
assign the property type to a concept in any local namespace, or add the property type (as
local content) for a concept in a subscription namespace.

1. Select Property Types from the Tools menu. The Property Type Editor window

displays.
[rooperty troegtor B
Delete |
Property Type | Mamespace I Aftaches To I
Allowe Non-human Flag UMLS Semartic Types Concept ﬂ
Code in Source CPT Concept
Code in Source ICD-3-Ch Concegpt
Code in Source SMNOMED CT Concept
Code in Source CCS [Clinical Classifications Sof... Term
Code in Source Omaha System Term
Code in Source DSh-Y [Disgnostic and Statistic... Term
Code in Source ICD-10 Term
Code in Source MesH Term LI

Name: |
ID: |
Code: |

Mamespace: |PM -0

Walue Size: I\ndaxable

Attaches To: ICDncept

Ll Lof Lef L]

Word Searchable: o Seaichiablz

Al | Close |

Information for each existing property type is listed in a table format, in columns
you can resize. Information includes the property type name, the namespace in
which the property type was created, and an indicator that references if the
property type is for a property assigned to a Concept or a Term.

To change the sort for the property type list, click the column header for the
characteristic (Property Type, Namespace, or Attaches To) on which you want
to base the sort.
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10.

11.

Click New. The information displayed in the lower portion of the window for the
existing property type is cleared.

In the Name field, specify the name for the new property type.

The property type ID is generated automatically, and displayed in the 1D field.
You cannot modify the generated property type ID.

The property type code is generated automatically, and displayed in the Code
field. You cannot modify the generated property type code.

From the Namespace field dropdown list, select the local namespace in which this
property type will be created. The list includes only local, writable namespaces.

From the Attaches To field dropdown list, indicate if the property type is for
properties that you will assign to a Concept or a Term.

The Value Size refers to the maximum length of a property value that can be
assigned to this property type. For a property type that attaches to a concept,
select (from the field dropdown list) from the options Indexable, Searchable, and
Big.

Indexable properties are up to 749 characters in length, and provide for the fastest
access; property types that attach to terms have a value size of Indexable.
Searchable properties are up to 4000 characters.

A Value Size of Big designates a property type value character string of more than
4000 characters. A Big property is not searchable.

For a property type that attaches to a concept, select (from the Word Searchable
field dropdown list) from the options Word Searchable and Not Word
Searchable.

Designating a property type as word searchable is the first step in enabling a word
match search on concept properties of this type. Property types that attach to
terms have a value of Not Word Searchable.

After concept properties of this type have been created, the Knowledgebase
Administrator must run the KB Admin utility. Refer to the Configure Word
Match Search discussion in the Knowledgebase Administrators Guide.

Click Apply to update the selected local namespace with the new property type;
the new property type is added to the table on the Property Type Editor window.
The Property Type Editor window remains displayed; you can click New again
and create additional property types in a local namespace.

When you finish creating property types, click Close to close the Property Type
Editor window.

© 1999-2009 Apelon, Inc. All Rights Reserved.
Page 95 of 147



View and Edit a Property Type

Follow this procedure to view information for an existing property type in any
namespace, and edit the information if it was created in a local, writable namespace.

1. Click Property Types on the DTS Editor Main window’s Tools menu. The
Property Type Editor window displays.

| :E: Property Type Editor ﬂ
Delete |
Property Type | Mamespace | Attaches To |
Aoy Mon-human Flag UMLS Semartic Types Concept ﬂ
Code in Source CPT Concept
Code in Source 1C0-9-Chd Concept
Code in Source SMOMED CT Concept
Code in Source CCS [Clinical Classifications Sof... Term
Code in Source Omaha System Term
Code in Source DEM-IY [Disgnostic and Statistic... Term
Code in Source ICD-10 Term
Code in Source MeSH Term LI
Name: |
I |
Code: |
Namespace: |PM -10 LI
Value Size: Ilndexable LI
Attaches To: |Concept LI
Word Searchable: [vord Searchable =l
Al | Close |

Information for each existing property type is listed in a table format, in columns
you can resize. Information includes the property type name, the namespace in
which the property type was created, and an indicator that references if the
property type is for a property assigned to a Concept or a Term.

To change the sort for the property type list, click the column header for the
characteristic (Property Type, Namespace, or Attaches To) on which you want
to base the sort.

2. Click the property type you want to view or modify to highlight the row. The
lower portion of the window changes to reflect information from that type.
If the property type you selected was created in a subscription namespace, none of
the fields are editable. If the property type was created in a local, writable
namespace, the editable fields are enabled.

3. Inthe Name field, modify the property type name, as necessary.
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10.

11.

The ID code generated for the property type when it was created displays. The ID
is not editable, regardless of the namespace in which the property type was
created.

The Code generated for the property type when it was created displays; the code
is not editable, regardless of the namespace in which the type was created.

The Namespace in which the property type was created is not editable, for any
type of namespace.

The Attaches To value indicates if the property type is for properties that you will
assign to a Concept, or a Term. The field is not editable if the property type is in
use currently for a concept or a term.

The Value Size refers to the maximum length of a property value that can be
assigned to this property type (Indexable, Searchable, and Big). The field is not
editable if the property type is in use currently for a concept or a term.

In the Word Searchable field dropdown list, the options are Word Searchable
and Not Word Searchable. The field is not editable, regardless of the namespace
in which the property type was created.

Click Apply (which becomes enabled if you make an edit) to update the
namespace with the edits. The Property Type Editor window remains displayed
for additional edits and/or additions.

To ignore the edits, click on any other property type listed in the table to display
information specific to that property type. When the confirmation window similar
to the following displays, click No to proceed without update of the edits.

Select an Option x|

@ Do 'you want save changes ko Property Tyvpe PM Prop index term nws?

Mo | Cancell

Click Close to close the Property Type Editor window.
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Delete a Property Type
Follow this procedure to delete an existing property type from a local namespace.

1. Click Property Types on the DTS Editor Main window’s Tools menu. The
Property Type Editor window displays.

=l
Property Type | Namespace | Attaches To |
i Man-human Flag UMLS Semantic Types Corcept ‘I
Code in Source cPT Concept
Code in Source 1CD-9-C Concert
Code in Source SHOMED CT Concept
Code in Source CCS [Clivical Classifications Sof... Term
Code in Source Omaha System Term
Code in Source DSMIY [Diagnostic and Statistic... Term
Code in Source 1=D-10 Term
Code in Source MesH Term -1
Name: |
D: |
Code: |
Namespace: [P 10 i |
value Size: [noe<ani= i |
Attaches To: [Concent =1
Word Searchable: [vord Searchabls =
T =

Information for each existing property type is listed in a table format, in columns
you can resize. Information includes the property type name, the namespace in
which the property type was created, and an indicator that references if the
property type is for a property assigned to a Concept or a Term.

To change the sort for the property type list, click the column header for the
characteristic (Property Type, Namespace, or Attaches To) on which you want
to base the sort.

2. Click the property type you want to delete to highlight the row. The lower portion
of the window changes to reflect information from that property type.

3. Click Delete. A window similar to the following displays if properties with this
type are in use for concepts in a local namespace.

Warning

Cannot delete Property Type because
. Properties of this Type
exist in the Knowledgebase,

As long as concepts with this property type exist, you will not be permitted to
delete the property type. If no concepts have properties with this type, a delete
confirmation window similar to the following displays.
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Confirm Delete x|

@ Are wou sure you wank to delete the Property Type
PM Prop index kerm rws 555, 5555 )7

Cancel |

4. Click OK to delete the property type from the namespace; the property type is
removed from the table on the Property Type Editor window. Click Cancel to
ignore the deletion.

Property Qualifier Types

For each property you can specify an established qualifier type and value. These
provide additional detail regarding the nature of a concept or term property (e.g., a
property effective date, or an indicator reflecting that the property is Current).

You can assign a type and value to each concept or term property qualifier. The
following procedures pertain to creating and maintaining property qualifier types.

Create Property Qualifier Types
Follow this procedure to add new property qualifier types to a local namespace.

1. Select Qualifier Types from the Tools menu. The Qualifier Type Editor window
displays.

'S Qualifier Type Editor x|
Delete |
Guialifier Type Mamespace I Gualifies I
Crverflove Order CPT Tettn Propetty ;I
Crverflove Order CCE [Clinical Clazsifications Sof... Term Property
Crverflove Order Cmaha System Tettn Propetty J
Crverflove Order DEM-IY [Diagnostic and Statistic... Term Property
Crverflove Order ICo-10 Tettn Propetty
Crverflove Order MesH Tettn Propetty
Crverflove Order SO0 [Alzohol and Other Drug T Term Property
Crverflove Order ICPC2P [International Classificati.. Term Property
Crverflove Order MCI Thesaurus [Mational Cancer... Term Property
Crverflove Order SPM [Standard Product Mormencl... Term Property
Crverflove Order HL? Tettn Propetty
Crverflo Order COSTART [Coding Symbals for ... Term Property LI
Naime: |

: |
Code: |

Namespace: [ii-10

Ll L

Qualifies: IConcept Azzociztion

Apply | Close |

Information for existing qualifier types (for both associations and properties) is
listed in a table format in columns you can resize. Qualifier types from both
writable and non-writable namespaces are listed.
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Table information includes the qualifier type name, the namespace in which the
qualifier was created, and an indicator that references if the type qualifies
properties for concepts or terms (Concept Property, Term Property). The
Concept Association and Term Association values refer to qualifiers you
establish for associations within, or across, namespaces.

To change the sort for the qualifier type list, click the column header for the
characteristic (Qualifier Type, Namespace, or Qualifies) on which you want to
base the sort.

. Click New. The information displayed in the lower portion of the window for the
existing qualifier type is cleared.

. Specify a name for the new property qualifier type in the Name field.

. The qualifier type ID is generated automatically, and displayed in the ID field.
You cannot modify the generated qualifier type ID.

. The qualifier type code is generated automatically, and displayed in the Code
field. You cannot modify the generated qualifier type code.

From the Namespace field dropdown list, select the local namespace to which this
property qualifier type should be written. Since a qualifier type can be written to
local, editable namespaces only, only these namespaces are included in the list.

. The value you select in the Qualifies field dropdown list indicates if this qualifier
type will qualify properties for concepts or terms. Select Concept Property or
Term Property, as appropriate (Concept Association and Term Association
refer to qualifiers you establish for associations within, or across, namespaces).

. Click Apply to update the selected local namespace with the new property
qualifier type; the new qualifier type is added to the table on the Qualifier Type
Editor window. The Qualifier Type Editor window remains displayed; you can
click New again and create additional property qualifier types in the local
namespace.

. Click Close to close the Qualifier Type Editor window.

© 1999-2009 Apelon, Inc. All Rights Reserved.
Page 100 of 147



View and Edit a Property Qualifier Type

Follow this procedure to view information for an existing property qualifier type, and to
perform any required edits.

1. Select Qualifier Types from the Tools menu. The Qualifier Type Editor window
displays.

:E: Qualifier Type Editor x|

Delete |
Guialifier Type Mamespace I Gualifies I
Crverflowy Order CPT Term Property d
Crverflove Order CCS [Clinical Clazsifications Sof... Term Property
Crverflove Order Cmaha System Tettn Propetty J
Crverflove Order DSM-IY [Diagnostic and Statistic... Term Property
Crverflove Order ICD-10 Tettn Propetty
Crverflove Order MeSH Tettn Propetty
Crverflove Order A0D [Alcohol and Other Drug T Term Property
Crverflove Order ICPC2P [International Clazsificati. .. Term Property
Crverflove Order MCI Thesaurus [Mational Cancer... Term Property
Crverflove Order SPM [Standard Product Mormencl... Term Property
Crverflove Order HL? Tettn Propetty
Crverflove Order COSTART [Coding Syimbals for ... Term Property LI

Naime: |

: |
Code: |

Namespace: [ii-10

Ll L

Qualifies: IConcept Azzociztion

Apply | Close |

Information for existing qualifier types (for both associations and properties) is
listed in a table format in columns you can resize. Qualifier types from both
writable and non-writable namespaces are listed.

Table information includes the qualifier type name, the namespace in which the
qualifier was created, and an indicator that references if the type qualifies
properties for concepts or terms (Concept Property, Term Property); the
Concept Association and Term Association values refer to qualifiers you
establish for associations within, or across, namespaces.

To change the sort for the qualifier type list, click the column header for the
characteristic (Qualifier Type, Namespace, or Qualifies) on which you want to
base the sort.

2. Inthe qualifier type table listing, click the property qualifier type you want to
view or modify to highlight the row. The data in the bottom portion of the
window changes to reflect information for that property qualifier.

If the property qualifier type was created in a local (writable) namespace, you can
modify the qualifier type Name, as needed. The Name is not editable if the
property qualifier type is from a subscription namespace.
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. The ID generated for the property qualifier type when it was created displays.
The field is not editable, regardless of the namespace in which the qualifier type
was created.

. The Code generated for the property qualifier type when it was created displays.
The field is not editable, regardless of the namespace in which the qualifier type
was created.

. The Namespace in which this property qualifier type was created displays. The
field is not editable.

. The value in the Qualifies field dropdown list indicates if this qualifier type
qualifies properties for concepts or terms (Concept Property or Term
Property). The field is not editable, regardless of the namespace in which the
qualifier type was created.

. Click Apply (which becomes enabled if you make an edit) to update the selected
local namespace with the property qualifier type edits. The Qualifier Type Editor
window remains displayed if you want to view or edit other qualifier types.

To ignore the edits, click on any other property qualifier type listed in the table to
display information specific to that property qualifier type. When the
confirmation window similar to the following displays, click No to proceed
without update of the edits.

Select an Option x|

@ Do you want save changes ko Qualfier Type First Calendar Quarter?

Mo | Cancell

. Click Close to close the Property Type Editor window.
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Delete a Property Qualifier Type

Follow this procedure to delete an existing qualifier type from a local namespace. The
qualifier type must have been created in a local, writable namespace in order for you to
delete it.

1. Select Qualifier Types from the Tools menu. The Qualifier Type Editor window

'S Qualifier Type Editor x|
“l  eete |
Qualifier Type I Mamespace I Quglifies I
Overflowe Order CPT Tertn Property ;I
vt flowe Order CCS [Clinical Classifications Sof... Ter Propery
Dverflow Order Omaha System Term Property J
Overflowe Order DEM-IY [Diaghostic and Statistic.. Term Property
vt flowe Order 1C0-10 Tertn Property
vt flowe Order MeSH Tertn Property
Dverflow Order A0D [Alcohol and Cther Drug T... Term Property
Overflowe Order ICPC2P [International Classificati... Term Property
vt flowe Order MCI Thesaurus [Mational Cancer... Tertn Propery
Dverflowe Crder SPM [Standard Product Momencl... Term Property
Overflowe Order HL? Term Property
Overflowe Order COSTART [Codihg Symbols for ... Term Property ;I
Name: |
ID: |
Code: |
Hamespace: |PM -0 LI
Qualifies: ICDnCep‘t Association LI
Al | Close

Information for existing qualifier types (for both associations and properties) is
listed in a table format in columns you can resize. Qualifier types from both
writable and non-writable namespaces are listed.

Table information includes the qualifier type name, the namespace in which the
qualifier was created, and an indicator that references if the type qualifies
properties for concepts or terms (Concept Property, Term Property); the
Concept Association and Term Association values refer to qualifiers you
establish for associations within, or across, namespaces. To change the sort for
the qualifier type list, click the column header for the characteristic (Qualifier
Type, Namespace, or Qualifies) on which you want to base the sort.

2. Inthe qualifier type table listing, click the property qualifier type you want to
delete to highlight the row. The lower portion of the window changes to reflect
information from that property qualifier type.

3. Click Delete. If the property qualifier type you selected for deletion is from a
non-writable namespace, a message window displays indicating that you cannot
delete that type.
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& Cannot delete Qualifier Type.
The target Mamespace musk be "writable',

Click OK, then select a property qualifier type from a writable namespace and
click Delete. Note: If the qualifier type has been assigned to one or more
properties in a local namespace, a window displays indicating that you will not be
permitted to delete this qualifier type. Click OK to exit the delete process.

If there are no properties that have been assigned this qualifier type, a delete
confirmation window similar to the following displays.

Confirm Delete x|

@ Are you sure you want to delete the Qualifier Type
qualz pm 10 Prop ¢ 23434, erd )7

| cancel |

4. Click OK to delete the property qualifier type from the namespace; the property
qualifier type is removed from the table on the Qualifier Type Editor window.
Click Cancel to ignore the deletion.

Assign Properties to a Concept

Follow this procedure when you want to add one or more established properties to an
existing concept or term in a local namespace. You also can add a property to a
concept/term in a subscription namespace, provided the desired property type (and
optional qualifier type) exists in the current local namespace.

1. Select Properties from the Tools menu, or click the Property Editor icon on the
DTS Editor Main window toolbar. The Property Editor window displays.

S Property Editor g
Concept / Term: | I
Property Type: | |Coded [ SMOMED CT EXTEMSICN ] v
Property Value:

Qualifier Type: | | Requires Yerification [ SMOMED CT EXTEMSICN ] w
Qualifier Value: 4
[ Add ] [ Remove ] [ Clear ]
Apply Close
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2. From another displayed panel or window (e.g., Concept Tree panel) drag the
concept/term for which you want to create a property and drop it into the
Concept/Term field. The name of the concept/term displays, and the namespace
in which it exists displays in brackets.

3. A property type is the pre-established identifier that defines the property. From
the Property Type field dropdown list, select a property definition to be assigned
to the concept or term. If the concept/term in the Concept/Term field is from a
subscription namespace, the Property Type dropdown list includes only property
types created in the current local namespace, listed alphabetically.

If the Concept/Term was created in a local namespace, the Property Type list
includes property types created in the current local namespace, but only if the
Concept/Term also was created in the current local namespace. If the
concept/term was not created in the current local namespace, the Property Type
field dropdown list will be empty. Refer to the Property Types discussions.

You have the option of filtering the property types that are available from the
Property Type field dropdown list by creating a pre-defined, filtered list of types.
When you attempt to select a property type from the Property Type field
dropdown list, or select an alternate property type, only the pre-selected types will
be included in the list. Refer to the Filter Property Types discussion.

4. For the property definition (type) assigned to this concept/term, enter the property
value in the Property Value text area. This area accommodates the entry of large
amounts of text, as well as formatted text (e.g., paragraphs, bulleted items, etc.).
A single concept/term can have multiple occurrences of the same property type,
each with a separate, unique value.

= Property Editor E
Concept / Term: |[EfS ecial preparation {procedure) [ SMOMED CT R

Property Type: | | Coded [ SNOMED CT EXTENSION ]

Property Value:

Requires Yerification [ SNOMED CT EXTENSION ] v
Qualifier Value: 4
[ Add ] [ Remove ] [ Clear ]

5. For each property you may specify an established property qualifier type and
value to provide details regarding the nature of a concept or term property (e.g.,
Current). From the Qualifier Type field dropdown list, select the qualifier to
assign to this property.
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The list includes only those property qualifier types that were created in the same
local namespace where the selected Property Type was created (refer to the
Property Qualifier Types discussion earlier in the guide). For the property
qualifier (type) you selected for this concept or term, specify the qualifier value in
the Qualifier Value field. For each property you can create multiple occurrences
of the same qualifier type, each with a separate, unique value.

Click Add after you specify the property Qualifier Type and Qualifier Value; both
are added to the display area in the lower portion of the window. Note the
illustration.

Qualifier Type: | | Testing [ SMOMED CT EXTEMSION ] A4

Qualifier Value; Review Passed 3

[ add ][ Remove ][ Clear ]

Testing [ SNOMED CT EXTENSION |: Review Passed

To remove an individual qualifier type/value combination from the property,
highlight the appropriate line in the display area and click Remove. To clear all
displayed qualifier type/value combinations, click Clear.

You have the option of filtering the property qualifier types that are available
from the Qualifier Type field dropdown list by creating a pre-defined, filtered list
of types. When you attempt to select a property qualifier type from the Qualifier
Type field dropdown list, or select an alternate Qualifier type, only the pre-
selected types will be included in the list. Refer to the Filter Property Qualifier
Types discussion later in this section.

6. Click Apply to add the new property to the current local namespace. If you added
this property to a concept in a subscription namespace, then you later view the
concept/term (e.g., on the Concept/Term Details panel) the property will display
in italics to indicate it was added as local content for the subscription namespace.

Filter Property Types
You can filter the list of property types that are available from the Property Type

dropdown field. Using the filtered list may simplify data entry if you are assigning many
properties to concepts at one time.

1. Tofilter the property type list, click the Property Type field button on the
Property Editor window.

1
| Property Type: | |Current Stakus [ SNOMED CT EXTENSION ] ;II

The Filter Property Types window displays.
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'S Filter Property Types x|
Available Property Types: & Conceptd " Terms
Property Type I Mamespace |
Approval Status SHOMED CT EXTEMSION -
Approval Status Fhi-10
Coded SMOMED CT EXTENSION
Current Status SMOMED CT EXTENSION
DC Fhi-10
DC SHOMED CT EXTEMSION
Documented SMOMED CT EXTENSION Jhd|
Add | Remove I Clear

Filtered Property Types:

Property Type | MNamespace

carcel

In the table in the top portion of the window, property types from all local
namespaces for which the user has been granted edit permission are listed
alphabetically. Refer to the Create User/Assign Namespace Permissions
discussion in the DTS Server Operations Guide for procedures on assigning
namespace edit permissions to a user.

Each property type name is listed, as well as the namespace where the property
type was created. To change the list sort, click the column header for the
characteristic (Property Type, Namespace) on which you want the sort based.

In the property type table in the upper portion of the window, click one of the
desired property types to highlight it for selection (you must select each property
type individually).

Click Add. The property type you selected is added to the Filtered Property
Types area in the lower portion of the window. The namespace in which each
selected property type was created is listed as well.

s Filter, Property Types @
Available Property Types: Eoncepts O Terms
Property Type Namespace
Appraval Status SHOMED CT EXTENSION ~
Approval Status PM-10
Caoded SNOMED CT EXTEMEION
Current Status SNOMED CT EXTEMEION
[aleg FM-10
[aleg SNOMED CT EXTEMEION
Crocumented SNOMED CT EXTEMEION b
[ Add ] [ Remove ] [ Clear ]
Filtered Property Types:
Property Type Mamespace
Approval Status SHNOMED CT EXTENSION
Current Status SNOMED CT EXTENSION
[ale] Phi-10
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4. To remove a type from the filtered list, highlight the appropriate line in the
Filtered Property Types area and click Remove. To clear all types, click Clear.
The filtered list may include property types from more than one local namespace.

5. When you are satisfied with your filtered list selections, click OK.

6. If the Concept/Term on the Property Editor window was created in a subscription
namespace, those filtered property types that also are in the current local
namespace will be the only ones listed in the Property Type field dropdown list.

If the Concept/Term on the Property Editor window was created in a local
namespace, the property type list includes property types created in the current
local namespace, but only if the Concept/Term on the Property Editor window
also was created in the current local namespace. If the concept/term was not
created in the current local namespace, the Property Type field dropdown list will
be empty. Refer to the Property Types discussions.

Based on the selections in the previous illustration, the property types Approval
Status and Current Status would be listed in the Property Type field dropdown
list on the Property Editor window (the filtered property types are in the current
local namespace, which matches the local namespace where the Concept/Term
was created).

Concept ! Term: | Attribute {attribute) [ SNOMED CT ] w

Property Type: | | Approval Skatus [ SNOMED CT EXTEMSION ] W
Approval Status [ SMOMED CT EXTEMSION

Property Value: Aol ]

Current Skatus [ SMOMED CT EXTEMSION ]

To select a new set of filtered property types for the list, click the Property Types
field button again and make your selections on the Filter Property Types window.

Filter Property Qualifier Types

You can filter the list of property qualifier types that are available from the Qualifier
Type dropdown field. Using the filtered list may simplify data entry if you are entering
many property qualifiers at one time.

1. Tofilter the property qualifier type list, click the Qualifier Type field button on
the Property Editor window.

| Qualifier Type: | | Requires Yerification [ SMOMED CT EXTEMSION ] |

The Filter Qualifier Types window displays.
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S Filter Qualifier Types K

Available Qualifier Types: @ Concepts O Terms
Qualifier Type Mamespace
Concept Review Completed Ph-10 A
Concept Review Needed SNOMED CT EXTENSION
Concept Review Pending SMOMED CT EXTENSION
Concept Review Performed SMOMED CT EXTENSION
Docurmented PHW-10
Requires Verification SNOMED CT EXTENSION
Testing SMNOMED CT EXTEMSION b
add ] [ Remove ] [ Clear ]
Filtered Qualifier Types:
Qualifier Type Mamespace

In the table in the top portion of the window, property qualifier types from all
local namespaces for which the user has been granted edit permission are listed
alphabetically. Refer to the Create User/Assign Namespace Permissions
discussion in the DTS Server Operations Guide for procedures on assigning
namespace edit permissions to a user.

Each qualifier type name is listed, as well as the namespace where the qualifier
type was created. To change the list sort, click the column header for the
characteristic (Qualifier Type, Namespace) on which you want the sort based.

In the qualifier type table in the upper portion of the window, click one of the
desired property qualifier types to highlight it for selection (you must select each
type individually).

Click Add. The property qualifier type you selected is added to the Filtered
Qualifier Types area in the lower portion of the window; the namespace for each
selected qualifier is listed as well.

'S Filter Qualifier Types E
Available Qualifier Types: (& Foncepis O Terms
Qualifier Type Mamespace
Concept Review Completed PM-10 -

Concept Review Meeded
Concept Review Pending
Concept Review Performed
Documented

Reguires Verification

SMNOMED CT EXTENSION
SMNOMED CT EXTENSION
SMNOMED CT EXTENSION
Ph-10

SMNOMED CT EXTENSION

Concept Review Needed
Concept Review Pending
Concept Review Performed

Testing SMOMED CT EXTENSION
Add ] [ Remove ] [ Clear ]
Filtered Qualifier Types:
Qualifier Type Mamespace
Concept Review Completed Fhd-10

SNOMED CT EXTENSION
SNOMED CT EXTENSION
SNOMED CT EXTENSION
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4. Toremove an individual property qualifier type from the filtered list, highlight the
appropriate line in the display area and click Remove. To clear all displayed
qualifier types from the filtered list, click Clear.

5. When you are satisfied with the selections in the filtered list, click OK.

Those filtered property qualifier types that also are in the current local
namespace, and that also match the Property Type local namespace, will be the
only ones listed in the Qualifier Type field dropdown list on the Property Editor
window. If the filtered list includes no property qualifier types from the current
local namespace that also match the Property Type local namespace, then no
types are listed in the Property Type field dropdown list.

Based on the selections in the previous illustration, the qualifier types Concept
Review Needed, Concept Review Pending, and Concept Review Performed
would be listed in the Qualifier Type field list on the Property Editor window (the
filtered qualifier types are in the current local namespace, which matches the local
namespace of the Property Type).

Qualifier Type: | |Concept Review Needed [ SMOMED CT EXTEMSION ] v
Concepk Revie

ot Review Needed [ SMOMED CT EXTEMSICN ]

nding [ SHOMED CT EXTENSION ]
(Concept Review Performed [ SNOMED T EXTENSION ]

To select a new set of filtered property qualifier types, click the Qualifier Type
field button again and make your selections on the Filter Qualifier Types window.
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Concept Maintenance

The discussions in this section relate to viewing details of existing concepts or terms, and
the creation of a new concept or term in a local namespace.

View Concept/Term Details

The Concept/Term Details panel displays as the default in the right pane of the DTS
Editor Main window when it first opens. For an Ontylog namespace you want to view,
you can display detailed attribute information for each concept or term that you drag from
any other display window or panel on the Main window. For a Thesaurus namespace,
you can view details for any association that you drag from another window or panel on
the main window.

In the following illustration, the concept ALBUMIN PREPARATION, from an Ontylog
namespace, was dragged from the Concept Tree tab into the Concept/Term Details panel.
The attributes (i.e., attribute folders) are expanded for view.

Tree IWaIkerl Saarchl Concept § Term Details |

Namespace: [uor-RT

o [|[ s ]

View Axis: ISuper:oncep{s § Subconcepts
Subset: |

EH@ ALEUMIN PREPARATION
—& Code: CO220

1] Ll e

[+ b Active Ingredients

: b : —a I eE3

+

. E‘UI:UIQ'C St;:clmrels D‘fr:ec‘;‘?"'t —_I Mamespace: MDF-RT [ Ortylog, Subscription, Read-Only 1
Ellular or Molecular Bracions =+ _J Properﬂes

b Sl L2 —dh Blert moa increases infravascular oncotic pressure
[')sez:radsi,ozd::gj:tra;;r;sa:;:hyslologlc S —dh Comment: €I 25% albumin in preterm infant (risk of idiopathic vertricular hypertraphy’
b Demographic states —dh Commert: may trest blood volume loss
b Digestive System Dissases —d\ Commert: C| hypersensitivity to drug or companent of the procuct
—d Comimert: Clin severe anemia and heart failure

b Dizarciers of Environmental Origin | dh Last Reviewed: 10/252003
= '0 Endocrine Diseases —a Leve; \ngred\er:rt

“@ Adrenal Gland Diseases [ . By: OF | 52602003
g Ef::ieZ'mzz &\ Reviewed By: DF | 10252003
qo Duwarfism (—dh Search_Mame: ALBUMIN PREPARATION

; —dh Stetus Reviewed

‘@ Endocring Gland Neoplasts EA e G
\. LR I —dh UMLS Semartic Type: Biclogically Active Substance
“—dh UMLS Semartic Type: Amino Acid, Peptide, ar Pratein
== _4 Superconcepts

I—Q, [Cx201] IMAGING AGEMTS (1M %WO) RADIOPHARMACEUTICALS

hies, Autaimmung

\o Th H ’ A Subconcepts
e L@ ALBUMIN MCROSPHERE HUMAN SERLUM PREFARATION
Thyroid Diseases 4 Roles

\. Tuberculosis, Endocrine 5 some O with Anemia
[+ b Evye Dizesses - E -

b = S — . o . A zome C_with, Drug Hypersensitivity
BImAle Lanta \sefasa.s and Fragnanay Lamplestians Al some Cl_with: Hzart Failure, Congestive

When you expand all, or selected attributes for view, the Concept/Term Details panel
retains those tree settings for the next concept displayed in the view. Only those
attributes that were expanded for the previous concept are “auto-expanded” for the new
concept in the view.
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In the next illustration, a focus concept from a Thesaurus namespace was dragged from
the Concept Tree tab into the Concept/Term Details panel. The attributes are expanded
for view.

Tres |Wa\kar| Searchl Concept / Term Details

Namespace: IMTHFDA [Metathesaurus FDA National Drug Code D\...ﬂ - | =) e Delete
\fiew Axis: Ichwld ©1 [ MTHFDA, [Metathesaurus FDA& National Dru LI

Focus Concept: [DIAZEPAM 5 MG INTRAVENOLIS INJECTION, EMULS.. = | || | = EErE g e RS oty s e W
Bl Code: CO355713
Subset: | = | B Ib: 285713

Y 4. ZER AM 5 MG INTRAVENOUS INJECTION, EMULSION [C0355713] =l Mamespace: MTHFDA, [Metathesaurus FDA National Drug Code Directory] ( Thesaurus, Subscription, Read-Only )
_A Synonyms
Synanym: DIAZEPAM 5 MG IMTRAMUISCULAR IMJECTION, SUSPENSION
Synanym: DIAZEPAM 5 MG INTRAYEMOUS INJECTION, EMULSION ( Preferred )
Synonyr: DISZEPAM 5 MG INTRAYEMOUS INJECTION, SUSPENSION
_A Propetties
&\ Code in Source: 0000108387
4\ Code in Source: 0000101934
& UMLS CUi C0355713
& UNMLS Semantic Type: Clinical Drug

Configure Concept/Terms Details Panel View

To select which attributes will display if there is a concept in the Concept/Term Details
panel, right click the name of the concept you dragged into the panel, then click
Configure View. The Configure Concept/Term Details View window displays, listing
the attribute view options available when a concept is displayed in the panel.

= Configure ConceptfTerm Details View

Code

D

Hamespace
SYnonyms
Properties

[ Superconcepts
Fl
Rales
Inverse Raoles

Associations
Inverse Associations

[ 5ubsets

Aktribute Limit | 100

O Cancel

As the default, all concept attributes are selected for display with the exception of
Superconcepts, Subconcepts, and Subsets. To remove an attribute from the detail
display, click the checkbox adjacent to that attribute to remove the check mark. To add
an attribute, click the checkbox to insert a check mark.

Click OK when finished. Your display configuration is retained for later DTS sessions.
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To select which attributes will display if there is a term displayed in the Concept/Term
Details panel, right click the name of the term you dragged into the panel, then click
Configure View. The Configure Concept/Term Details View window displays, listing
the attribute view options available when a term is displayed in the panel.

= Configure ConceptfTerm Details View

D
Mamespace
Properties
Associations

Inwerse Assaciations

[ Subsets
Attribuke Limit | 100
Ok Cancel

As the default, all term attributes are selected for display with the exception of Subsets.
To remove an attribute from the detail display, click the checkbox adjacent to that
attribute to remove the check mark. To add an attribute, click the checkbox to insert a
check mark. Click OK to save your display configuration.

Depending on your selected configuration, the following concept/term detail attributes
will display. The icon that identifies each attribute is indicated.

Note that only the attributes present for a specific concept or term display on the
Concept/Term Details panel, regardless of the configuration. For example, if a concept
has no associations connected with it, the Associations folder does not display.

Concept (indicates displayed detail is for a concept) @
Term (indicates displayed detail is for a term) #

Concept Code i
Concept ID 4
Concept Namespace i
Concept Synonyms  #

0 Preferred Term
Concept Properties 4

o Concept Property Qualifiers &
Superconcepts .
Subconcepts @
Concept Roles «
Concept Inverse Roles 4
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Associations 3
0 Associated Concepts ("To" Concepts) &
0 Association Qualifiers @
Inverse Associations &
o Inversely Associated Concepts ("From™ Concepts) &
0 Association Qualifiers &
Namespace Subsets @

For local, writable namespaces, after you view concept details, you may select one of the
available editor functions and make modifications to that specific concept’s displayed
attributes. Procedures for creating a new concept in a local namespace, and for viewing
and editing existing concept attributes, are provided later in this section.

Attribute List Control

You can set the maximum number of attributes to be listed when you expand each

attribute folder for a concept (i.e., Associations, Properties, etc.) on the Concept/Term
Details panel. In the Attribute Limit field, specify the maximum number of attributes to
list for each detail component; 100 is the default (specify 0 to list no concept attributes).

For example, enter 10 in the Attribute Limit field to limit the number of listed
associations, properties, roles, etc., for each concept to 10. Note: All superconcepts and
subconcepts display for each concept when you expand the respective folder, regardless
of the threshold you specify in the Attribute Limit field.

Navigate to Other Concepts or Terms From Displayed Detail

On the Concept/Term Details panel you can navigate to (and display attribute details for)
another concept or term from the current attribute detail view. In the following
Concept/Term Details panel illustration, the highlighted concept Biologic Structures of
Recipient is a superconcept of the displayed concept DRAFT Gene Product.

File ‘“iew Tools Options Help

88| &8 B] &) B]%]%] o] @[] 8]
Tree IWaIkerl Saarchl Caneept £ Term Details
Namespace: |noF-RT =l Mew Delete
View Axis: ISuperconcems fSubconcepts LI
Subset: | =1 || |5 @ DRAFT Gene Praduct

I Code: C2E2574

-4 ID: 262574

- Namespace: NDF-RT ( Ontylog, Subscription, Read-Only 3

= _4 Properties

l—h MCI_Preferred_Term: Gene Procuct

= _4 Superconcepts
[ Xeiciouic Structures of Recipiert

h Active Ingredierts

= b Binlogic Structures of Recipient
“@ DRAFT Gene

°

@ DRAFT Gene variant

b Celular or Molecular Interactions
Y Cliriesl Kinetics o 54 Subconcepts
‘@ Diseases, Marifestations or Physilogic States Cg proten
@ HLT Race . _ 524 Subssts

b PharmaceLtical Preparations I_@ MOF-RT

‘@ Physidlogical Effects
@ Proposed HL7 Drug Dose Farms

To display detail attributes for Biologic Structures of Recipient, drag that concept and
drop it into any empty area on the Concept/Term Details panel. The Concept/Term
Details panel display refreshes, referencing attributes for Biologic Structures of
Recipient.
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File View Tools Options Help

2 laslaxl =

= | s v = el | rwm
7| ]| s E] "] T2) o) D] 0] | B

Tree IWalk!r | Search |

Concept f Term Details

Namespace: [NDF-RT

&) =

View Axis: [Superconcepts | Subcancepts

Subset: |

=@ Biologic Structures of Recipient

+-@ Active Ingredients

[#-@ DRAFT Gene Product
('@ DRAFT Gene Variant
¥ Celulsr or Molscular interactions
£ Clinical Kinetics
-4 Diseases, Manifestations o Physiologic States
+-@ HL7 Race
#-@ Pharmaceutical Preparations
¥ Physiological Effects
-9 Proposed HLT Drug Dose Forms

B Code
= .
] : NDF-RT ( Ortylog, Subsseription, Read-Only )
=4 Synonyms

# Synonym: Structures,
=_4 Properties
4 MeSH_UL DOA0342

The previous illustrations reflect navigation to another concept within the same
namespace. You also can navigate to, and display details for, a concept or term within
another namespace. Note the inverse association highlighted in the next illustration.

T —T

s -b Acquired ahsence of teeth, unspecified [624.10] 1=

I8 b Loss ofteeth due to carles [525.13]

i ‘o Loss ofteeth due to periodontal disease [925.12]

o -b Loss ofteeth due to trauma [525.11]

@ Other loss ofteeth [525.19]

=] -b The International Classification of Diseases: 9th revision, C
-3 DISEASES AND INJURIES

‘@ CERTAIN CONDITIONS ORIGINATING IN THE PERI

‘@ COMPLICATIONS OF PREGMANCY, CHILDBIRTH, £

‘@ CONGENITAL ANOMALIES

‘@ DISEASES OF THE BLOOD AND BLOOD-FORMING

‘@ DISEASES OF THE CIRCULATORY SYSTEM

‘@ DISEASES OF THE DIGESTIVE SYSTEM

‘@ DISEASES OF THE GENITOURIMARY SYSTEM

‘@ DISEASES OF THE MUSCULOSKELETAL SYSTEM ¢

‘@ DISEASES OF THE MERVOUS SYSTEM AND SENSE

‘@ DISEASES OF THE RESFIRATORY SYSTEM

‘@ DISEASES OF THE SKIN AND SUBCUTAREOUS TIE

‘@ ENDOCRINE, NUTRITIONAL AND METABOLIC DISE

‘@ INFECTIOUS AND PARASITIC DISEASES

‘@ INJURY AND POISONING

‘@ MENTAL DISORDERS

=) Y thNTALRETARDAT\ON

- |
E-@ Other specified mental retardation [318]

~-'® Woderate mental retardation [318.0)

=@ Mild mental retardation [317]

o Code: C1404
- 10 1404
- Mamespace: 1CD-8-CM { Ontylog, Subscription, Read-Only)
224 Synonyms
-3 Wild mental retardation { Preferred )

# Mild mental retardation, high-grade defect
-4 Wild mental retardation, 12 50-70
-6 Wild mental subnormality
=4 Properties
-dv Gode in Bource: 317

4 UMLS CUIL 0026106
~-4 UMLE Semantic Type: Mental or Behavioral Dysfunction
B4 Supercancepts

@, HENTAL RETARDATION

Bl Inverse Associations

-8 [Irv] SHOMED CT o 1C0-3-CM map: Mild mental retardation (1.2, 50-70) (disorder)

I
& Mapping Category: Marrow to Broad

Drag the selected inverse association and drop it into an empty area on the Concept/Term
Details panel. The panel display refreshes, referencing the concept or term included in
the inverse association you selected.

Note that new concept displayed in this illustration is from a different namespace.

T )
- Acouired absence ofteeth, unspecified (5246.10] -
- b Loss of teeth due to caries [525.13]
= b Loss ofteeth due to periodontal disease [525.132)
o Loss ofteeth due to traurma [526.11]
L@ Other Inss ofteeth [5246.18]
£ b The International Classification of Diseases: dth revision, C
-3 DISEASES AND INJURIES
£-@ CERTAIN CONDITIONS ORIGINATING IN THE PERI
#1-@ COMPLICATIONS OF PREGMNANCY, CHILDBIRTH, &
#1-@ CONGENITAL AMOMALIES
£-@ DISEASES OF THE BLOOD AND BLOOD-FORMING
#-@ DISEASES OF THE GIRCULATORY SYSTEM
+-@ DISEASES OF THE DIGESTIVE SYSTEM
@ DISEASES OF THE GEMITOURIMARY SYSTEM
£-@ DISEASES OF THE MUSCULOSKELETAL SYSTEM /4
7@ DISEASES OF THE NERVOLIS SYSTEM AND SENSI
+-@ DISEASES OF THE RESPIRATORY SYSTEM
- DISEASES OF THE SKIN AND SUBCUTAMNEQUS TI
£-@ ENDOGRINE, NUTRITIOMAL AND METABOLIC DISE
#-@ INFECTIOUS AND PARASITIC DISEASES
£-@ INJURY AND POISONING
]b MENTAL DISORDERS

SR hfoENTAL RETARDATION

PE b Cther specified mental retardation [318]
i - Moderate mental retardation [318.0]

=@ Educationally subnormal (finding)

2 Code: S-2001F

1D 276354003

A Mamespace: SNOMED CT { Ontylog, Subscription, Read-Only)

] Synonyms \
] Properties

) Buperconcepts
] Subconcepts
| Roles

£ Associations

Different Namespace
Referenced
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For any displayed concept or term, you can navigate to those concepts or terms
referenced in the displayed details (associations, inverse associations, roles, inverse roles,
concepts or terms referenced as superconcepts, subconcepts, synonyms).

View Subsets in Which a Concept Resides

In addition to listing a concept’s attributes in the Concept/Term Details panel, you have
the option to list all subsets in which the concept in the view is included. Confirm that
the Subsets option is checked in the Configure Concept/Term Details View window.

|

E Configure Concept;Term Details ¥iew

|7 Code

¥ b

v Mamespace
il Synonyms

v Properties

v Superconcepts
v Subconcepts
[V Roles

|7 Inverse Roles
[V Associstions

IV Inverse Associations
Attribute Limit |1 oo
0K | Cancel |

If the concept is included in one or more subsets, a Subsets folder is added to the
Configure Concept/Term Details View panel view. Each subset in which the concept is

included is listed in the folder, adjacent to the (! icon.

Subsets View Option

Concept / Term Details |

e Delete |
E-@ Permease
Bl Code: C2EZE33
o D 2E2EE3

- Mamespace: MDF-RT [ Ortylog, Subscription, Read-Only 1
(== _4 Propertties
&\ MCI_Preferred_Term: Permeasze
(== _4 Superconcepts
l—ob Tranzport Pratein
£ _ 4 Subconcepts
l—b ABC Transporter
=—_4 Subsets <
MOF-RT

Subsets Folder

If a subset is modified so that the concept in the view no longer is included in the subset,
that subset is removed from the listing.

You can drag a subset listed on the Concept/Term Details panel, then drop it onto the
Subset Expression Editor window to view and/or modify concept selection parameters for
the subset. Refer to the DTS Subset Editor Users Guide for procedures on creating and

maintaining subsets.
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Concept Name and Attribute Text Wrapping

If lengthy concept names and/or attribute text extend beyond the border of the Concept/
Term Details panel, the text will wrap around to a new line. The concept name or
attribute text also will be enclosed in brackets.

Wrapped
Concept Name
in Brackets

Wrapped
Concept
Attributes
in Brackets

—+—>

Concept | Term Details
o

= [Body structure, altered From its original anatomical
= structure {morphologic abnormality)
| ler M-01001

B I 118958008
" Namespace: SNOMED CT { Ontylog, Subscription,
Read-Only, 2003.07 )
=4 Synonyms
r\;n-: nym: Body structure, altered from its
#*

ariginal anatomical structure (marphaologic
abnormality)
# Synonym: Morphologic alteration
#* Synonym: Morphologic change
* [Syn\:-ruyrn: Morphalogically altered structure (
Preferred )
= _{ Properties
& Codein Source: 118956008
& Concept Status: Current
& NHS Clinical Terms Yersion 3 XU4(9
& SNOMED Legacy-style Code: M-01001
=~ _§ Superconcepts

:
=~ _4 Subconcepts

If you enlarge the Concept/Term Details panel, then drag a different concept into the
panel, the enlarged panel size setting is retained. The text wrapping and brackets will be
removed if they are not required in the larger panel.

Text Wrap and
Brackets are
Retained Only
if Required

Concept [ Term Details

«|=»

""" A Coder M-01001

""" o ID: 11395E00%

----- o Mamespace: SNOMED CT { Onkylog, Subscription, Read-Cnly, 2003,07 )
=4 Synonyms

----- # Synonym: Morphologic alteration
----- # Synonym: Morphologic change
----- # Synonym: Morphologically alkered struckure  Preferred )
=~/ Properties
----- & Codein Source: 118956008
----- 4 Concept Status: Corrent
----- & MHS Clinical Terms Wersion 3: sL412
----- & SMOMED Legacy-style Code: M-01001
=4 Superconcepts
¢ @ Body structure (body struckure)
=4 subconcepts
----- @ Apoptosis (morphalagic abnovmality)
----- b Morphologically abnormal struckure {morphalogic abnormality

----- b Structure resulting From tissue repair process {morphologic abniormality)

=@ Body structure, altered from its original anatomical structure (morphologic abnormalty)

P .- # Synonym: Body structure, albered From its original anatomical structure {morphologic abrormality
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View Concept/Term Details Panel History Using Forward and Back Buttons

For your reference, a history is provided of the concepts and/or terms that were displayed
previously in the same instance of the Concept/Term Details panel. Use the Forward
and Back buttons to navigate through concepts and terms that you viewed or edited
earlier.

For example, if you are viewing a concept or term in the Concept/Term Details panel,
then subsequently drag a different concept or term into the panel for view or edit, the
Back button becomes enabled. Note the illustration.

/— Back Button Enabled
Congept [ Term Details
Mew

=@ SAMPLEABLE_EMTITY
F-ll Coder C177

> ----- 2 Mamespace: Triad { Ontylog, Subscription, Read-Only, 1.0.0,0)
=+ Properties

sy cpric_code: 32291

Loy prink_name: Sampleable Entity

Click the Back button to review the concept that displayed in the panel previously (i.e.,
the concept in the Concept/Term Details panel’s history). The view always reflects the
current Configure View setting for the Concept/Term Details panel.

As soon as you click the Back button, the Forward button becomes enabled.

/— Forward Button Enabled
ConceptA Term Details
Mew

=@ SAMPLEABLE_ENTITY
Code: CIFF

ID: 177
; Mamespace: Triad { Ontylog, Subscription, Read-Cnly, 1.0.0.0 )
=14 Properties

- dy Cpmc_code: 32291

o dy prink_name: Sampleable Entity

Click the Forward button repeatedly to redisplay the concept you dragged into the
Concept/Term Details panel most recently. The button becomes disabled (grayed out)
when the most recent concept is displayed.

The displayed history reflects the latest version of a concept or term. If a concept or term
is updated after it was put in the history, the latest version of the concept or term is
displayed when you click the Forward and Back buttons.

The Concept/Term Details panel history is available only for the current connection
instance. The Concept/Term Details panel history will be reset when you disconnect
from the DTS Editor.
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Add a New Concept/Term to a Local Namespace

Create the New Concept
Follow this procedure to add a new concept or term to an established local namespace.

1. To create a new concept in a namespace, click New in the Concept/Term Details
tab in the right panel of the DTS Main window. The Create New Concept/Term
window displays.

[ 7
Create New Concept / Term ll

Name: |

Hamespace: [f¥esssiss

0 Mew Concept  { Mew Term

Ok I Cancel |

2. Enter the name of the new concept in the Name field.

3. From the Namespace field dropdown list, select the local namespace to which the
new concept will be added (only local, writable namespaces are listed).

4. The default, New Concept, applies if you are adding a new concept to the local
namespace. Click New Term to add a new term to the local namespace.

5. To cancel the addition of the concept or term to the namespace, click Cancel.
The Create New Concept/Term window closes.

Click OK to add the concept or term to the selected namespace. The new concept
name displays in the Concept/Term Details panel, and references the namespace
in which you created it.

The Concept Code and 1D (which are assigned to the new concept automatically)
display as well. Note that each concept ID is tracked so that if the concept is
deleted at a later time, that concept ID is prevented from being reassigned to
another new concept.

To change the format of the assigned concept code and/or ID, follow the
procedures outlined in the Code and ID Generator discussion later in the guide.
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Change the Name of a Concept
You can change the name of an existing concept only if the namespace is writable.

1. Make sure the concept you want to modify displays on the Concept/Term Details
panel. Right-click on the concept name.

2. On the displayed option list, click Rename. The Rename Concept/Term window
displays, referencing the existing concept name.

:E: Rename Concept,/Term ll

New Name: IAcquired body structure (hody Structure)|

Ok | Cancell

3. Enter a New Name for the concept, and click OK. If the conceptisina
namespace that is not writable, the following window displays.

Unable to write Concept/Term to Mamespace

Click OK to bypass the renaming of the concept.

If the concept you want to rename is in a writable namespace, the new name
displays immediately in the Concept/Term Details panel. The namespace is
updated with the new concept name.

Add a Synonym to a Concept

Use one of the following methods to add a synonym (with an association type established
as local content in a local namespace) between concepts or terms in a subscription
namespace. The synonymous term can exist in the same namespace as the concept, or in
a different namespace. A synonym always pairs a concept with a synonymous term
(never a concept with a concept, or a term with a term).

If you are creating a synonymous term as local content for a concept in a subscription
namespace, the association type you select must be created already in the current local
namespace; the resulting new synonym will be written to the current local namespace as
well. You have the option of defining a new character string as the synonymous term,
and linking that term to a concept.
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Create a Synonym — Click on Concept Name in Concept/Term Details Panel

Follow this procedure to link a synonymous term to a concept by right clicking on the
new concept name in the Concept/Term Details panel.

1.

If the new concept is displayed in the Concept/Term Details panel, right-click on
the concept name. Select Add Synonym from the displayed options.

To add a synonym to an existing concept, drag the concept from another
displayed window or panel and drop it on the Concept/Term Details panel. Right-
click on the concept name, then select Add Synonym from the displayed options.

The New Synonym window displays.

= New Synonym x|

Concept: |.°.cquired ichthyosis (disorder) [ SMOMED CT ]

LT L Y T H B Conicept Bo Term [ SMOMED CT EXTEMSION ]

Term: I

" Is Preferred Craate Mew Term ... |

K I Cancel I

The concept from the Concept/Term Details panel displays automatically in the
Concept field.

If you are creating a synonymous term for a concept in a subscription or local
namespace, only association types from the current local namespace are listed
(alphabetically) in the Synonym Type dropdown field, and only those association
types that represent connections between concepts and synonymous terms
(Concept to Term Assoc); select the appropriate association type. A new
(synonymous) association between the concept and the term you select will be
written to the local namespace where the association type was created. Refer to
the Association Types discussions.

You have the option of filtering the association types that are available from the
Synonym Type field dropdown list by creating a pre-defined, filtered list of types.
When you attempt to select an association type from the Synonym Type field
dropdown list, or select an alternate association type, only the pre-selected
association types will be included in the list. Refer to the Filter Association Types
discussion.
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From one of the other display windows or panels, drag the concept/term you want
to establish as a synonym, and drop it into the Term field on the New Synonyms
window. The term can be from the same namespace as the concept, or from a
different namespace.

If you would rather create a new term (i.e., one not already existing in a
namespace) to establish as a synonym, click Create New Term. The Create New
Term window displays.

Create New Term 5'

Narme: |

Namespace: [4 Local Namespace =

C " New Term

Ok | Cancel

Specify the Name of the new synonymous term. From the Namespace field
dropdown list, select the local, editable namespace in which it will reside (local
namespaces are listed alphabetically). The synonym you are adding is a New
Term (the only option).

Click OK. The Create New Term window closes.

In the event multiple synonyms exist for a specific concept, you can designate that
one of the synonyms Is Preferred. On the New Synonym window, click the Is
Preferred field checkbox to designate this synonym as the preferred synonym.
This synonym will be referenced as Preferred when you expand the Synonyms
folder on the Concept/Term Details panel.

= New Synonym @

Concept: | Acquired ichthyosis (disorder) [ SMOMED CT ]
Synomym Type: | | Concept ko Term [ SNOMED CT EXTENSION ] N

Term: | acquired ichthyosis [ SNOMED CT EXTENSION ]

[J1s Preferred [ CreateMewTerm.. |

Click OK on the New Synonym window to add the synonym to the current local
namespace. In the Synonyms folder for the concept on the Concept/Term Details
panel, the synonym displays in italics (to indicate that it is subscription content
that was written to a local namespace).
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Create a Synonym — Control/Drag Concept into Concept/Term Details Panel

Follow this procedure to link a synonymous term to a concept displayed in the
Concept/Term Details panel using the concept Control/Drag option.

1. Make sure the concept for which you want to add a synonymous term displays in
the Concept/Term Details panel.

2. From another displayed panel or window (or another instance of the Concept/
Term Details panel) select the term you want to add as a synonymous term, then
drag it to the Concept/Term Details panel.

The term can be from the same namespace as the concept, or from a different
namespace, but the association type for it must reside in a local namespace (i.e.,
the association type must be created in a local namespace).

3. Hold the Control key down before you drop this concept into the Concept/Term
Details panel.

The New Synonym window displays. The concept from the Concept/Term Details
panel displays in the Concept field, and the dragged concept populates the Term
field (the namespace in which the concept resides is included in brackets).

= New Synonym @
Concept: | Acquired ichthyosis (disorder) [ SMOMED CT ]

Synomym Type: | | Concept ko Term [ SNOMED CT EXTENSION ] N

Term: | acquired ichthyosis [ SNOMED CT EXTENSION ]

[J1s Preferred [ CreateMewTerm.. |

4. Click OK on the New Synonym window to add the synonym to the current local
namespace. When you expand the Synonyms folder for the concept on the
Concept/Term Details panel, the synonym displays in italics (to indicate that it is
subscription content that was written to a local namespace).

Create a Synonym — Control/Drag Local Synonym into Concept/Term Details Panel

Follow this procedure to select an existing synonym (in a local namespace) displayed in
another panel, then add the synonym itself to a concept displayed in the Concept/Term
Details panel using the concept Control/Drag option.

1. Make sure the concept for which you want to add a synonymous term displays in
the Concept/Term Details panel.
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2. From a concept displayed in another panel or window (or in another instance of

the Concept/Term Details panel) select the local synonym you want to add; select
the local synonym itself (not the entire concept); local synonyms display in
italics.

Drag the selected synonym to the Concept/Term Details panel. Hold the Control
key down before you drop the synonym into the Concept/Term Details panel; the
dragged synonym displays in italics.

Edit a Synonym

Follow this procedure to modify an existing synonym for a concept. You can modify an
existing synonym for a concept in a subscription namespace, but only if the association
type exists in a local namespace (i.e., the synonym is content in a local namespace, and is

listed in italics).

1. To edit a synonym for an existing concept, drag the concept from another

displayed window or panel and drop it on the Concept/Term Details panel.

For the displayed concept, click on the Synonyms folder to expand it. The
existing synonyms for the concept display. Right-click on the synonym you want
to edit, then select Modify Synonym from the displayed options.

oncept § Term Details |

flewr

Delete:

Defined View

@ Acquired ichthyosis (disorder)
& Code: DO-Z2340

—a 1D 85291004

o Mamespace: SMOMED CT ( Ontylog, Subscription, Read-Only )
= Frimilive

—# Kinck SMOMED_kinc

#- | Defining Concepts

| Defining Roles

=4 Synonyms

Acouired ichthyosis ( Preferred )

Acguired ichthyosis (disorder)

Acquired inctiyosis [ SNCAE0 o T orToacian
E:J Properties
| Associations:

Delete Synornym ...

The Modify Synonym floating window displays, referencing the concept and the
synonymous term, as well as the namespace in which each resides.

= Mo dify Synonym E

Concept: | Acquired ichthyosis (disorder) [ SHOMED CT ]

Symomym Type: | | Concepk to Term [ SMOMED CT EXTEMSION ] 4

Term: | acquired ichthyosis [ SMOMED CT EXTENSION ]

[lis Preferred [ Create New Term ..., ]

3. Make the desired edits, then click OK to update the appropriate namespace(s).
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Delete a Synonym

Follow this procedure to delete an existing synonym for a concept that was created as
content in a local namespace.

1. To delete a synonym for an existing concept in a local namespace, drag the
concept from another displayed window or panel and drop it on the Concept/Term
Details panel.

2. For the displayed concept, click on the Synonyms folder to expand it. The
existing synonyms for the concept/term display. Each synonym that is content in
a local namespace displays in italics.

Concept ! Term Detailz |

ew | oo |

@ Acquired body structure (body structure)
A Code: T-DO140
B 1D 280116004
- Mamespace: SMOMED CT ( Ontylog, Subscription, Read-Only )
_ M Syhokyms
Acouired body structure ( Preferred )
Acouired body structure (hody structure)
Acguired Stroctiure
+] | Properie:

3. Right-click on the synonym you want to delete, then select Delete Synonym from
the displayed options. Note that if the synonym is in a namespace that is not
editable, the Delete Synonym option is not available.

The following confirmation window displays.

Confirm Delete x|

@ Are you sure you want to delete the Synonwvm 'Boquired Struckure '?
il cancel |

4. Click OK to delete the synonym from the local namespace where it resides. Click
Cancel to ignore the deletion and close the window.

Add a Property to a Concept or Term

Follow this procedure to create a new property (as local content in the current local
namespace) for a concept or term that resides in a subscription namespace.

1. Drag the concept/term for which you want to add a property into the
Concept/Term Details panel.

2. Right-click on the concept/term name on the Concept/Term Details panel, then
select Add Property from the displayed options. The Add Property window
displays.
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= Add Property g
b

Concept / Term: |[ET: ecial preparation {procedure)

Property Type: | | Approval Status [ SHOMED CT EXTEMSION ]

Property Value:

Qualifier Type: | | Requires Werification [ SNOMED CT EXTEMSION ] v
Qualifier Value: i
[ add ] [ Remove ] [ Clear ]

The concept/term from the Concept/Term Details panel displays automatically in
the Concept/Term field, and the namespace in which it exists displays in brackets.

. A property type is a pre-established identifier that defines the property. From the
Property Type field dropdown list, select a property definition to be assigned to
the concept or term. If the Concept/Term is from a subscription namespace, the
Property Type dropdown list includes only property types created in the current
local namespace, listed alphabetically.

If the Concept/Term was created in a local namespace, the Property Type list
includes property types created in the current local namespace, but only if the
Concept/Term also was created in the current local namespace. If the
concept/term was not created in the current local namespace, the Property Type
field dropdown list will be empty. Refer to the Property Types discussions.

You have the option of filtering the property types that are available from the
Property Type field dropdown list by creating a pre-defined, filtered list of
property types. When you attempt to select a property type from the Property
Type field dropdown list, or select an alternate property type, only the pre-selected
types will be included in the list. Refer to the Filter Property Types discussion
earlier in the guide.

For the property definition (type) assigned to this concept or term, specify the
property value in the Property Value text area. This area accommodates the entry
of large amounts of text, as well as formatted text (e.g., paragraphs, bulleted
items, etc.). A single concept or term can have multiple occurrences of the same
property type, each with a separate, unique value.
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= Add Property >

Concept ! Term: |Gross organ fixation and special preparation {procedure) [ SNOMED CT ] A

Property Type: | | Approval Status [ SMOMED CT EXTENSION ]

Property Value: F'assed|

Requires Verification [ SMOMED CT EXTEMSION ] w
Qualifier Value: i
[ Add ] [ Remove ] [ Clear ]

5. For each property you may specify an established qualifier type and value; these
provide additional detail regarding the nature of a concept or term property (e.g.,
Current). From the Qualifier Type field dropdown list, select the qualifier to
assign to this property. The list includes only those property qualifier types that
were created in the same local namespace where the selected property type was
created (refer to the Property Qualifier Types discussions).

6. For the property qualifier (type) you selected for this concept or term, specify the
qualifier value in the Qualifier Value field. For each property you can create
multiple occurrences of the same qualifier type, each with a separate, unique
value.

7. Click Add after you specify the Qualifier Type and Qualifier Value; both are
added to the area in the lower portion of the window. Note the illustration.

Qualifier Type: | | Concept Review Meeded [ SNOMED T EXTEMSION ] v

Qualifier Value: Hpproved =

[ Add ][ Remove ][ Clear ]

Concept Review Meeded [ SMOMED CT EXTERSION ] Approved

To remove an individual qualifier type/value combination from the property,
highlight the appropriate line in the display area and click Remove. To clear all
displayed qualifier type/value combinations, click Clear.

You have the option of filtering the property qualifier types that are available
from the Qualifier Type field dropdown list by creating a pre-defined, filtered list
of types. When you attempt to select a qualifier type from the Qualifier Type
field dropdown list, or select an alternate Qualifier type, only the pre-selected
property types will be included in the list. Refer to the Filter Property Qualifier
Types discussion earlier in the guide.
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8. Click OK on the Add Property window to add the property to the current local
namespace. When you expand the Properties folder for the concept on the
Concept/Term Details panel, the property displays in italics (to indicate that it is
subscription content that was written to a local namespace). Click Cancel to
ignore the new property.

Edit a Concept Property

Follow this procedure to view and/or edit a property that was created in a local
namespace for a concept or term in a subscription namespace.

1. Drag the concept/term containing the property you want to view or edit from
another panel and drop it on into the Concept/Term Details panel.

2. On the Concept/Term Details panel, expand the Properties folder to display
existing properties for the concept/term.

3. Right-click on the property for which you want to view or edit details, then select
Modify Property from the displayed options. (Properties created as local content
display in italics; the Modify Property option is available for these properties
only.) The Modify Property window displays.

= Modify Property a

Concept / Term:

Property Type: | | Approval Status [ SMOMED CT EXTEMSION ] v

Property Value: poccoq

Qualifier Type: | |Requires werification [ SNOMED CT EXTEMSION ] w
Qualifier Value: b
[ Add ] [ Remave ] [ Clear ]

The concept/term from the Concept/Term Details panel displays in the
Concept/Term field, and is not editable. The namespace in which the
concept/term resides displays in brackets.

4. A property type is a pre-established identifier that defines the property. From the
Property Type field dropdown list, select an alternate property definition to be
assigned to the concept or term. If the Concept/Term is from a subscription
namespace, the Property Type dropdown list includes only property types created
in the current local namespace, listed alphabetically.
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If the Concept/Term was created in a local namespace, the Property Type list
includes property types created in the current local namespace, but only if the
Concept/Term also was created in the current local namespace. If the
concept/term was not created in the current local namespace, the Property Type
field dropdown list will be empty. Refer to the Property Types discussions.

You have the option of filtering the property types that are available from the
Property Type field dropdown list by creating a pre-defined, filtered list of types.
When you attempt to select a type from the Property Type field dropdown list, or
select an alternate property type, only the pre-selected types will be available in
the list. Refer to the Filter Property Types discussion earlier in the guide.

For the property type (definition) assigned to this concept or term, you can modify
the property value in the Property Value text area.

For each property you can specify an established qualifier type and value; these
provide additional detail regarding the nature of a concept or term property (e.g.,
Current). From the Qualifier Type field dropdown list, select the qualifier
assigned to this property. The list includes only those property qualifier types
that were created in the same local namespace where the selected property type
was created; refer to the Property Qualifier Types discussions.

For the property qualifier (type) you selected for this concept or term, specify the
qualifier value in the Qualifier Value field. For each property you can create
multiple qualifiers with different qualifier types, or multiple occurrences of the
same qualifier type, each with a separate value.

Click Add after you specify the Qualifier Type and Qualifier Value; both are
added to the display area in the lower portion of the window. See the illustration.

Qualifier Type: | | Concept Review Needed [ SNOMED CT EXTEMSION ] w
Qualifier Value; [mmedists A
[ add ] [ Remave ] [ Clear ]

Concept Review Meeded [ SNOMED CT EXTENSION ] Immediate

To remove an individual qualifier type/value combination from the property,
highlight the appropriate line in the display area and click Remove. To clear all
displayed qualifier type/value combinations, click Clear.

You have the option of filtering the property qualifier types that are available
from the Qualifier Type field dropdown list by creating a pre-defined, filtered list
of types. When you attempt to select a qualifier type from the Qualifier Type
field dropdown list, or select an alternate Qualifier type, only the pre-selected
types will be available in the list. Refer to the Filter Property Qualifier Types
discussion earlier in the guide.
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9.

Click OK on the Modify Property window to add the property edits to the current
local namespace. Click Cancel to ignore the edits.

Delete a Concept Property

Follow this procedure to delete an existing property from a concept, if the property was
written to a local, writable namespace.

1.

Drag the concept/term containing the property you want to delete into the
Concept/Term Details panel.

On the Concept/Term Details panel, expand the Properties folder to display
existing properties for the concept/term.

Right-click on the property you want to delete, then select Delete Property from
the displayed options. Note that the Delete Property option is not available if the
displayed concept exists in a namespace that is not writable.

A delete confirmation window similar to the following displays.

Confirm Delete x|

@ Are you sure wou wank o delete the Property 'Current: Quarterly Review' ?

Cancel |

Click OK to delete the concept/term property from the concept in the local
namespace. Click Cancel to ignore the deletion.

Create an Association

Use one of the following methods to add an association (with an association type
established as local content in a local namespace) between concepts or terms in a
subscription namespace. The association can be between concepts or terms within one
namespace, or across different namespaces.

Create an Association — Click on Concept Name in the Concept/Term Details Panel

Follow this procedure to add an association definition and target concept value to the new
concept by right clicking on the new concept name in the Concept/Term Details panel.

1.
2.

Drag the relationship from concept/term into the Concept/Term Details panel.

Right-click on the concept/term name on the Concept/Term Details panel, then
select Add Association from the displayed options. The Add Association window
displays.
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S Add Association m

From Concept ! Term:
Association Type: | | Child OF [ PM-10] "
To Concept / Term: b
Qualifier Type: | | Pending Review [ PM-10] ~
Qualifier Value: 4
[ Aidd ] [ Remove ] [ Clear ]

The from concept/term from the Concept/Term Details panel displays
automatically in the From Concept/Term field, establishing the From portion of
the From/To association between concepts or terms. The namespace in which
the from concept resides displays in brackets.

3. From the Association Type field dropdown list, select the type of association (e.g.,
Related To, Child Of) you are creating between the concepts or terms.
Association types from the current local namespace are listed alphabetically.
Refer to the Association Types discussions.

You have the option of filtering the association types that are available from the
Association Type field dropdown list by creating a pre-defined, filtered list of
types. When you attempt to select an association type from the Association Type
field dropdown list, or select an alternate association type, only the pre-selected
types will be included in the list. Refer to the Filter Association Types discussion
earlier in the guide.

4. From another displayed panel or window, drag the target concept/term in the
association in the To Concept/Term dropdown field. The namespace in which the
to concept resides displays in brackets to the right of the field.

From Concept / Term:

Association Type:

To Concept | Term: |Pathology and Laboratory Tests [Level 1: 80043-89356] [ CPT ] v

5. For each association you can add one or more qualifiers, each of which consists of
an established qualifier type and value. Qualifiers provide additional detail
regarding the nature of a concept or term association (e.g., Usually).

From the Qualifier Type field dropdown list, select a qualifier type to assign to
this association.
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The list includes only those association qualifier types that were created in the
same local namespace where the selected Association Type was created (refer to
the Association Qualifier Types discussions). The namespace in which the
qualifier type was created displays in brackets.

6. For the qualifier (type) you selected for this association, specify the qualifier
value in the Qualifier Value field. For each association you can create multiple
qualifiers of different types, or create occurrences of the same qualifier type, each
with a separate value.

7. Click Add after you specify the Qualifier Type and Qualifier Value; both are
added to the display area in the lower portion of the window (see the illustration).

Qualifier Type: | | Pending Approval [ SHOMED CT EXTENSION ] 7
Qualifier Value; [mmediate 3

[ Add ][ Remove ][ Clear ]

Fending Approval [ SNOMED CT EXTENSION | Immediate

To remove an individual qualifier type/value combination from the association,
highlight the appropriate line in the display area and click Remove. To clear all
displayed qualifier type/value combinations, click Clear.

You have the option of filtering the association qualifier types that are available
from the Qualifier Type field dropdown list by creating a pre-defined, filtered list
of types. When you attempt to select an association qualifier type from the
Qualifier Type field dropdown list, or select an alternate Qualifier type, only the
pre-selected types will be included in the list. Refer to the Filter Association
Qualifier Types discussion earlier in the guide.

8. Click OK on the Add Association window to add the association.
Create an Association — Control/Drag Concept into the Concept/Term Details Panel

Follow this procedure to create an association definition and target concept value for the
new concept using the concept Control/Drag option.

1. Make sure the from concept for which you want to add an association (e.g., Drug
Testing) displays in the Concept/Term Details panel.

2. From another displayed panel, or another instance of the Concept/Term Details
panel, select the concept you want to add as the target concept in the association
(e.g., Pathology and Laboratory Tests) then drag it to the Concept/Term Details
panel. Hold the Control key down before you drop this concept into the
Concept/Term Details panel. The Add Association window displays.
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3. Both the From and To concept/terms display automatically in the appropriate
fields. The namespace in which each concept resides displays in brackets.

Tree | Walker | Search Concept | Term Details
Namespace: cPT v 3G Tew

Wiew Axis: |Superconcepts [ Subconcepts

=@ Drug Testing [Level 2: 80100-80103]
Code: Level 21 80100-80103
il ID: 694
i Mamespace: CPT ( Ontylog, Subscription, Read-Only, 2005.1.44C )

Subset: b

@ AnesthesiaProcedures [Level 1 D0100-01999]
*‘“b [Emerging Technology, Services & Procedure Codes (Category I1I,

[ Synonyms
Temporary) [Lewel 1: 0001T-9999T] A .
©-@ Evaluation and Management Procedures [Level L: 89201-29502] i Preferred Name: Drug Testing (Preferred )

+--b Medicine Guidelines [Level 1: 90281-99199] — -

5 IERET = = Add Association E]
@ Anatomic Pathology Procedures [Level 2: 83000-33299] |
H ° Chemistry Pathology and Laboratory Tests [Lewel 2; From Cancept | Term:

&
@ | 52000-84999] association Tyoe: | | EEEATDET
- @ Consultations (Clinical Pathology) [Level 2: 80500-50502] vpe: | [Silble =

A @ Drug Testing [Level 2: 80100-80103] To Concept i Term:
- b Evocative/Suppression Testing [Level 2: 80400-30440] o0
jr » [Hamatology and Coagulation Procedures [Level 2:

] b drug
& Immur = 2. lifier Ty Pending Review [ PM-10
@ Immunology Procedures [Level 2: B5000-86849 Qualifier Type: w

4@ Micrabiology Procedures [Level 2; 87001-87939]

- '0 Organ or Disease Oriented Panels [Level 2; 80048-80075]
+ b Cther Pathology and Laboratory Procedures [Level 2;

? 89050-89240] [ Add ] I Remove ] [ Clear ]
- b Reproductive Medicine Procedures [Level 2: §3250-39356]
@ Surgical Pathology Procedures [Level 2: 88300-88393]
@ Therapeutic Drug Assays [Level 2 BO1S0-B0299]

- b Transcutaneous Procedures [Level 2; 88400-85400]

= @ Transfusion Medicne Procedures [Level 2: 86850-86999]
- b Urinalysis Procedures [Level 2: 81000-81099]

i “o Radiology Procedures [Level 1 70010-79999]

#-@ Surgical Procedures [Level 1: 10021-59990]

- b [Tra:king iZodes For Performance Measurement {Category 1I)

[Level 1: D001F-0999F]

Qualifier Value: w

From the Association Type field dropdown list, select the type of association (e.g.,
Likened To, Related To) you are creating between the concepts or terms.
Association types from the current local namespace are listed alphabetically.
Refer to the Association Types discussion.

You have the option of filtering the association types that are available from the
Association Type field dropdown list by creating a pre-defined, filtered list of
types. When you attempt to select an association type from the Association Type
field dropdown list, or select an alternate association type, only the pre-selected
types will be included in the list. Refer to the Filter Association Types discussion
earlier in the guide.

4. For each association you can add one or more qualifiers, each of which consists of
an established qualifier type and value. Qualifiers provide additional detail
regarding the nature of a concept or term association (e.g., Usually).

From the Qualifier Type field dropdown list, select a qualifier type to assign to
this association. The list includes only those association qualifier types that were
created in the same local namespace where the selected association type was
created (refer to the Association Qualifier Types discussions). The namespace in
which the qualifier type was created displays in brackets.

5. For the qualifier (type) you selected for this association, specify the qualifier
value in the Qualifier Value field. For each association you can create multiple
qualifiers of different types, or create occurrences of the same qualifier type, each
with a separate value.
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Click Add after you specify the Qualifier Type and Qualifier Value; both are
added to the area in the lower portion of the window. Note the illustration.

Qualifier Type: Pending Approwval [ SNOMED CT EXTENSION ] v
Qualifier Value; mmediate v

[ Add ][ Remove ][ Clear ]

Fending Approval [ SKOMED CT EXTEMSION | Immediate

To remove an individual qualifier type/value combination from the association,
highlight the appropriate line in the display area and click Remove. To clear all
displayed qualifier type/value combinations, click Clear.

You have the option of filtering the association qualifier types that are available
from the Qualifier Type field dropdown list by creating a pre-defined, filtered list
of types. When you attempt to select an association qualifier type from the
Qualifier Type field dropdown list, or select an alternate Qualifier type, only the
pre-selected types will be included in the list. Refer to the Filter Association
Qualifier Types discussion earlier in the guide.

6. Click OK on the Add Association window to add the association.
Create an Association — Control/Drag Association into the Concept/Term Details Panel

Follow this procedure to select an existing local association itself from a target concept
displayed in another panel, then add the association itself to the new concept in the
Concept/Term Details panel using the concept Control/Drag option.

1. Make sure the from concept for which you want to add an association (e.g., Drug
Testing) displays in the Concept/Term Details panel.

2. From a target concept displayed in another panel or window (or in another
instance of the Concept/Term Details panel) select the local association you want
to add. Select the local association itself (not the concept); local associations
display in italics.

3. Drag the target concept association to the Concept/Term Details panel where the
association from concept is displayed. Hold the Control key down before you
drop the target concept association into the Concept/Term Details panel where
the from concept is displayed. The dragged target concept association displays
(in italics) in the Associations folder for the association from concept displayed
in the Concept/Term Details panel.
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Create a Concept/Term Association within a Namespace

The following procedure illustrates how to create an association between concepts or
terms within the same namespace. In the example shown, an association is created
between two concepts in the ICD-9-CM namespace.

1. Inthe DTS Editor Main window, open one or more display panels that include the
concepts or terms for which you want to create an association. The panel displays
should reflect the same namespace (in this case, ICD-9-CM). In the illustration,
the Concept Tree panel reflects both concepts that will be included in the
association (Diabetes mellitus and Diabetes with ketoacidosis).

Tres | walker | Search |

Namespace: [icp-9-cit

View Axis: [Supsrconcets / Subcancepts

Subset: |
TR0 K

+-@ DISEASES OF THE MUSCULOSKELETAL SY¥STEM AND CONNECTIVE TISSUE [710-739.95]
#-@ DISEASES OF THE NERYOLIS SYSTEM AND SENSE ORGANS [320-389.99]

+—@ DISEASES OF THE RESPIRATORY SYSTEM [460-519.99]

+- DISEASES OF THE SKIN AND SUBCLITANEOUS TISSUE [580-709.99]

=—@ ENDOCRINE, NUTRITIONAL AMD METABOLIC DISEASES, AND IMMUNITY DISORDERS [240-279.99]
&%D\SEASES OF OTHER EMDOCRIME GLANDS [250-259.93]

Diabetes melltus [250]

“@ Diabetes melitus with hyperosmolarty [250.2]
h of complication [250.0]

ifestations [250.6]
“@ Diabetes with ophthaimic manifestations [250.5]
“@ Diabetes with other coma [250.3]
“@ Disbetes with other specified manitestations [250.8]
“@ Diabstes with peripheral circulstory disorders [250.7]
@ Diabetes with renal manifestations [250 4]

- Diabstes with unspecified complication [250.9]
+—@ Dizeases of thymus gland [254]
£-@ Disorders of adrenal glands [255]
£ Disorders of parathyrold gland [252]
£ Disorders of the pituitary gland and s hypothalarmic control [253]
£ Other dlisordlers of pancreatic internal secration [251]
@ Other shdocring disorders [259]
@ Ovarian dysfunction [256]
#-@ Polyglandular dysfunction and related disarders [258]
#-@ Testicular dysfunction [257]
£ DISORDERS COF THYROID GLAND [240-248.99]
£ NUTRITIONAL DEFICIENCIES [250-269.99]
£ OTHER METABOLIC AND MMUNITY DISORDERS [270-279.85]
#-@ INFECTIOUS AND PARASITIC DISEASES [001-139.89]
£ INJURY AND POISONING [800-899.89]

Another option is to open the Search panel in the left pane, which reflects the
concept Diabetes mellitus in the ICD-9-CM namespace. The Concept Walker
floating window reflects Diabetes with ketoacidosis as a child concept of
Diabetes mellitus, also in the ICD-9-CM namespace. Note the illustration.
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File View Tools Options Help
| @] 4] s8] &la] B]%| %] ]| a
f prre— zl

(@, DISEASES OF OTHER ENDOCRINE GLANDS [250-259 9]

Search: { Concepts & Synonyms (¢ Concepts  © Terms
M Resuks : [10 = _—

Search For: [meiitus*

Searchin: (% Memespace ( Subset  Sio

Focus Concept: [Diabetes melitus [250] [ 1£0-8-Ch1 ]

View Axis: [superconcepts [ Subconcepts

£-9-CH |

Diabetes meltus vithout mertion of complication [250.0] [ 12D-8-2M ]
iependiert type] [IDDM] [uvenile type], not stater
iependiert type] [DDM] [uvenile type], not state
juve ontro

L Ll L e

Hamespace: [Ico-9-cht

Subset: |

Dishetes melitus with hyperosmolarty [250.2]
of carmplication [250.0]

stations [250 6]
ifesstations [250.5]

03]

maritestations [250 8]
nheral circulstary disorders [250.7]
etions (250.4]

@ Disbetes with unspecified complication [250.9]

iepentlent type] [MDDM tye] [adut-onset

Ll clepenclent type] [NDDM type] [adutt-onset -
ype Il diabetes melitus [non-sulin dependent type] (NDDM type] [sdut-onset-
ype Il iabetes melitus [non-insulin dependent type] (NDDM type] [adut-onset -

Drag the relationship from concept/term (i.e., Diabetes with ketoacidosis) into
the Concept/Term Details panel.

Right-click on the concept/term name on the Concept/Term Details panel, then
select Add Association from the displayed options. The Add Association window
displays. The from concept/term from the Concept/Term Details panel (i.e.,
Diabetes with ketoacidosis) displays automatically in the From Concept/Term
field, establishing the From portion of the From/To association between
concepts or terms.

‘= Add Association

From Concept / Term: IDiabeteS with ketoacidosis [25001] [ 1CD-9-CM |

| Association Type:| [Part Of [ Local [Non Ex] ]

Lol Lol Ll

To Concept | Term: |

The association always is written to the From Concept namespace (in this case,
ICD-9-CM), which displays in parentheses next to the concept/term.

Drag Diabetes mellitus from the other displayed panel and drop it into the To
Concept field. The namespace (again, ICD-9-CM) displays in parentheses next
to the concept/term.

From Concept / Term: IDiabeteS wyith ketoacidosis [250.1] [ 1C0-3-Ch | LI

. Association Type:i| [Part 01 [ Local [Mon Ex] ] =]

To Concept / Term: |Diabetes melituz [250] [ 1CD-9-Chi | LI

The Association Type field dropdown list includes only association types created
in the current local namespace; select the type of association you are establishing.
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In the illustration, Part Of is selected; the local namespace in which that
association was created displays in parentheses.

Concept ! Term Details |

ey Delete |

=@ Dishetes with ketoacidosis [250.1]
-4 Code: CEZZ
A D 633

‘@ Add Association

From Concept ! Term: IDiabetes with ketoacidosis [250.1] [ 1CD-9-Ch ]

Association Type: | Part Of [ Local [Mon Ext] ]

To Concept | Term: IDiabetes melitus [250] [ ICD-9-CM |

6. Select the appropriate qualifiers for this association using the Qualifier Type field

dropdown list, then enter the value for each qualifier type.

7. Click OK to update the ICD-9-CM namespace with the association of the
concept Diabetes with ketoacidosis as being Part Of the concept Diabetes

mellitus. Click Cancel to ignore the new association.

Map Concept/Terms across Namespaces

The DTS Editor allows you to create associations between concepts or terms across many
namespaces. Using this mapping approach (i.e., creating sets of associations between
concepts in two or more namespaces) you can map a single From Concept to many To

Concepts across multiple namespaces.

The following procedure illustrates how to create an association between concepts or
terms across two namespaces. In the example shown, an association is created for the
concept diabetes mellitus, which exists in both the SNOMED CT and ICD-9-CM

namespaces.

1. Open two separate display panels in the DTS Editor Main window. The display
in each should include the concept/term (each reflected in a separate namespace)

for which you want to create an association.

In the illustration, the Concept Walker panel reflects the concept diabetes
mellitus in the ICD-9-CM namespace. The Concept Tree floating window
reflects the concept diabetes mellitus in the SNOMED CT namespace.
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T Voo Somen]

., DISEASES AND IMJURIES [001-999.99] Namespace: ISNOMED cT

View Aixis: [superconcents £ Susconcepts

Subset: I

F}‘. Disorder of endocrine pancress (disorder)

‘. Abnormality of bombesin secretion (disorder)
‘. Abnormality of gastric inhilbitory peptide secretion (disordsr)

‘@ Abnormality of motiin secretion (disorder)
‘. Abnormality of secretin secretion (disorder)

@ Autcimmune hypoglycemia (disarder]

@ Disorder of pancreatic internal secretion (disorder)

Focus Concept: IENDOCRINE, MUTRITIOMAL AND METABOLIC DISEA LI ‘. E ) atostat etion (dsordier)
(— @ Excessive somatostatin secretion (disorder;

View Axis: |Supercnn:apts f Subconcepts

Namespace: |\CD-9-CM
Subset: |

@ Glucagon resistance (disorder)
+-@ Glucagonoma syndrome {disorder)
@ Hyperinsulinism (disarder)

Ll L] L]

7@ Hypainsulinism (disarder)

® Diseases of thymus gland [254] #-@ Insuiin biosyrihesis defect (disorder)

@ Disorders of aurensl glands [255] ‘@ Islet cell adenomatosis (disarder)

@ Disorders of parathyroid gland [252] - Iset cell yperpissia (cisorder)

b Dizorders of the piultary gland and ts hypothalamic cortrol [263] —b Leucine-induced hypoglycemia (disorder)

@ Cther endocrine disorders [259] | Wauriac's syrdrome (disarder)

@ Folyganciier dystunction and refsted disorders [258] 7@ Non-ciabetic disorder of endocrine pancreas (disorder)

“@ [XCther specified disorders of pancreatic irternal secretion (disorder)

‘@ Abnormality of cholecystokinin-pancreozymin secretion (disorder)

—@ sbnormealty of vasoactive intestinal peptide secretion (disorder)
@ Acrorenal field defsct, sctodermal dysplasia, and lipoatroptic disbstes (disorder)

[—@ Extreme insulin resistance with acarthosis nigricans, hirsutism AND alinormal insulin receptors (disorder)
@ Extrems insulin resistance with acarthosis nigricans, hirsutism AND autoantisoties to the insulin receptors (di

-9 DISEASES OF GTHER ENDOCRINE GLANDS [250-259.95) | @ Hypoonadism, disbetss melitus, alopecia, mental retardation and slectracardiographic sbnormalties (disorder

@ Cther sisorders of pancrestic inernal secrefion [251] | @ Lipodystrophy, partisl, with Risger anomaly, short staturs, and insulinopenic disbetes melitus (disorder)

@ Ovarian dysfunction [256] | @ Menaloblastic anemia, thiatine-responsive, with disbstes melltus and sensorineural deafnsss disorder)

o L e 1 e

@ Testicular dysfunclion [257) | @ Photomyoclonus, disbstes melitus, deatress, nephropathy and cerebral dystunction (disorder)
- DISCRDERS OF THYROID GLAND [240-245.99] Lttt et -
#-@ NLTRITION AL DEFICENCIES [260-269 5] K| J
- OTHER METAECLIC AND MUY DISORDERS [270-279.39]
| ‘ Switch view |

Another option is to open two instances of the Concept Tree floating window,
each of which include the concept diabetes mellitus in its respective namespace.

Note the following illustration.

Tree IWaIker' Searchl | Concept / Term Details

‘= Concept Tree

L

Namespace: [SoMED CT

\View Axis: ISuperconcepts I Subconcepts

Subset: |

f—]—b Dizorder of endocrine pancresas (dizorder)

'. [X]Cther specified dizorders of pancrestic internal secretion (disorder)

b Ahnarmality of bombesin secretion (disorder)

b Abnortnality of cholecystokinin-pancreozymin secretion (disorder)

b Abnoriality of gastric inkibtory peptide secretion (dizorder)

‘@ Abrormalty of motiin secretion (disorder)

b Ahnarmality of secretin secretion (dizorder)

b Abnorinality of vasoactive intestinal peptide secretion (disorder)

b Acrorenal field defect, ectodermal dysplasia, and lipoatrophic disbetes (dizorder)
@ Autoimmune hypoglyceria (cisorder)

4

o L el el

L

Srmceprreee

Hamespace: ||cD-9-CM

View Axis: ISuperconcep{s 1 Subconcepts

Subset; |

W OTeCASEs O THE SENT OO T 5 T = TEm (o029 99]

b DISEASES OF THE MUSCULOSKELETAL SYSTEM AND CONMWECTIVE TISSUE [710-739.93]

b DISEASES OF THE MERVOUS SYSTEM AMD SENSE ORGANS [320-359.99]

.. DISEASES OF THE RESPIRATORY SYSTEM [460-519.99]

b DISEASES OF THE SkIM AND SUBCUTANEQUS TISSUE [680-709.949]

b ENDOCRIMNE, MUTRITIONAL AND METABOLIC DISEASES, AND IMMUNITY DISORDERS [240-279.94]
b DISEAZES OF OTHER EMDOCRIME GLARDS [250-250.94]

=

b Dizeazes of thymus gland [254]

b Dizorders of adrenal glands [255]

b Dizorders of parathyroid gland [252]

‘@ Disorders of the pituitary sland and its hvoothalamic control 12531

1

—

L
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Drag the relationship from concept/term, Diabetes mellitus in the from
namespace (i.e., SNOMED-CT) into the Concept/Term Details panel.

Right-click on the concept/term name on the Concept/Term Details panel, then
select Add Association from the displayed options. The Add Association window
displays. The from concept/term from the Concept/Term Details panel (i.e.,
Diabetes mellitus) displays automatically in the From Concept/Term field,
establishing the From portion of the From/To association between concepts or
terms.

=
From Concept ! Term: ID\abetes melitus (dizorder) [ SHNOMED CT | LI
Association Type: | RTINS
To Concept { Term: | =l

The association always is written to the From Concept namespace (in this case,
SNOMED-CT), which displays in parentheses next to the concept/term name.

Drag the relationship to concept/term, Diabetes mellitus in the to namespace
(i.e., ICD-9-CM) and drop it into the To Concept field on the Associations
window. The namespace (in this case, ICD-9-CM) displays in parentheses next
to the concept/term.

From Concept / Term: IDiabetes mellitus (dizorder) [ SMOMED CT ] j
Association Type: | Part Of [ Lacal [ton Ext] ] =
(Lo e Rl L2 Lt (ol Cisbete:s melitus [250] [ ICD-9-CM ]

The Association Type field dropdown list includes only association types created
in the current local namespace; select the type of association you are establishing.
In the illustration, Same As is selected; the local namespace in which that
association was created displays in parentheses.

Fint Concegt | Tanm: |

mmlm

T Conoegt } Term: [sbsies meBtur [250] | K504 | =]

Select the appropriate qualifiers for this association using the Qualifier Type field
dropdown list, then enter the value for each qualifier type.

Click OK to update the SNOMED CT namespace with the association of the
concept diabetes mellitus between the namespaces SNOMED CT and ICD-9-
CM. Click Cancel to ignore the new association.
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View and Edit an Existing Association

Follow this procedure to view or edit an association definition and target concept value
for a concept by right clicking on the concept name in the Concept/Term Details panel.

1. Drag the from concept/term in the from/to relationship you want to view into the
Concept/Term Details panel.

2. On the Concept/Term Details panel, expand the Associations folder to display
existing associations for the concept.

3. Right-click on the association for which you want to view or edit details, then
select Modify Association from the displayed options. The Modify Association
window displays.

'S Modify Association E

From Concept / Term:

Association Type: | |Parent OF [ SNOMED CT EXTENSION ]

To Concept / Term; |Pathology and Laboratory Tests [Level 11 30043-33356] [ CPT ] R

Qualifier Type: | | Pending Approval [ SNOMED CT EXTENSION ] v

Qualifier Value: '

[ Add ][ Remove ][ Clear ]

Fending Approval: Immediate

The concept/term from the Concept/Term Details panel displays in the From
Concept/Term (drop target) field; this establishes the From portion of the
From/To association. The namespace in which the from concept resides displays
in brackets.

The target concept/term in the association displays in the To Concept/Term (drop
target) field. The type of association (e.g., Approach) that was established
displays in the Association Type field.

4. The modified association that you enter will be written to the local namespace
where the association type is defined. In the Association Type field list, select the
type of association between the concepts or terms. Association types from the
current local namespace are listed alphabetically (see Association Types).

You have the option of filtering the association types that are available from the
Association Type field dropdown list by creating a pre-defined, filtered list of
types. When you attempt to select an association type from the Association Type
field dropdown list, or select an alternate association type, only the pre-selected
types will be included in the list. Refer to the Filter Association Types discussion.
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5.

For each association you can add or remove one or more qualifiers, each of which
consists of an established qualifier type and value. Qualifiers provide additional
detail regarding the nature of a concept or term association (e.g., Usually). From
the Qualifier Type field dropdown list, select a new qualifier type to assign to this
association. The list includes only those association qualifier types that were
created in the same local namespace where the selected association type was
created.

Click Add after you specify the Qualifier Type and Qualifier Value; both are
added to the display area in the lower portion of the window.

To remove an individual qualifier type/value combination from the association,
highlight the appropriate line in the display area and click Remove. To clear all
existing qualifier type/value combinations, click Clear.

You have the option of filtering the association qualifier types that are available
from the Qualifier Type field dropdown list by creating a pre-defined, filtered list
of types. When you attempt to select an association qualifier type from the
Qualifier Type field dropdown list, or select an alternate Qualifier type, only the
pre-selected types will be included in the list. Refer to the Filter Association
Qualifier Types discussion earlier in the guide.

Click OK to update the knowledgebase with your association edits. Click Cancel
to ignore the edits.

Delete an Association

Follow this procedure to delete an association that exists between concepts or terms
within a namespace, or across namespaces. The association type for the association you
want to delete must exist in a local namespace in order for you to delete the association.

1.

Drag the from concept/term in the association you want to delete into the
Concept/Term Details panel.

On the Concept/Term Details panel, expand the Associations folder to display
existing associations for the concept.

Right-click on the association you want to delete (in a subscription namespace,
the association should be in italics) then select Delete Association from the
displayed options. A delete confirmation window displays.

Confirm Delete X

@ Are you sure vou wank to delete the Associakion 'Diabetes melitus (disorder), Park OF, Diabetes mellitus [250] 7

Cancel |

Click OK to delete the concept/term association from the local namespace to
which it was written originally. Click Cancel to ignore the deletion.
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Code and ID Generator

Introduction

Concept codes and concept IDs are identifiers generated automatically and assigned to
each new concept or term you create through the DTS Editor. The concept code and ID
display in the Concept Tree panel (in parentheses) next to each concept name when you
right-click on the concept name.

The default format for each new generated ID is the next available number in sequence.
The default format for each new code generated is a prefix of letter C for concepts, or
letter T for terms, followed by the next available number in sequence (e.g., C1, C2, C3,
T1, T2, T3, etc.). The default format for new concept code and ID generation is defined
in the class com.apelon.dts.client.plugins.DefaultCodeAndldGenerator.

You have the option of writing and “registering” one or more customized code and 1D
generators. Each new generator can define parameters for generation of new codes and
IDs based on formats of your own design. Each new generator would extend
CodeAndldGenerator based on the new class in com.apelon.dts.client.common.

To create a new code and ID generator, you first must write and compile a java class for
it (and place the compiled custom code and ID generator under a plugins subfolder of
their DTS installation). You then must register the new code generator .class file (which
makes it the current generator for creation of codes and IDs for new concepts or terms in
the DTS Editor). Procedures for each of these steps are provided.

Writing and Compiling a Code and ID Generator

A code generator is a java class that must extend the abstract CodeAndldGenerator class
found in package: com.apelon.dts.client.common. There are three methods that must be
implemented in the java class, getCode (DTSobjectconceptOrTerm) getld
(DTSobjectconceptOrTerm) and getDescription(). Each method is described.

e getCode(DTSobject conceptOrTerm) — the return value from this method will be
passed to the concept for which a code must be assigned. This method should
return a Java string type of 32 characters or less. This code will be assigned to the
concept when the concept is saved in the DTS Editor.

e getDescription() will return a Java string that describes the code generation
method for this code generation class. You will see this description in the DTS
Editor, when you select a code generator from the Register Code Generator
window (this window is discussed in detail later).

e getld (DTSobject conceptOrTerm)

An example of a code generator class is shown; note that the .class file must have a
unique name. The methods described are shown in the example.
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package com.apelon.dts.client.plugins;

import com.apelon.apelonserver.client.ServerConnection;
import com.apelon.dts.client.common.CodeAndIDGenerator;
import com.apelon.dts.client.common.DTSObject;

import com.apelon.dts.client.term.Term;

import java.util.Random;

/**
* Sample code and 1D generator that generates a random ID and corresponding
* code for the passed concept or term.
*/
public class SampleCodeAndldGenerator extends CodeAndIDGenerator {
private String fCode;
private int fld = -1;

/**

* Constructor passing server connection. The server connection can be used
* to instantiate DTS query classes in case they are needed to determine a

* unique code and ID. The server connection is not used in this sample code
*and ID generator.

*

* @param  sC server connection

*/

public SampleCodeAndldGenerator(ServerConnection sc) {
super(sc);

public String getCode(DTSObject conceptOrTerm) {
if (fCode == null) {
setRandomCodeAndID(conceptOrTerm);
}

return fCode;

}

private void setRandomCodeAndID(DTSObject conceptOrTerm) {
Random r = new Random();
fld = r.nextint();
if (conceptOrTerm instanceof Term) {

fCode ="T" + fld;
}else {
fCode ="C" + fld;
}
}
public int getld(DTSObject conceptOrTerm) {
if (fld==-1) {
setRandomCodeAndID(conceptOrTerm);
}
return fld;
}

public String getDescription() {
return "Generates a random ID for a new concept or term.
+ "For the code it prepends a capital \"C\" to the generated 1D of a concept, "
+ "or a capital \"T\" to the ID of a term.";
}
1

Note: Code generators must be placed in package: com.apelon.dts.client.plugins and
must extend class: com.apelon.dts.client.common.CodeAndldGenerator.
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The compplugins.bat file included in the DTS install is located in the bin\editor
directory, under the DTS main directory. To compile a code and ID generator source file,
place the source file in this directory:

DTSInstall\plugins\src\com\apelon\dts\client\plugins

Run the compplugins.bat file. You must have the path to your JDK on your PATH
environment variable for this .bat file to compile your code and ID generator. Your
compiled code and ID generator now will be available in the DTS Editor.

You also may use your own third-party java source editor (e.g., JBuilder, Visual Age) to
compile your code and ID generator. You will need the ApelonDTS.jar on your
CLASSPATH to compile; this .jar file will contain the CodeAnd IdGenerator class that
all code and ID generators must extend.

After you compile the class successfully, place the resulting .class file into this directory
on your local hard drive:

Apelon\ DTSInstall\plugins\classes\com\apelon\dts\client\plugins

This path originates from the location of your DTS Editor install. Only code and 1D
generators placed in this directory will be available while using the DTS Editor.

Registering a Code and ID Generator

Follow these procedures to register a new code and ID generator. All concepts created
thereafter will have codes and IDs generated based on the registered generator
parameters.

1. Select Code and ID Generator from the DTS Editor main window Options
menu. The Select Code and ID Generator window displays.

select Code And ID Generator |

Current code and ID generator class:

|com.apeIun.dts.cIient.pluginS.DefauItCodeAndIdGenerator
Select desired code and ID generator class:

com.apelon.dts.client pluging DefaultCodeAndld Generator

ok | Cancel |

The window lists each code and ID generator for which a Java class file was
created, compiled, and placed in the plugins\classes\com\apelon\dts\client\
plugins directory. The code and ID generator currently in effect displays at the
top of the window.
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Note: The sample file DefaultCodeAndldGenerator.java is included in the
plugins\src\com\apelon\dts\client\plugins directory. Run the file
compplugins.bat in the DTSInstall\bin\editor directory to compile this Java file
for the sample code and ID generator.

com.apelon.dts.client.plugins.DefaultCodeAndldGenerator then displays as an
option in the Select Code and ID Generator window.

2. Click the desired code and ID generator to select it. A brief description of the
code format that is generated displays.

Select Code And ID Generator x|

Current code and ID generator class:

|com.apelon.dts.client.pIugins.DefaultCodeAndldGenerator

Select desired code and ID generator class:

com.apelon.dis.client plugins DefaultCodeAndldGenerator

Generates a sequential ID on the save of a new
concept or term. For the code it prepends a capital
"C" to the generated ID of a concept, a capital "T"
to the ID of a term.

Ok | Cancel |

The default format for each new generated ID is the next available number in
sequence. The default format for each new code generated is the newly generated
ID, with a prefix of letter C for concepts, or letter T for terms (e.g., the new IDs 1,
2, and 3 would generate codes of C1, C2, C3, etc, for concepts, and T1, T2, T3,
etc. for terms).

3. Click OK to register the new code and ID generator. Each new concept created
from this point will be assigned an ID and code based on the associated generator
parameters in the java class file.

Duplicate Codes

If the new code and ID generator you registered creates a code that is identical to one
already in the knowledgebase, a message displays indicating that The concept/term
already exists!.

You have the following two options at this point:

1. Click OK. The concept or term will not be created. Try creating the concept or
term again; possibly the code and ID generator will generate a unique code and 1D
the next time.

2. If duplicate codes are being generated on a consistent basis, register a different or
updated code and ID generator on the Select Code and ID Generator window.
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Sample Code and ID Generator

An alternative, "sample™ code and ID generator is available with DTS . Rather than
automatically generating a code and ID like the default code and ID generator, it permits
you to manually enter the code and ID for a new concept or term.

The class name is com.apelon.dts.client.plugins.PromptForCodeAndId; it will be
included in the list of code and ID generators until you compile it by running the
compplugins.bat file. The source in DTSInstall\plugins\src\com\apelon\dts\client\
plugins will be compiled into the output directory DTSInstall\plugins\classes\com
\apelon \dts\client\plugins.
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Appendix A — Adjust Memory for Remote JDBC Connections

DTS loads the Lexicon dictionary whenever you perform a silo search using the DTS
Editor. If you use a Remote JDBC connection to the database, and experience Out of
Memory errors when you attempt silo searches, you may need to increase the amount of
heap memory configured for the DTS Editor.

Perform the following procedure to adjust the installed heap memory.

1. Right-click the Apelon DTS Editor selection on the Windows Start menu
(Programs>Apelon>DTSInstall>Apelon DTS Editor).

2. When the options list displays, click Properties. The Apelon DTS Editor
Properties window displays, with the Shortcut tab selected.

Apelon DTS Editor Properties 21x]

General  Shortout I Dptionsl Fant I La_l,loutl Colorsl Securityl

P‘E_Ej Apelon DTS Editor

Set New

Target type:  MS-DOS Batch File || — Heap Size
Target location: bin /
T arget; I\bin\runﬂbp.bat" 286 com. apelon, dts. apps. editor,

¥ Furin separate memom space. [ | Blun az different wser

Start in: I"E:\F‘rogram FilezApelonDT Shhin"

Shortout key: INDne

Run: INormaI window j

Comment; I

Find Target... | Changelcon...l

ok I Catcel | Apply |

3. Inthe Target field, set the value for the first argument to the desired maximum
Java heap size (consider the total amount of memory you have available when
deciding how much to allocate to the DTS Editor). Replace the installed default
value of 256, which refers to the amount of heap memory in megabytes.

4. Click OK to reset the heap size value.

5. Confirm that the Apelon DTS Server is running (Start>Programs>Apelon>
DTSlInstall>Start Apelon DTS Server) then start the DTS Editor.

Back to Top
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